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Welcome!
Welcome to the Cubasis AV on-line documentation! 

Please use one of the methods described below to quickly find the desired 
information:

• Use the Table of Contents provided by the Adobe Acrobat Reader program.
• Use the Adobe Acrobat Reader Search function.
• Click on a cross-reference (green text) to jump to the respective topic.

It is possible to print out this document or parts of it.

Additional Information on how to use the Adobe Acrobat Reader program can be 
found in its on-line Help.

● Before you start using the program, you should follow the instructions in the 
separate Installation document.
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How you can reach us
You can find us at the World Wide Web, at the following address: 

• www.steinberg.net. 

Here you can find the following sections (among others):

• The Service Web contains support information, answers the frequently asked 
questions etc.

• You can send email to our support personnel from the web pages.
• On the Web site you will find the latest update of your program and demo 

version of other Steinberg products, for instant download.
• The web User Area lets Cubasis AV users world wide communicate and ex-

change information.
• The Web pages also have sections for Education and Multimedia users.
- 12 - 
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Why you should read this Chapter
In this chapter, none of the actual features of Cubasis AV are described. Instead, the 
chapter contains information about the general methods you need to employ when 
using Cubasis AV, plus some useful terminology. These methods are the same in 
every part of the program, whether you are making a basic recording, or using Cu-
basis AV at its most advanced level. To make your work with Cubasis AV as effec-
tive as possible, please take some time to read this chapter.
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Cubasis AV Building Blocks
When you record audio or MIDI, your recorded sounds or 
MIDI signals are packed into “containers” called Parts.

Parts reside on Tracks. The Parts and Tracks make 
up an Arrangement.

You can work on a number of Arrangements 
simultaneously. Together they form a Song.

An Arrangement with 24 Tracks.
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Toolboxes

What are the Tools?

When you are working with Cubasis AV, you need different tools in different situa-
tions. You may for example want to move or copy Parts using the Arrow tool, or de-
lete Parts using an Eraser tool. There are a lot of other tools as well.

Some examples of tools
- 16 - 



What are the Toolboxes?

The various tools you may need in a certain situation are gathered in a Toolbox. 
This is essentially a “box” containing an icon for each tool. Each of the main win-
dows in Cubasis AV has its own Toolbox, containing its associated tools. All the 
main tools are described in the chapters “Arrangement Editing” and “The MIDI Ed-
itors - General Information”.

Three different Toolboxes (Arrange window, Key/List Edit and Score Edit).
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Selecting a Tool from a Toolbox

1. Press the right mouse button.
Make sure the pointer is not positioned over a numerical value field, as this 
will instead increase the value (see page 24).

2. The Toolbox appears.

3. Move the pointer to the tool you want to select, and release the mouse 
button.
The Toolbox disappears and the pointer takes on the shape of the selected 
tool.
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Pop-Up Menus
Throughout the program you will select values from pop-up menus. These differ a 
bit from the regular “menu bar menus”. Pop-up menus may be located anywhere in 
a window, and are not on a menu bar. But selecting is done similarly from both pop-
up and regular menus.

Press the mouse button 
with the pointer positioned 
on the small triangle...

...to pull down a pop-up menu.
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About Positions
Cubasis AV works with a resolution of 384 fractions (or ticks) per quarter note. You 
will often work with position values in the Arrange window. Positions in Cubasis 
AV are displayed as Bars, Beats (quarter notes) and Ticks. 

The first Beat of the first Bar, in other words the beginning of the Song.

Bars

Beats
Ticks
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The lengths of notes are shown as ticks. In the table below, some note values are 
displayed as ticks:

Note Value Number of Ticks

Whole note 1536

Half note 768

Quarter note 384

Dotted eighth note 288

Eighth note 192

Eighth note triplet 128

Dotted sixteenth note 144

Sixteenth note 96

Sixteenth note triplet 64
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Setting Values
There are three basic kinds of values displayed in Cubasis AV:

• Meter Positions
• Note Pitches
• “Other” values

As explained above, positions and lengths are displayed as Meter Positions. Other 
values, such as tempo, velocity etc, are displayed as a number, sometimes with dec-
imals. Some values may be negative.

Changing a value by typing

You can double click on a value field. The value is highlighted, and you can type in 
a new value and press [Return]. You can use the numeric key pad as well as the nor-
mal keyboard in most cases.

If you are editing a value that is “segmented”, such as a Song Position or a decimal 
number, you can use spaces, dots, commas or any character that is not a number, to 
separate the numerals. However, you don’t have to type in all the numerals. If you 
just type in a single number, you will change the largest numeral in the segmented 
value, and all the lesser numerals will be set to their lowest values.
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If you are editing a pitch (note number), there are two ways of typing it: as a note 
name (a letter followed by a number and maybe a #-sign) or as a MIDI note number 
(a number from 0 to 127, where 0 is the lowest note).

Double clicking on this 
value (Song Position)...

...brings up a value box 
with a cursor.

If you type a single value and 
press |Return|...

...the lesser numerals get their 
lowest values automatically.

You may enter a MIDI note 
number, for example 37...

...but Cubasis AV will display 
the name of the note (in this 
example C#1).
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Changing a value by using the Mouse

You can use the mouse to either change a value by single steps or continuously 
scroll it up or down.

Method 1

1. Position the pointer over the value you want to change.

2. Click with the left or right mouse button
The left button decreases the value, the right button increases it. For each 
click the value changes one step.

3. Continue clicking until you have reached the desired value.

• If you hold down [Shift] while clicking, the value will change in larger 
steps (often steps of ten).

Method 2

1. Press and hold one of the mouse buttons with the pointer over the value.
The value will scroll up or down depending on which button you press (the 
left button decreases the value and the right button increases it).

2. Release the button when you have reached the desired value.

• If you hold down [Shift] while using the mouse, the value will scroll in 
larger steps (often steps of ten).
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Changing a value by dragging

If you hold down the [Control] key on the computer keyboard, you can click on a 
value and drag the mouse up or down with the button pressed. The whole screen 
will then act like an invisible scroll bar or fader, which you can use to change the 
value.

...or down.

If you press [Control], click on a value 
and keep the mouse button pressed...

...you can “drag the value” 
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About changing “segmented” values

If you are using the mouse to change a “segmented” value such as a position or a 
decimal number, you can change any one of the “segments” individually. In a posi-
tion value for example, you can change the bar, beat and tick values independently, 
just by positioning the pointer at the right numeral.

...will change this value only.

Clicking on the “Beats” value...
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Naming
You can give names to Tracks, Parts and other items in Cubasis AV. To edit a name 
just double click on it. The text gets highlighted and you can type in the changes 
you want to make. You can use the arrow and [Backspace] keys, just as in any text-
editing program.

...highlights it and makes it ready to edit.

Double clicking on the name... 
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Window Techniques
Cubasis AV is a Windows program, which means standard “Windows procedures” 
apply. You may move, resize, scroll and close windows using standard procedures. 
But there are also a couple of special features:

Changing the Magnification

In the Arrange window, and most of the editors, a plus and a minus sign appear on 
each scroll-bar. Click on the  plus sign to increase magnification. The  minus sign 
will decrease magnification.

The plus and minus sign on the left/right scroll bar change the horizontal magnifi-
cation. The signs on the up/down scroll bar change the vertical magnification. If 
you click on a plus or minus sign and keep the mouse button pressed, the magnifi-
cation factor will change continuously, allowing you to zoom in or out.

The vertical magnifying buttons

The horizontal magnifying buttons
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You can also change the magnification from the computer keyboard, using the fol-
lowing keys:

[G] Decrease horizontal magnification.

[H] Increase horizontal magnification.

[Shift]-[G] Decrease vertical magnification.

[Shift]-[H] Increase vertical magnification.
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Dividers

Some of the windows in Cubasis AV are divided into two sections. The “borders” 
between the sections are called Dividers. If you position the pointer on a Divider, 
the pointer takes on the shape of a hand. If you then click on the Divider and drag it 
in the direction of one of the sections, you will shrink that section and enlarge the 
other.

Dragging the Divider in the Arrange Window.
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The Transport Bar

This is a special window that, among other things, contains the transport controls: 
Play, Stop, Record, Rewind and Fast Forward. These work much like the controls 
on a tape recorder. Read more about the Transport Bar in the chapter “Playback, 
Tempo and the Transport Bar”.

The Transport Bar differs from standard windows. It doesn’t have a title bar (the 
area at the top, used for dragging a window around on the screen). Instead you use 
the “handles”, at each side of the window, to move the Transport Bar. Also, the 
Transport Bar will never be obscured by other Cubasis AV windows, but always 
stays on top.
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Dialog Boxes
When you select a function from a menu, sometimes a dialog box appears. This is 
a type of window for making various settings, etc. After you have input the neces-
sary information using the mouse and/or keyboard you close the dialog box by 
clicking on a button called “OK”, “Do It!” or something similar, or by pressing 
[Return] on the computer keyboard.

Even when you have a dialog box open you can still use the numeric key pad for the 
functions on the Transport Bar (Start, Stop and so on).
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Using the Computer Keyboard
When you are working with Cubasis AV, the computer keyboard has several differ-
ent uses:

Transport Controls

The Transport functions (such as Play, Stop, Record and so on) can all be managed 
from the computer keyboard. The keyboard commands for these functions are lo-
cated on the numeric key pad, to the right of the main computer keyboard. See page 
109 in this book.

Keyboard Shortcuts

Many of the items on Cubasis AV menus have a computer keyboard equivalent - a 
“shortcut”. These keyboard shortcuts generally use keys on the “typewriter” part of 
the computer keyboard.
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How Keyboard Commands are displayed in this Manual

The following list shows how the “special” keys on the computer keyboard are dis-
played in this manual.

When the text says something like “press [Control]-[T]” this means that you should 
hold down the control key on the computer keyboard and press T once.

In this manual: On some keyboards:

[Shift]

[Alternate] Alt

[Alt Gr] (should not be confused with Alternate)

[Control] Ctrl

[Tab]

[Return]

[Backspace]
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Cutting, Copying and Pasting
You can use the standard commands, Cut, Copy and Paste, to rearrange Parts, notes 
and other Events. These commands can be found on the Edit menu, and have the 
keyboard equivalents [Control]-[X], [Control]-[C] and [Control]-[V] respectively. 
Cutting, Copying and Pasting is the main way of moving and duplicating notes be-
tween different Parts or between the different Arrangements in a Song.
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Cutting

The Cut command takes the selected Parts or Events, removes them from where 
they were and puts them in a temporary, non-visible location called the Clipboard.

Selecting a Part and Cutting it...

...removes it from where it was...

...and puts it on the Clipboard.
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Copying

The Copy command takes the selected Parts or Events, copies them and puts the 
copy on the Clipboard. The difference between Cut and Copy is that nothing is re-
moved when using Copy.

● Only the last Cut or Copied item(s) are stored in the Clipboard. There is only 
one Clipboard, shared by Cut and Copy.

Selecting a Part and Copying it...

The original Part is left where it was.

...makes a duplicate of the 
Part and puts the duplicate 
on the Clipboard.
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This means that anything already on the Clipboard will be replaced if you Cut or 
Copy again. 

Let’s for example say that you Cut 
or Copy two notes from an editor. 
These are put on the Clipboard.

If you then Cut or Copy something 
else (a Part, some other notes, etc)...

...the two notes on the Clipboard 
will be replaced by these last 
Cut or Copied Events.
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Pasting

The Paste command puts the contents of the Clipboard back into the selected win-
dow, which can be the same window as they were Cut or Copied from or another. 
These are the rules:

• If the Clipboard contains Events Cut/Copied from an editor, you can only 
Paste them into an editor (the one they came from or another one). You 
can’t Paste editor Events into the Arrange Window.

• If the Clipboard contains Parts Cut/Copied from the Arrange window, 
you can only Paste them into the Arrange window. 

• You can Paste the same contents from the Clipboard as many times as 
you like. Data is copied from the Clipboard, not moved from it.
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● Cutting, Copying and Pasting is the way to move Events from one Part to an-
other. There is only one Clipboard for Events, and it is shared between all the 
editors, so that notes and other Events can be moved from one Part to the 
next.

Pasting will make a duplicate of the 
contents of the Clipboard and put 
the duplicate where you want it.

The contents of the 
Clipboard are still there.
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Undo
Cubasis AV has a wide-ranging Undo function. This means that if you regret your 
last action, you can Undo it. This is very helpful when something doesn’t turn out 
as intended. Remember that it is only the last action that can be undone.

You Undo an action by selecting “Undo” from the Edit Menu, or by pressing [Con-
trol]-[Z] on the computer keyboard.

If you wish to “Undo the Undo”, this is possible. The menu text changes to “Redo” 
after an Undo (for example “Redo Delete”). If the menu item is grey, nothing can 
be undone.

Often the menu item Undo tells you what will be 
undone at any given moment. In this case, “Undo 
Delete” means the last deletion will be undone.
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Real Time
Cubasis AV is a true real-time program. It has sophisticated multi-tasking proce-
dures that let you do almost anything (like loading from, and saving to disk) with-
out interrupting the music.

In some instances the notes sounding at the moment have to be cut off, but timing is 
never affected.

● In general, don’t turn off playback or recording just because you want to try a 
command or a function, just do it!
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Selecting a sound source for recording
Before starting to record audio, you must decide what type of sound source you 
want to record. There are (usually) two basic options:

• Recording a sound source connected to the audio inputs of the audio 
card.
This could be a microphone, a mixer or any electrical musical instrument.

• Recording audio from an internal CD-player.
You may for example want to record loops and sounds from a Sample CD.

To “tell” the computer which type of sound source you want to record, proceed like 
this:

1. Switch to the desktop/Program Manager.

2. Locate and launch the mixer software included with the audio card.
Possibly, you may have to launch the Explorer/File Manager to do this.

3. Use the settings in the mixer program to select an input source.
There may be several options, such as line and microphone inputs, internal 
CD-player and possibly digital inputs. Refer to the audio card documentation 
for more information.

4. Quit the mixer program and return to Cubasis AV.
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Choosing a Sample Rate
Before you start recording the first audio file in a Song, you have set the sample 
rate:

1. Open the “Hardware Setup” dialog (on the Audio menu).

2. Select a Sample Rate.
See page 430 for details about sample rates. Some cards might only support 
the 11025, 22050 or 44100 alternative. See the card’s documentation for de-
tails.

● This setting is done once and for all for the whole Song. You can not make 
some recordings at one sample rate and others at some other sample rate. 
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3. Close the dialog by clicking OK.

The settings are automatically saved together with the program.

Preparing a Track
1. Select an Audio Track by clicking on its name field in the list.

Audio Tracks are indicated by this symbol.
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• If you don’t have any empty Audio Tracks in your Arrangement, you need 
to create one, for example by using the Create Track item on the Edit 
menu. 
To make sure the Track is an Audio Track, position the pointer in the “C” col-
umn for the Track, click the mouse to pull down the pop-up menu and select 
“Audio Track”.

2. Set the Track's channel (Chn) to the audio channel you plan to record on 
(1 to 8).
If this is the first Audio Track you record on, select 1. For more information on 
channels, see page 80.

3. Double click on the Track name, type in a new name for the Track and 
press [Return].
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4. Open the Inspector.
This is done by clicking on the Inspector icon below the Track list.

5. Decide whether you want to make a mono or a stereo recording, by 
clicking on the Mono/Stereo button under the heading Rec Chn Mode.
If you select Mono, the signal from the left input channel will be recorded.

6. Click on the Filename button.

Click here to open the Inspector
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7. In the standard file dialog box that appears, select where you want the 
file located and type in a name. Click OK.
The Filename button turns darker to indicate this audio channel and file are 
now ready for recording.

An Audio file set up for recording.

● If you attempt to record on a Track for which you don’t have selected a file 
name and location, Cubasis AV will ask for this information, before allowing 
you to record.

Where is the best place to put my Files?

• If you have the choice, we recommend that you put your audio files on a sep-
arate hard disk. You can also store your Cubasis AV documents (like Song and 
Arrangement files) on this hard disk, together with the audio files, since this 
simplifies archiving and backing up. We recommend that you reserve your 
startup hard disk for applications, system files etc.
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• We recommend that you make one folder for each project. In this folder you 
can put your Cubasis AV documents and other documents related to the 
project. We have also found it convenient to create an “Audio” folder inside 
the Project folder for the actual audio files.
Project folder Cubase documents

Folder for audio files
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The “Free Space” indication

The Free Space indication in the Inspector shows you the longest recording you can 
make with the available disk space. Please note that the Rec Chn Mode setting 
(Mono/Stereo) affects this value.

● For the Free Space value to be shown for a Track, a Record File must have 
been selected, as described on page 48.

About Monitoring
Cubasis AV in itself does not handle monitoring, that is it has no controls for how 
the audio passes through the card (since many cards are different in this respect).

However, with some audio cards, the accessory application(s) that come with the 
card will allow you to turn on and off Monitoring. If your card has this ability, we 
recommend you to activate monitoring, since it will (among other things) facilitate 
setting recording levels.
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Using Monitoring to check levels

If monitoring is activated, the audio signal will pass through the card’s “analog to 
digital” and “digital to analog” convertors. You can then simply check the recording 
levels by listening to the output of the card. To obtain an optimal recording level, 
raise the level of the input signal until you hear distortion, and then lower the input 
level a bit.

About Digital Recording and Levels

Digital recording (as in Cubasis AV) is different from analog recording when it 
comes to recording levels. Whereas with analog recording it is often perfectly ac-
ceptable to let the “needle hit the red” (record at levels actually higher than the sys-
tem can reproduce accurately), this is not true when it comes to digital recording.

The term used here is headroom. The headroom is the difference in level between 
the signal you record and the maximum level the system can handle. When the level 
of the signal increases, the headroom diminishes towards 0 dB (decibels).

When the signal is stronger than the system can handle - when you exceed the 
available “headroom” - in a digital recording system, hard clipping occurs, which 
results in clearly audible and very unpleasant distortion.

To avoid this, you should always give yourself an extra bit of headroom in your re-
cordings in Cubasis AV.
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Setting up the Metronome Click and selecting a tempo
When you record audio, you don’t have to use a metronome, or even any specific 
tempo. However, it is often practical to select a correct tempo before starting to 
record, since this will let you add MIDI music easily later on. To help you keep 
time when recording, you use the Metronome Click function. First, you need to set 
it up:

1. Pull down the Options menu and select “Metronome...”.
The Metronome dialog opens.
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2. Make sure that “Precount” and “Beep” are activated.
When “Precount” is activated, the metronome will give you a “count in” be-
fore you start recording. You can select the length of the count in, by entering 
a value in the “Bars” field below.

3. Click OK.
Now you need to set a suitable time signature and tempo for your music:

4. Make sure the Master button on the Transport Bar is not activated.
How to use the Mastertrack and the Master button is described in the chapter 
“The Master Track”.

5. Set a Time Signature of your choice on the Transport Bar.
You can change each of the two Time Signature values separately to get Time 
Signatures from 1/2 to 16/16.

Tempo integer Time Signature

The Master button
turned off

Tempo fraction
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6. Activate the Click button on the Transport Bar and click on the Play button.
You will hear a metronome click sound.

7. Adjust the Tempo on the Transport Bar, until it feels right.
The Tempo setting is divided into integer (“coarse”) and fraction (“fine”) val-
ues. We suggest you start with the integer part and use the fraction value only 
for fine-tuning.
- 55 - 



Recording from a specific point
Now that you’re all set, it is time to actually record!

1. Set up the Left Locator to where you want the recording to start and the 
Right Locator to where you want it to end.
The Locators are markers, visible as two lines stretching over the Arrangement 
and with an “L” and an “R” flag in the ruler. 

You move the Locators by clicking with the left or right mouse button in the 
ruler, or by changing the Locator values on the Transport bar (for other ways 
of setting the Locator positions, see page 118).

● If you are not sure how long you want the recording to be, or prefer to deac-
tivate recording manually, set the Right Locator to a very large value so that 
you will not intentionally reach it while recording.

Right LocatorLeft Locator
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2. Make sure that the Cycle button (the top button to the right on the Trans-
port Bar) is deactivated.

3. Click the Record button.

4. After the count-in, start performing.

5. When you are done, press Stop.
The program will now calculate an image file so that a waveform can be dis-
played. Depending on the length of your recording, this may take a few sec-
onds, during which a dialog box shows the progress of the calculation. When 
finished, a Part will appear on the Track:

A Part on a Track.

6. Click Stop again to return to the beginning of the recording, and click 
Play to listen to your performance.

Cycle turned off
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Redoing the Recording
There are three ways you can redo a recording that you are not satisfied with:

Recording again over the existing Part

If you simply record again on the Track, you will get a new Part which overlaps the 
previous. The Track will play back fine, but you will be wasting hard disk space 
with unused recordings.

Using Undo

If you press Undo after Recording, the Part you just created will disappear and you 
can record again. However, the audio file still resides on the hard disk and there is a 
segment for it in the Pool (see page 84 for more about audio files and segments). 
You can always delete unused segments later, so this is nothing to worry about.

Deleting the Part

The final option is to manually delete the Part and then record again on the Track.

• If you delete the Part with the Eraser (or by selecting it and clicking 
[Backspace]), it disappears, but the segment and the audio file are not 
deleted (just as when you use Undo, see above).
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• If you select the Part, hold down [Control] and press [Backspace], a dia-
log appears, asking you if you also want to delete the audio file. To do 
this, click OK.
This is the method to choose if you are sure you permanently want to delete 
the recording.

Recording more on the same Track
To record more on the same Track, proceed as follows:

1. Move the Left Locator to the next position where you want to start re-
cording.
This can be at a “free” area on the Track, or at some place where something is 
already recorded, as described below.

2. Move the Right Locator to where you want the recording to stop.

3. Activate recording just as you did the first time on the Track.
A new file is automatically created for you, as described below.

● Please note that the same audio channel can play back a mono file on one 
section of the Track and a stereo file on another.
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About overlap

When you record again, where something has already been recorded on the Track, 
you will get a new Part which overlaps the previous one(s). When you play back, 
only the Parts that you can see are played back. Let’s say the Track contains a long 
Part, and a shorter Part is recorded “on top of” and in the middle of the longer one. 
When the Track is played back, you will hear the first Part (the longer one) up until 
the start of the shorter Part. The short Part will then be played until its end and then 
you will hear the end of the longer Part.

During the “riff” Part, the “guitar” Part is silenced.
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About File Names
As described on page 48 in this chapter, you have to specify a file name before you 
start recording on a Track. This is done by clicking on the Filename box in the In-
spector, and using the file dialog that appears.
You can also change the names of files, after recording. This should be done from 
the Pool, as described on page 216.

● Do not change the names of audio files from “outside” Cubasis AV, for rea-
sons described on page 216.

Recording the Next Track - Overdubbing
Recording the next Track is done just as with the first. Just select another Track, 
name it and record as described on page 56. When you activate recording, you will 
hear the previously recorded Tracks together with the performance you are cur-
rently recording.

● Not all audio cards support simultaneous audio playback and recording (also 
known as “full duplex”)! If your card does not support full duplex, this means 
that as soon as you enter record mode, you will not hear your previously re-
corded audio Tracks. 
If your card does support full duplex, you should make sure this function is 
activated in Cubasis AV’s Hardware Setup dialog, as described on page 429.
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Some additional recording rules
In Cubasis AV, the following guidelines apply when recording audio:

• Cubasis AV always punches out automatically at the Right Locator.
This means, that if you are recording and the Song Position passes the Right 
Locator, recording is automatically deactivated.

• Recording always starts from the Left Locator.
This means you cannot punch in manually (activate recording “on the fly” 
from play mode.

• If you switch Tracks when recording audio, recording is disabled but 
playback continues.
To be able to record on another Track you have to stop playback.
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4

Recording MIDI 4
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Preparations

Activate MIDI Thru!

Cubasis AV is best used with MIDI Thru activated and the connected MIDI sound 
source in Local Off-mode. Therefore:

● Make sure that MIDI Thru is activated on the Options menu.

Selecting a MIDI Track for recording

The Tracks with the note symbol in the “C” column, are used for recording MIDI. 
You can have up to 64 MIDI Tracks in Cubasis AV. Each Track has its own MIDI 
Channel (1 - 16, indicated by the number in the “Chn” column). If you have a MIDI 
sound source that can play different sounds for different MIDI channels (usually 
called a “multitimbral” sound source), you can control up to 16 different MIDI 
sounds at once, one for each MIDI channel.
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First, you need to select a Track to record on:

1. In the Track list in the Arrange window, click on the name of one of the 
Tracks. 

• If you don’t have any empty MIDI Tracks in your Arrangement, you need 
to create one, for example by using the Create Track item on the Edit 
menu.
To make sure the Track is a MIDI Track, position the mouse in the “C” column 
for the Track, pull down the pop-up menu and select “MIDI Track”.

MIDI Tracks
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At this stage, you can name the Track if you want to. It is often very practical to use 
a Track name that corresponds to the music or the sound you want to record on the 
Track:

2. Double click on the Track name in the list.
A name box opens.

3. Type in the desired name of the Track and press [Return].

4. Set a MIDI channel for the Track in the “Chn” column.

● In General MIDI, channel 10 is always used for drums!
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Selecting a sound for the Recording

If you use a typical multitimbral MIDI sound source, it can receive MIDI signals on 
16 different MIDI channels. For each channel, you can select a sound (“Programs”, 
“Presets”, “Patches”, “Tones”, “Voices” or whatever they might be called).

There are three ways to select a sound for the Track’s MIDI channel:

Using the Instrument’s front panel

Normally you can select sounds – for each MIDI Channel – directly from the front 
panel on the instrument. If you choose this method, please refer to the instrument’s 
operation manual for details.

Using the GM/GS/XG Editor

This method is suitable if your instrument is compatible with any of the standards 
GM (General MIDI), GS or XG.

● You may need to activate your instrument’s GM/GS/XG mode for the settings 
below to work. Refer to page 381 and the instrument’s operation manual for 
instructions on how to do this.
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To select a sound, proceed as follows:

1. Pull down the Edit menu and select “GM/GS/XG Editor”.

A window with 16 sections of controls, on for each MIDI Channel, appears.

2. Locate the Device section in the lower left corner of the window.

3. Use the Mode pop-up to select GM, GS or XG Mode.
Select the mode that is appropriate for your instrument.

4. Pull down the Output pop-up and select the MIDI Output port your in-
strument is connected to.
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5. Locate the channel section corresponding to the MIDI Channel you have 
chosen.

6. Press the mouse button with the pointer over the “Program” box at the 
bottom of the channel section.

7. Use the hierarchical menus to select a sound.
The pop-up menu consists of 16 submenus, each containing 8 GM instru-
ments. Selecting one of them will send out the appropriate MIDI Program 
Change message to your MIDI sound source.

• You can also use the GM/GS/XG Editor to set levels, panning and various 
other parameters for each MIDI channel.
This is described on page 379.
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Using the Inspector

You can also select sounds directly in Cubasis AV’s Arrange window.

● Your instrument must be set up to receive MIDI “Program Change” messages 
for this to work. Refer to the instrument’s operation manual for instructions on 
how to do this.

1. Click on the Inspector icon, below the Track list.
The Inspector appears.

2. Click in some empty part of the Part Display (the area to the right of the 
Track list).
This is to make sure no Part is selected. 

3. Click on the Track name to make sure the Track is selected.
The top text in the Inspector now says ”Trackinfo” and below this, the name 
of your Track is displayed. This is your verification that the Inspector actually 
shows the settings for the right Track (the selected one).

4. If GM, GS or XG Mode is activated in the GM/GS/XG Editor, you can 
click on the “Prg” field to pull down a hierarchical program menu, simi-
lar to the one in the GM/GS/XG Editor.
For this to work, your instrument needs to be General MIDI-compatible and 
possibly set to its GM/GS/XG Mode.
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5. If you use a non-GM sound source (and “Off” is selected in the Mode 
pop-up in the GM/GS/XG Editor), you can instead enter a Program 
Change number in the Prg value field.
In MIDI, Programs are always numbered continuously, and in Cubasis AV 
they are numbered from 1 upwards. Your instrument might use some other 
numbering scheme, so you might need to experiment a bit before you get the 
right sound.

● If you are using a soundcard with a built-in synthesizer that supports Sound-
Fonts, such as the Creative Labs AWE series, you could also use the Patch 
pop-up menu to select sounds (see page 158).

Changing this setting 
sends out MIDI 
Program Change 
numbers.
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Click

Recording into a sequencer is done in time with a metronome click. So, to make 
sure you hear the metronome, check that the Click button is activated. If it isn’t, 
click on it.

This activates a click directly from the computer, and/or a MIDI metronome, de-
pending on the settings in the Metronome dialog.

Tempo and Time Signature

To set a Tempo and Time Signature for your recording, proceed as follows:

1. Make sure the Master button on the Transport Bar is turned off.
You need to activate the Master (Track) if you want tempo changes in your 
song. Otherwise it is best turned off. See page 110.

2. Set a Tempo and a Time Signature of your choice in the Tempo/Time Sig-
nature box on the Transport Bar.

Click activated on 
the Transport bar.
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Recording from a specific point
1. Set up the Left Locator to where you want the recording to start and the 

Right Locator to where you want it to end.
Make sure the Cycle button is deactivated.

2. Click on the Record button or press [*] on the numeric key pad.

3. After the count-in, start playing your MIDI instrument.

4. When you are done, click the Stop button.
A Part appears on the Track.

5. Click Stop again to return to the beginning of the recording, and click 
Play to listen to what your performance.

Now all you have to do to hear what you recorded, is to click the Play button, or 
press [Enter] on the numeric key pad.

Cycle deactivated on the transport bar.
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Redoing the Recording

If you aren’t satisfied with the recording, you can try either of the two following 
methods:

Using Undo

If you haven’t made any changes to the Arrangement since you recorded, you can 
simply Undo the recording by selecting Undo from the Edit menu. Remember you 
can only Undo your last action.

Deleting a Part

You can delete a recording (a Part) by clicking on it and selecting Delete from the 
Edit menu or pressing [Backspace].

Recording more on the same Track

If you wish to record more on the same Track, proceed as follows:

1. Set up the Left Locator to where you want the new recording to start and 
the Right Locator to where you want it to end.

● You can’t activate recording if the Locators are positioned in “reverse order”.
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2. Activate Recording by clicking on the Record button or pressing [*] on 
the numerical keypad.

You will hear a count-in just as you did the first time, and then recording starts from 
the Left Locator position.

When you have finished recording, you will probably get a new Part, after the first 
one.

The second Part appears after the first.

You may also start recording from Play mode (“Punch In”), see page 78.

How Parts appear when you record

When you record, the following rules apply:

• Recording from one point to another creates a Part that spans these two 
points.

• Recording again on the same Track, between the same points or within 
the Start and End points of the existing Part creates no new Part. 
The music is added to the existing.
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• In other cases (like starting recording in an empty section of the Track, 
recording over Parts and recording out of existing Parts into empty areas 
of the Track), new Parts are only created where there weren't any before. 
An example might clarify this: 

You have an existing Part starting 
at 5.1.0 and ending at 8.1.0.

You start the new recording at 
3.1.0 and end at 10.1.0.

This creates a new Part starting at 
3.1.0 and ending at 5.1.0...

...the old one between 5.1.0 
and 8.1.0 is kept, but music 
gets added to it...

...and finally there is a new Part created between 8.1.0 and 10.1.0.
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Recording the next Track

To record on the next Track, proceed as follows:

1. Select the next Track by clicking on its name field.

2. Select a sound for this recording, just as with the first.
Again, this can be done either on the front panel of the instrument or from the 
Inspector - it all depends on your instruments and which method you prefer.

3. Set the Left Locator to the position where you want the recording to be-
gin, and the Right Locator to the position where you want it to automat-
ically end.

4. Activate Recording, wait for the count-in and start performing.
Now, if you have everything set up OK, you should hear your first Track while 
you record the second.
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Activating Recording from Play mode - Punch In and 
Out

As with Audio Tracks, you can Punch In and Out on your MIDI recordings, follow-
ing these rules:

• Punch In is done manually, by activating recording anytime during play-
back.

• Punch Out is either done manually, by deactivating recording without 
pressing the Stop button, or automatically, when the Song Position passes 
the Right Locator.

About punching in on long notes

When you activate recording in Cubasis AV, already recorded notes are never cut 
off, they will play to their end just as they did before you started this recording.

About punching in on Controller or Pitch Bend data

Watch out when punching in on recordings with Pitch Bend or Controller data 
(modulation wheel, sustain pedal, volume etc), since this may lead to strange ef-
fects (sustained notes, constant vibrato etc).
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Why you should read this Chapter
This chapter contains some details and background theory about how Cubasis AV 
handles audio and MIDI, as well as some terminology used throughout this manual 
and in the program. Please take the time to read this, as it will aid you in using the 
program in the most effective way (when working with audio, you should also read 
the chapter “Optimizing Audio Performance” for best results).

Audio Channels vs Tracks
Many audio recording systems do not make a difference between audio channels 
and Tracks, which is the way a regular tape recorder works: one channel - one 
Track. Cubasis AV however, has a much more flexible approach to handling audio, 
as we shall see. This is important to note, especially if you have previously been 
working with a system where Tracks and Channels are one and the same thing.

Audio Channels

An audio channel plays back one audio recording at a time.

In Cubasis AV, the number of audio channels you have access to is limited by your 
computer’s processing power, the amount of free RAM and the speed of the hard 
disk (see page 418). However, the maximum is 8 stereo channels.
- 80 - 



The number of audio channels puts a limit to how many audio recordings can be 
played back at the same time. For example, in a four channel system, you could 
play back:

• One lead vocal recording (one channel), plus
• One backing vocal recording (one channel), plus
• One mono bass recording (one channel), plus
• One mono guitar recording (one channel)...

...all at the same time.

Mono/Stereo

In Cubasis AV, an audio channel can play back either mono or stereo files, it 
doesn’t matter which. The same Track can play back a mono file in one section of 
the Song and a stereo file in another. In essence, this means the audio channels are 
all stereo.

Four channels of audio
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Tracks

An Arrangement can contain up to 64 Tracks. In the “Chn” column, you set an Au-
dio Track to play back on a certain audio channel, just like you set MIDI Channel 
for a MIDI Track.

Setting Two Tracks to the same Audio Channel

You can set things up so that two Tracks use the same audio channel. This is not a 
problem as long as there is no audio happening at the same time, on the two Tracks. 
For example like this:

Here, the Guitar Track plays through the verses and the saxophone Track plays in 
the chorus. Since the Parts don’t overlap, both Tracks can have access to the same 
audio channel during playback. 

However, if there is any overlap between the two – if, for example, the saxophone 
starts playing in the middle of the guitar, the two Tracks will compete for the single 
audio channel, and only one of them can use it at the same moment. In this case, the 
“latest” recording will always “steal” the audio channel, as described in the illustra-
tion on the next page.
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The guitar will play until the sax Part starts. 
Then the sax will be heard instead.

These sections will not be heard!
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Audio Files
When you record, your audio card digitizes the audio signal coming from the mi-
crophone (or other sources) and stores the digital data as files on your hard disk.

One File per Channel

One file is always created for each single recording and each audio channel you 
record on.

File Format

The audio files created by Cubasis AV are Wave files (WAV), the most common au-
dio file format for the PC. It is also possible to import and export audio files in 
AIFF format.

Since practically all Windows audio processing programs read and write Wave or 
AIFF files, this allows you to process your Cubasis AV files in other programs, and 
import files that have been created elsewhere, into Cubasis AV. See page 233 for in-
formation about importing and exporting files.
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Audio Files are big

Audio files are comparatively large, compared to Cubasis AV Song files, MIDI 
files, or for example, word processor files. For each minute of recording at 44.1 
kHz mono, you will use up 5 MBytes of hard disk storage per mono audio channel. 
This means that to record continuously on four channels for three minutes, you will 
need 60 Mbyte of free hard disk space (5MByte * 4 channels * 3 minutes = 
60MByte).

Take good care of your Audio Files!

This can not be repeated too many times: Back up your files! Hard disk crashes are 
a well known fact in the computer industry, and the only way to insure yourself 
against any disasters is to maintain a meticulous back-up scheme. If you work pro-
fessionally, we suggest you invest in an removable disk based, DAT based or other 
back-up system and that you keep multiple copies of all files.
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Audio Segments and Events - Non-Destructive Editing
Cubasis AV is a random access based, non-destructive audio recording system – 
and even if that sounds like gibberish, you should be happy about it, as you will 
soon find out.

Non-destructive editing

Let’s say you have recorded a couple of minutes of guitar. During the first verse, 
there happens to be a brilliant section that you would like to use again in all the 
other verses. As you may know, this is possible using the “Copy and Paste” tech-
niques employed in most computer programs.

However, reusing material over and over again, normally wastes computer memory 
and/or hard disk space. With Cubasis AV it doesn’t!

If you “cut out” a section of audio, and paste it in, over and over again in the song, 
you are simply instructing the program to use the same portion of the audio file in 
many places, without actually copying the file. This is made possible via Cubasis 
AV’s use of segments.
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Segments

A segment is a specification for a section of an audio file. The segment contains in-
formation about where in the audio file to start playing and where to stop. It might 
be that the segment plays the entire file, or it could also be that it just plays a couple 
of seconds somewhere in the middle of the file.

You can create as many segments as you like, from the same file, as the example be-
low shows.

Audio file

Segments
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Audio Events

To actually play back a segment in your Song, you need to place an Audio Event in 
the Song. Each Audio Event plays a certain segment. 
Audio Events and segments are of course automatically created as you record, but 
you can also manually create events and segments when you are editing or assem-
bling recorded material.

In many cases, you will not “feel” any difference between handling Audio Events 
and segments, but there is one. For example, an Audio Event specifies where to 
start playing some audio, but the segment specifies the duration of playback. Also, 
you might delete Audio Events and still have access to the segment it played, so 
that some other Audio Event can play back the same segment in another part of the 
song. When there is an important difference between these two, this manual will 
tell you.

A Part contains Audio Events...

...which play segments (portions of an audio file).
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MIDI Inputs
Cubasis AV records from all active MIDI Inputs at the same time. In essence, this 
means you don’t have to care about selecting or activating MIDI Inputs. However, 
if you have multiple interfaces and want to deactivate an input for some reason, you 
could do this by quitting Cubasis AV, launching the application “setupmme” in 
your Cubasis AV folder and setting the Input to “Inactive”. 

MIDI Outputs
Each MIDI Track has a MIDI Output setting. This routes the data on the Track to a 
physical MIDI Output on one of your MIDI Interfaces.
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Standard Interfaces

Standard interfaces are identified in Cubasis AV by the names provided by their re-
spective drivers.

Multi-port Interfaces

If you have a multi-port interface, each of its MIDI Out connectors appears as a 
MIDI Output in the Output list. Setting a Track to a certain Output routes all the 
MIDI Data on that Track to that specific MIDI Out connector on the interface.

Select one of the ports on the Output pop-up menu 
to make the Track transmit data to that interface.

In this case, the Track will transmit all its data to MIDI 
Output number 1 on a Voyetra multi-port interface.
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How Cubasis AV records MIDI Channel data
Each MIDI Event that Cubasis AV records has a MIDI Channel number.

If for example you set your MIDI keyboard to transmit on MIDI Channel 5, all the 
notes, Pitch Bend data, program change or whatever you transmit from it, will have 
the MIDI Channel number 5.

This keyboard transmits on MIDI Channel 5.

Some MIDI devices can transmit on more than one MIDI Channel. In this case the 
MIDI input data coming in to Cubasis AV will contain mixed channel numbers.

This keyboard transmits on two MIDI Channels, – 2 and 6. It may for example transmit each 
channel from one side of a split point.

5
5

5
5 5

2
6

6

2

6
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Cubasis AV stores the MIDI Channel with the Event. If for example you look in 
List Edit (which you will learn about later in this manual), you can see the MIDI 
Channel for each Event that has been recorded.

In List Edit you can see 
the MIDI Channel 
stored with each Event.
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Rechannelizing – The MIDI Channel setting for the 
Track

When you play back a recording, you want it to be routed to a certain sound in one 
of your synthesizers. Let’s say you have a synthesizer that plays a bass sound on 
MIDI Channel 3. To route a Track to that sound you set it to MIDI Channel 3.

What now happens is that when you hit play Cubasis AV plays back all the data on 
the Track, but when doing so it replaces the MIDI Channel number stored in the 
Events with that of the Track – in this example, MIDI Channel 3!

This Track is set to play back 
on MIDI Channel 3.

These Events, on different 
MIDI Channels...

3

3

3

3
3

...get their MIDI Channel changed to 
that of the Track, during playback
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This replacement is done as part of the playback procedure, that is it does not affect 
the recording permanently. If you check the data on the Track in List edit (as men-
tioned above) all the Events still have their MIDI channel intact.

This is what we refer to as rechannelizing – changing the MIDI Channel of the 
Events on playback.

Rechannelizing is very convenient because it lets you forget what MIDI Channel 
number your keyboard is set to transmit on. Instead, to route a Track to a certain 
sound, you simply set the MIDI Channel number in the Track list in Cubasis AV.

And, if you decide you want to route the Track to another synthesizer, later, the 
only thing you have to do is to change the MIDI Channel setting for the Track.
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Rechannelizing also works on Thru-put!
The text above only described what happens on playback. But in fact, Rechanneliz-
ing happens on the data that passes Thru Cubasis AV. 

If you click on a Track to activate it, its MIDI Channel setting is used for rechan-
nelizing the data that passes through the program. This automatically routes your 
playing to the correct MIDI Channel when you are recording, or rehearsing for a re-
cording you are about to make.

If you make a 
Track active...

3

3

3

3
3

...its MIDI Channel value is used 
for rechannelizing the data that 
passes through Cubasis AV.

2

6

6

2

6
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Turning off Rechannelization – MIDI Channel “Any”
There’s one situation where you might not want rechannelizing and that’s when 
you have a Track that contains Events on multiple MIDI Channels. You might for 
example have:

• Recorded with a keyboard that can be “split” so that it transmits on two MIDI 
Channels.

• A guitar synthesizer where each string can transmit on a different MIDI 
Channel.

• Recorded the output of another MIDI sequencer onto a Track in Cubasis AV.
• Imported a MIDI File of Type 0, which by definition contains only one Track, 

possibly with Events on several MIDI Channels.

In each of these situations you might want to have the Track transmit on all its 
MIDI Channels – the MIDI Channels actually stored with each Event, as described 
above. This would allow you to set up several sounds and play them all from one 
Track.
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To do this, set the Track to MIDI Channel “Any” (the “lowest” value ).

Summary

To summarize: When a Track is set to MIDI Channel “Any”, rechannelizing is 
turned off, and the Events will be transmitted on their original MIDI Channels in-
stead.

These Events, on 
different MIDI 
Channels...

6

6

2

6
2

...will play back on their 
original MIDI Channels since 
the Track is set to “Any”.
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What can I do with the Cycle?
Cubasis AV can play back and record in a Cycle – a loop. You decide where the Cy-
cle starts and ends by setting the Left and Right Locators. When Cycle is active you 
can repeatedly listen to a section of the Arrangement, and record, adding more on 
each lap etc. Cycled playback is also convenient when making adjustments in the 
Monitor mixer or GM/GS/XG Editor.

Setting up the Cycle
1. Set the Left Locator to the position where you want the Cycle to begin.

2. Set the Right Locator to the position where you want the Cycle to end.

3. Click on the Cycle button so that it gets activated, or press [/] on the nu-
meric key pad.

The Left and Right Locator.

The Cycle button.
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Playing back the Cycle
When you play back with Cycle activated, the section between the Locators gets re-
peated indefinitely.

You can use any or all of the functions while the program is playing back. This fact 
allows you to use Cycled playback for a number of things, many of which you will 
learn about later in this manual:

• Rehearse a part before recording.
• Try different settings in the Monitor mixer or GM/GS/XG Editor.
• Mute Tracks to try out variations on an Arrangement.
• Make adjustments in the Inspector, apply Quantize etc.
• Make adjustments to the sounds in your instruments or try out a Track with 

another sound.
• etc., etc.
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Recording in Cycle Mode
Cycle Recording works differently for MIDI Tracks and Audio Tracks. The text be-
low describes the procedure and results of MIDI Cycle Recording; Audio Cycle 
Recording is described on page 103.

With MIDI Tracks

When you record in Cycle mode on a MIDI Track, you can add new notes to the 
Part for each Cycle “lap”. You may for example use it when recording a drum pat-
tern - record the kick drum on the first lap, the snare on the next and so on.

1. Set up the Cycle and activate the Cycle button.

2. Set up a Track to record on.

3. Click the Record button.

4. After the count-in, start playing.

5. Keep playing on each lap of the Cycle until you are done.
The new notes are added to the existing ones.
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● If you punch out manually by clicking the Record button after each recorded 
lap, you can listen to the latest recording, and use the Undo command to de-
lete it if you are not satisfied. Then, simply punch in again and try again on 
the next lap.

6. Stop Cubasis AV or punch out manually by clicking on the Record button 
again.

Switching MIDI Tracks while recording

You can record on more than one Track while in the Cycle (this only works with 
MIDI Tracks):

1. Set up a few Tracks on which to record. Also set up the instrument(s) so 
that they play the right sounds on these MIDI Channels.

A few Tracks set up for recording a four bar groove.
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2. Enter recording in Cycle mode.
Record on the first Track.

3. Without stopping, select a new Track in the Track list or use the [↑ ] and 
[↓ ] keys to step through the Tracks.
Selecting a new Track automatically routes your playing to the new sound.

4. Record on this second Track as with the first.

5. Keep recording on different Tracks until you are finished.

6. Stop Cubasis AV or punch out manually.

With Audio Tracks

When you record in Cycle mode on an Audio Track, the new music is not simply 
added to the old. Instead you will get a separate “take” for each recorded lap, and 
can decide afterwards which one to use. Let’s say that you want to record an instru-
mental solo passage or a lead vocal:

1. Set up the Cycle and activate the Cycle button.

2. Set up a Track to record on.

3. Click the Record button.
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4. After the count-in, start performing.
For each lap, try a new take, until you are satisfied.

5. Stop recording.
You will find that all your audio “takes” are lined up as one long Audio Event 
in one long Part, as if Cycle had been turned off for that Track only. Now you 
need to cut up this long Part into several smaller Parts, one for each take:

6. Select the Scissors tool from the toolbox, hold down [Alt] and click on 
the recorded Part, at the position of the Right Locator.
The Part will be split into several Parts, each one as long as the Cycle and 
containing one take. 

7. Listen to each of the Parts and decide which one to keep.
To make this easy, a good idea is to create new Audio Tracks (so you have one 
for each take), and position all the Parts between the Left and Right locator, 
but on different Tracks. Then click in the “M” column to Mute all the Audio 
Tracks except one - the one with the take you want to listen to. You could also 
use the Solo function to quickly switch between Tracks with different takes 
(see the chapter “Mute and Solo”).

8. Move the selected Part into place, on the right Track, between the Left 
and Right Locator.
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9. Select the other Parts and press [Backspace] to erase them.
This will not remove anything from your hard disk, only the Parts from the Ar-
range window. If later you want to permanently remove the unused takes 
from your hard disk, you need to use the “Erase Unused” command in the 
Pool, as described on page 228.

● As long as you don’t delete the unused takes permanently, they will be avail-
able as segments in the Pool. This means that you can drag them into the Ar-
rangement and use them later if you wish. See page 235.
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7

Playback, Tempo and the Transport Bar7
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The Transport Bar
Below, you will find a brief description of each control on the Transport Bar:

Record end point and end of Cycle.

Record start point and 
beginning of Cycle.

Handle for moving the window.

Song Position Time SignatureTempo

Flashes when MIDI signals are 
sent from Cubasis AV.

Turns the Metronome On/Off.

Turns the Master 
Track On/Off.

Flashes when 
MIDI signals 
are received by 
Cubasis AV.

RecordRewind Forward Stop Play

Position slider

Turns Cycle On/Off.
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Hiding and showing the Transport Bar

To hide the Transport Bar, either select “Hide Transport” on the Windows menu or 
press [F12] on the computer keyboard. To bring it back, select “Show Transport” 
from the Windows menu or press [F12] again.

When the Transport Bar is hidden, you can still access all its functions via the com-
puter keyboard. See below for a list of Transport Bar commands.

Moving the Transport Bar

You can put the Transport Bar anywhere you want it, by dragging the handles. It 
will always stay on top of the other Cubasis AV windows.
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The Numeric Key Pad
The numeric part of the computer keyboard is used for many Transport Bar opera-
tions. Some of these are described in more detail later in this chapter.

In addtion to this, the Page Up and Page Down keys function as Fast Forward and 
Rewind and the Space bar also functions as Stop button.

Num
Lock ÷ x –

7 8 9

4 5 6 +

1 2 3

0 , Enter

Record

Lower Tempo

Raise Tempo 

Play

Cycle On/Off

Go to 

Go to 

Go To 

Go To 

Cue Point

last Stop

Left Locator

Right Locator

Stop
- 109 - 



Basic Tempo and Time Signature Handling

Transport Bar and Master Track Tempo

There are actually two sources for the tempo in Cubasis AV:

• When the song uses a steady tempo throughout, you don’t need to use the 
Mastertrack and can have the Master button on the Transport Bar turned off 
and simply set the right tempo directly on the Transport Bar. The tempo can 
be adjusted at any time, even while playing back.

• When the song contains tempo changes, you need to use the Master Track, 
(which is Cubasis AV’s tempo Track and more!). For those tempo changes to 
actually “happen” on playback, the Master button on the Transport Bar must 
be activated. This is all discussed in the chapter “The Master Track”.

The Tempo setting on the 
Transport Bar is used.

The Tempi set on the 
Master Track are used.
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Setting the Transport Bar Tempo

The tempo on the Transport Bar is adjusted like any other value (see page 22 in this 
book). The value is in BPM (Beats Per Minute). The integer and fraction part can 
be adjusted separately, if necessary.
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Setting the Song and Time Position

Using Fast Forward and Rewind

The Song Position can of course be moved using Fast Forward or Rewind. If you 
hold down [Shift] while clicking the button, Rewind/Fast Forward is much faster.

By moving the Song Position in the Ruler

You can drag the Song Position Pointer directly in the ruler simply by pointing at 
the triangle, pressing the mouse and dragging left or right.

Dragging the Song Position.

Rewind Fast Forward
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By double clicking in the Ruler

If you double click somewhere in the ruler, the Song Position Pointer is moved there.

By using the Position slider

The position slider is located on the Transport Bar. You can drag the handle or click 
directly somewhere on the line to move the handle there. 

The range of the slider is relative to the length of your song. This means that if you 
drag the slider all the way to the right, the Song Position will be moved to the end 
of the last Part.

Dragging the position slider.

Double click in the ruler... ...to move the Song Position Pointer.
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About the Snap Value

When you change the Song Position in the ruler or by using the position slider, the 
Snap value helps you find exact positions quickly. It does this by limiting the possi-
ble points for positioning to Bar, half note, quarter note, etc. Snap can also be set to 
Off; then all movements are unrestricted.

The Snap value is set with the Snap pop-up at the top of the Arrange window.

Value Description

Off Any position can be used.

Bar Movement is restricted to exact bar lines.

1/4 to 1/16 Movement is restricted to the selected note 
value.

The Snap pop-up.
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Changing Position values on the Transport Bar

You can adjust the Position values on the Transport Bar as described in the chapter 
“Basic Methods”. The Song pointer is moved accordingly.

If Snap is set to Bar...

...the Song Position can only be dragged to exact bar lines.

If Snap is set for example to 1/4...

...the Song Position can be put on any quarter note position.
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Making relative Position changes

If you double click on either position value and enter a new one, preceded by a “+” 
or “–” character, the song position is changed accordingly.

Double click...

...enter a value 
preceded by 
+ or – ...

...and the value 
gets added to the 
existing position
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Returning to the beginning of the Song

If the Song is stopped and you click the Stop button again (or press [0] on the nu-
meric key pad), the following happens:

• The Song Position is moved to the Left Locator.
• If the Song Position is already at the Left Locator or to the left of it, the Song 

Position is moved to the beginning of the Song.

This means that you can always click twice on the Stop button to return to the be-
ginning of the Song.

Going to the left side of the window

If you press the [Home] key on the computer keyboard, the Song Position Pointer is 
moved to the left side of the window.

Going to the last Stop Position

If you press [9] on the numeric key pad, the Song Position moves to the place you 
last stopped at.
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Moving to the Locators

• If you press [1] on the numeric key pad, the Song Position is moved to the Left 
Locator.

• If you press [2] on the numeric key pad, it is moved to the Right Locator.

Using Cue Points

Cue points are used to quickly locate to any position. If for example you often find 
yourself jumping to the beginning of the first chorus, set up that position as a cue 
point.

Programming Cue Points

1. Set the Song Position to where you want the Cue Point to be located.

2. Hold down the [Shift] key and press any of the keys [3] to [8] on the nu-
meric key pad.
The key is now programmed with that position.

Locating to Cue Points

If you press any of the keys [3] to [8] on the numeric key pad, the Song Position is 
moved to the position programmed for that key.
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Cueing
Cueing is when you fast forward through the music while playing it. You might 
have done this on a multi-track tape recorder. The big difference with Cueing in 
Cubasis AV is that the music is played back with normal pitch.

● Cueing only works with MIDI Tracks; Audio Tracks are silenced during Cueing.

1. Hold down the [Control] key.

2. Click and hold down the mouse button with the pointer over the Fast 
Forward button.

• To change the speed of cueing, drag the mouse left/right.
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Locators
As described in the previous chapters, the Left and Right Locator are crucial for re-
cording, setting up a cycle, etc. There are several ways of setting the Locator posi-
tions:

Setting the Locators by clicking in the Ruler

1. Set the Snap value.
The Snap value restricts the positions to which you can move the Locator, as 
with the Song position, see page 114.

The Snap pop-up.

2. Click somewhere in the ruler with the left mouse button, to move Left 
Locator.
The Locator appears at that position. To move the Right locator, click with the 
right mouse button.
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Setting the Locators on the Transport Bar

You can also adjust the Left and Right Locator position by changing the numerical 
values in the Locator boxes on the Transport Bar.

Making relative Position changes

Just as with positions (see page 116 in this book) you can double click and enter a 
new value, preceded by a “+” or “–” character. When you hit [Return] the Locator 
is moved relative to its current position.
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Managing Tracks 8
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What can I do with Tracks?
The Track is one of the most basic concepts in Cubasis AV. Every time you record 
something in Cubasis AV, the recorded material is placed on a Track. You can have 
up to 64 Tracks in each Arrange window, and you can easily move or copy material 
between Tracks, as long as they are of the same type (MIDI or Audio).

When you are working with audio, different Tracks can be set to play back on dif-
ferent audio channels, which is essential if you want several audio files to be played 
back simultaneously (as described in the chapter “How Cubasis AV handles audio 
and MIDI”). In MIDI recording, the most obvious reason for putting the recorded 
material on different Tracks is perhaps that you want to have your music played 
back by different “instruments” - or maybe rather by different sounds on a MIDI 
sound module or keyboard. But there are also many other advantages of working 
with multiple Tracks.
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Creating Tracks
Create a new Track when you want to add another “layer” to your recording. You 
might for example want to add another audio or MIDI recording, or make room for 
an alternative version of a part in your music. There are several ways to create a 
new Track:

• By double clicking in the Track List.

• By selecting Create Track on the Edit Menu.

• By pressing [Control]-[T] on the computer keyboard.

● The maximum number of Tracks in an Arrangement is 64.

Double clicking in an empty 
part of the Track List... ...creates a new Track.
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Properties of the new Track

Track Type

There are two types of Tracks, Audio Tracks and MIDI Tracks. If you create a 
Track using any of the above methods, it will get the type of the Track that was pre-
viously selected. If you start with an empty Arrange window, the first Track you 
create will be a MIDI Track. You can easily switch type for any Track as long as it 
doesn’t contain any Parts (see page 126).

Track Name

If you start with an empty Arrange Window (with no Tracks), and create a new 
Track, it gets the name “Track 1”. Next time you create a New Track, this gets the 
name “Track 2” and so on. You can rename a Track at any time (see Naming 
Tracks, below).

Audio/MIDI Channel

When you create a Track, it will be set to a channel “one higher” than the previ-
ously selected Track, with the reservation that the highest audio channel is 8 and 
the highest MIDI channel is 16. If you start with an empty Arrange window, the 
first Track you create will be set to Audio/MIDI channel 1.
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Naming Tracks
You can rename a Track simply by double clicking on its current name in the Track 
List, and typing in a new name.

Selecting Track Class
There are two different types of Tracks, called Track Classes: Audio and MIDI 
Tracks. If a Track contains no Parts, you can select Track Class in the following 
way:

1. Press the mouse button with the pointer in the “C” column for a Track.

2. Select “MIDI Track” or “Audio Track” from the pop-up menu that ap-
pears.
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Selecting Tracks
If you want to record on a Track, change settings for it or perform an operation that 
affects a whole Track, the Track itself has to be selected so that Cubasis AV “under-
stands” which Track you wish to direct the action to.

By clicking

1. Click in the name field of the Track you want to select.

2. The Track gets inverted (white on black).
The Track you have selected is called the “active Track” or the “selected 
Track”.

This Track is selected.
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By using the keyboard

You may also “move” the selection up or down in the Track List by using the [↑ ] 
and [↓ ] keys on the computer keyboard. This will select the Track above/below the 
currently selected.

Finally, you may also press [Alt Gr]-[T] on the computer keyboard, and type in the 
number of the Track you want to select (counted from the top of the Track List).

If you press the [↑ ] key...

...the Track above in the 
Track List gets selected.
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Changing the order of the Tracks
You can rearrange the Tracks in the list like this:

● All the Parts on the Track are moved with the Track.

1. Press the mouse button with the pointer 
on the Track you want to move. The pointer 
takes on the shape of a hand.

2. Drag the Track with the mouse 
button pressed. A dotted outline shows 
you where the Track will be placed.

3. When you release the mouse button, 
the Track is moved to its new position.
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Duplicating Tracks
You may make a copy of a Track and all Parts on it. 

1. Position the pointer on the name of the Track in the Track List.

2. Hold down [Alternate] on the computer keyboard and press the mouse 
button.

3. Drag the outline of the Track to an empty  field in the Track List.
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4. Release the mouse button.

● You can not duplicate empty Tracks.

A duplicate of the selected 
Track is created and placed, 
complete with Parts, at the 
bottom of the Track List.
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Deleting Tracks
You may delete a Track and all Parts on it.

1. Make sure that no Part is selected (inverted).
This is to make sure that what you Delete will be a Track, not a Part. 

2. Press [Backspace] on the computer keyboard or select Delete on the Edit 
menu.

● If you change your mind, you can undo the Delete Track operation with the 
Undo option on the Edit menu, or by pressing [Control]-[Z] on the computer 
keyboard.

Check that this menu item says 
“Delete Track”, not Delete Parts.
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The Track Columns and the 
Inspector 9
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The Track Columns
The Track columns show names and settings for the Tracks. Some of these settings 
can be changed directly. 

Getting the Track Columns to appear

The Arrange Window is divided into two parts, the Track columns to the left and 
the Part display to the right. To get all of the Track columns to appear, press the 
mouse button with the pointer positioned above the Divider (the border between the 
two parts of the Arrange Window) and drag it as far to the right as possible. You 
should now be able to see all of the Track columns.
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The Divider, dragged as far right as possible.
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Changing the order of the Track Columns

You can arrange the vertical columns in any order you like, by simply dragging the 
headings to the left and right, respectively.

If you drag to the left, the column will be inserted to the left of the column you 
“drop it on”. If you drag to the right it will be inserted to the right of the column you 
“drop it on”.

The Class Column

This column (labelled “C”) is used to select Track Class (MIDI or Audio Track - 
see page 126). The Class for each Track is indicated by a symbol in the C column:

MIDI Track

Audio Track
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The Mute Column

The Mute column is indicated by an “M”. By clicking in this column, you tempo-
rarily “silence” the Track. A black dot is displayed in the column. To make the 
Track sound again, you just click in the Mute column again. This is described in de-
tail in the chapter “Mute and Solo”.

The Track Column

This column shows the Track's name. To enter or change a name, double click in 
this field for the relevant Track.

Click in the “M” column...

...to Mute the Track. The black dot indicates that a Track is Muted.
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The Chn Column

The Chn column shows the Audio/MIDI Channel for each Track. You may change 
the channel of a Track at any time. For a full explanation of Audio/MIDI Channels 
and the effect of changing them, see the chapter “How Cubasis AV handles audio 
and MIDI”.

The Output Column

For MIDI Tracks, the Output column shows which physical MIDI Output each Track 
uses (see the chapter “How Cubasis AV handles audio and MIDI”). For Audio 
Tracks, this column will always show the word “WaveAudio”.

• If you hold down [Control] while you change the Output value, all Tracks 
will get the selected Output value.

To change Output for a Track, position the pointer in its Output column, 
press the mouse button...

...and select the MIDI Output you want from the pop-up menu that appears.
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Using the Inspector

● The information in this section is mostly relevant to MIDI Tracks/Parts only. 
For Audio Tracks, the Inspector is mainly used to set up the Tracks for record-
ing, as described on page 46.

What is the Inspector?

The Inspector is a part of the Arrange Window. It contains a number of value- and 
name fields where you can change settings and properties of a Track, or individual 
Parts on a Track. 

There is one important thing to remember before you start working with the Inspec-
tor:

● The settings you make in the Inspector will only affect the material during 
playback. You don’t actually change the recorded data itself. 
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This also means that Inspector settings, such as transposition, are not shown when 
you edit a Part. To make these settings permanent you need to use the Freeze Play 
Parameter item on the Functions menu, as described on page 149.

When you play back notes 
from a Part...

...they pass through 
the Inspector...

...and are output, in this 
example transposed one fifth 
(i.e. seven semitones) upward.

The actual recorded material 
in the Part is not affected.
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Getting the Inspector to appear

You open the Inspector by clicking on the strip with the little Inspector Icon below 
the Track column, or by pressing [Alt Gr]-[I]. An area to the left of the leftmost col-
umn in the Track list appears. In this you find a number of value fields, name fields 
and buttons. These are described in the following pages.

...to open the Inspector.Click on the Inspector Icon...

To close the Inspector, click 
on the Inspector Icon again.
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Changing values in the Inspector

By changing values in the Inspector, you make changes to your Parts and Tracks. 
Some fields are duplicates of settings in the Track columns or the GM/GS/XG Edi-
tor, while others can be found only in the Inspector. To get a basic concept of how 
to use the Inspector, follow the steps below:

1. Open the Inspector.

2. Select a MIDI Track on which you have recorded some music.

3. Check that no Parts are selected.
The heading of the Inspector should read “Trackinfo” - otherwise, just click on 
an empty area in the Part Display.

4. Start playback.

5. While the music is playing, try changing the “Transpose” and “Volume” 
values in the Inspector.
The transposition and volume of the played back music will change accord-
ingly.
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Making Real-time changes with the Inspector

When you change the value of a parameter in the Inspector, the new value is imme-
diately sent out to the MIDI Output. This will affect not only the sound source as-
signed to the selected Track, but all MIDI devices connected to the same Output as 
the Track, and set to receive on the same MIDI Channel.

You may use this feature for setting appropriate values (e.g. volume, velocity etc.) 
while the music is playing.
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What is affected by the Inspector?
This depends on what is selected in the Arrange window. The following possibili-
ties exist:

When a Track, but not a Part, is selected:

When no Parts are selected, the Inspector has the heading “Trackinfo”. The param-
eter values affect the selected Track, and all the recorded material (the Parts) on it.

The Inspector opened for the Track “Bass”.
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When One MIDI Part is selected:

The Inspector has the heading “Partinfo”. The parameter values affect the selected 
Part only.

The Inspector opened for the Part ”Bass Verse”.

When Two or more MIDI Parts are selected

The Inspector has the heading “Partinfo”, and shows the parameter values for one 
of the selected Parts. If you change a parameter the changes will be applied to all 
selected Parts.
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How MIDI Part and Track settings relate

As you have seen, you may change parameter values both for the whole MIDI 
Track and for individual Parts on the Track. It is the latest change that “counts”. If 
for example you change the velocity value of a single Part and then set another ve-
locity value for the whole Track, the Part will also get this latest velocity value. 
Other parameter settings for the Part will remain unaffected.

Make various settings for a Part... ...then change the velocity value for the 
whole Track.

Now the velocity value for the Part is changed to that of the 
Track, but the other settings for the Part remain unaffected.
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The Fields and Values in the Inspector
The Inspector contains names, numerical values and pop-up menus. All these set-
tings can be changed using any combination of mouse and keyboard, as usual. Like 
all other changes, these can of course be done while the music is playing and even 
while recording.

Audio Parts/Tracks

Parameter Explanation

Track/Part 
Name

If a Track is selected, this shows the Track’s name. If a Part is se-
lected, this displays the name of the Part.

Output Always “WaveAudio”.

Channel The audio channel the Track uses, as described on page 80.

Filename This is the name of the file you are currently recording into. See 
page 48.

Rec Chn 
Mode

Use this button to determine whether the next recording on the 
Track should be in Mono or Stereo, as described on page 46. 

Free Space This shows you how much recording time you have left on your 
hard disk.
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MIDI Parts/Tracks

Parameter Explanation

Track/Part 
Name

The name of the selected Track or Part.

Output The  physical Output port for the selected Track or Part.

Chn The MIDI Channel associated with the Track. 

Patch If you are using a soundcard with a built-in synthesizer that supports 
SoundFonts (such as the Creative Labs AWE series) you can use this 
field to select sounds for the synthesizer (see page 158).

Bank Lets you associate a MIDI Bank Select message with a Track or a 
Part, to make an instrument switch “program bank” (see page 157).

Prg Lets you associate a MIDI Program Change message with a Track or 
a Part, to make a connected instrument switch from one sound to 
another. If GM, GS or XG Mode is activated in the GM/GS/XG Edi-
tor, clicking this field will open a hierarchical pop-up menu, where 
you can select a GM instrument by name.

Volume A volume value for a Track or a Part. This setting is sent out as a 
MIDI Volume message.

Transp Lets you transpose the notes in a Part or a Track.

Veloc The value in this field is added to the velocity of the notes played 
back.
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Using Freeze Play Parameters
As mentioned above, the Inspector settings (or “Play Parameters”) does not change 
the MIDI Events themselves, but works rather like a “filter”, affecting the music on 
playback. However, sometimes you may want to make these settings permanent, 
i.e. convert them to “real” MIDI Events in the Part. You might for example want to 
transpose a Part and then edit the transposed notes in a MIDI editor. For this, you 
need to use the Freeze Play Parameters item on the Functions menu:

1. Select the Part(s) with Inspector settings you want to make permanent.
If no Parts are selected, all Parts on the active Track will be affected.

2. Pull down the Functions menu and select “Freeze Play Parameters”.
Bank Select, Program Change and Volume settings in the Inspector will be 
converted to MIDI Events and inserted at the beginning of the Part(s). All notes 
in the Part(s) will be modified according to the Transpose and Velocity settings 
in the Inspector, and the Inspector settings will be reset.

● When you export a MIDI file, all Inspector settings are automatically included 
in the file, with no need to perform Freeze Play Parameters.
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Real-time Thru
In most MIDI recording situations, the Thru function in Cubasis AV is used to 
“echo” incoming MIDI data via MIDI Out. If you use the Thru function, the MIDI 
data that Cubasis AV receives via MIDI In is modified in real-time by some of the 
Playback parameters. This means that if you for instance set a transposition value 
of 7 (semitones) and play your keyboard, all notes coming out via the MIDI Out are 
transposed a perfect fifth higher.

Notes from the keyboard...

...are passed through 
the Inspector...

...and output again, 
transposed a fifth higher.
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This allows you to try out what effect a certain parameter setting will have on the 
music, before and when you record something. Since different Parts can have dif-
ferent settings you must select the right Track and check that the Song Position is 
somewhere within the Part that has the settings you want to try. 

● It doesn’t matter which Part or Track you have visible in Part Info (you may 
have stepped through the Parts and Tracks with the arrow keys on the compu-
ter keyboard), it is only the Song Position and Active Track which determines 
which Part’s settings should be used for the real-time modification. 

The real-time parameters used for modification are Transpose and Velocity.

The settings for the Part in the “cross” made up by the Active 
Track and the Song Position are used for real-time “Thruing”.
- 151 - 



10

Program Change and MIDI Volume10
- 152 - 



Why you should read this Chapter
When you arrange in Cubasis AV you will find yourself spending some time select-
ing Programs and setting Volumes for each instrument. This will be significantly 
easier if you understand exactly how and where Program Change and Volume can 
be inserted and the advantage that the different methods have.

● This chapter is not relevant if you only work with audio.

Program Change
Program Change messages are used to switch between sounds in your instruments. 
By inserting Program Change messages for all MIDI Channels, at the beginning of 
the Song, the instruments will automatically play with the correct sounds when you 
open and play the Song (if you haven’t “re-programmed” your instruments since 
you played the Song last).

By inserting Program Change messages somewhere in “the middle” of a Song, you 
can use one MIDI Channel for playing several different sounds throughout the 
Song. This allows you to use “limited MIDI resources” as effectively as possible.
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Entering Program Change in the Inspector

You can enter Program Change messages in the Inspector, either for the whole 
Track or for one Part at a time. If you’re not sure how this is done, refer to the chap-
ter “The Track Columns and the Inspector”.

• If you enter a Program Change for the Track, this Program Change will be 
sent out at the beginning of every Part on that Track.
This might not always be desirable, since some devices shut off their sound 
momentarily when they receive a Program Change message.

• If you enter a Program Change message for a certain Part, this is only 
sent out where that specific Part starts.
For instance you can enter one Program for the first Part on the Track and then 
another for a Part later in the Song, where you want the device to switch to 
another Program (see the example on the next page).
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● As described in the the chapter “The Track Columns and the Inspector”, the 
Prg field in the Inspector will show a GM Program name instead of a number, 
if GM, GS or XG Mode are activated in the GM/GS/XG Editor.

This Part sends out Program Change 
number 4 when you start the Song 
from the beginning.

Later in the Song, this Part sends out 
Program Change 52 to make the 
device switch to another Program.
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Resetting Program Change

If for example you Copy and Paste or duplicate Parts a lot, Program Change mes-
sages might also get copied or moved, ending up in positions where you don’t want 
them. The quickest way to get around this might be to start over from scratch:

1. Make sure no Part is selected.

2. Select the Track for which you want to “reset” Program Change.

3. Use the Inspector to set the Program Change to “Off”.
Even if the box already says “Off”, adjust the value up and then down again to 
make sure all Parts are set to “Off”.

4. Now select each Part for which you want a Program Change message, 
and enter it in the Inspector.

Make sure that the Inspector says 
“Trackinfo” at the top. Then, if you set 
Program Change to Off, this setting is 
“copied” to all Parts on the Track.
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About Bank Select

With Program Change messages, you are able to select between 128 different pro-
grams in your MIDI device. However, many MIDI instruments contain a larger 
number of program locations. To make these available from within Cubasis AV, 
you need to use Bank Select messages, a system in which the programs in a MIDI 
instrument are divided into Banks, each Bank containing 128 programs. If your in-
struments supports MIDI Bank Select, you can use the Bank field in the Inspector 
to select a Bank, and then the Prg field to select a program in this Bank.

● Technically, a Bank Select message is actually a combination of two MIDI 
Controller messages (Controller 0 and 32). However, not all manufacturers 
follow the MIDI Standard in this aspect; some instruments use Controller 0 
messages as a replacement for standard Bank Select messages. If this is the 
case with your instruments, you need to multiply the value in the Bank field 
with 128 to select program Banks. Refer to the documentation for your MIDI 
equipment for more information.
- 157 - 



Selecting SoundFont Banks and Patches

If you are using a soundcard that supports SoundFonts, such as the Creative Labs 
AWE series, Cubasis AV offers a special feature to make it easier to select sounds 
for the card’s built-in synthesizer:

1. Make sure the card’s built-in wavetable synthesizer is selected on the 
Output pop-up menu.

2. Pull down the Bank pop-up menu and select a SoundFont Bank.
The Banks are displayed with names instead of numbers.

3. Instead of using the Program Change (Prg) pop-up menu, pull down the 
Patch pop-up menu.

A list is displayed, containing all the SoundFont names for the sounds in the 
selected Bank.

4. Select a Patch from the pop-up menu.

● Cubasis AV automatically detects an installed SoundFonts compatible sound-
card and makes the SoundFonts Patch pop-up menu available, provided that 
the proper software is installed. This is usually done automatically when in-
stalling the card. If in doubt consult the documentation for the card.
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Recording or Entering Program Change in the Editors

You can record Program Change messages if you have equipment that can transmit 
them. This is done as with any other MIDI recording in Cubasis AV, simply enter 
Record mode and transmit the message (probably by selecting a new Program on 
the front panel of your instrument).

You can also enter Program Change messages “by hand” in List Edit. Entering Pro-
gram Change messages in List Edit allows you to put them anywhere you want 
them, even in the middle of a Part. It also allows you to perform editing functions 
on them.
- 159 - 



Which should I choose - Inspector Settings or “Real” Events?

Well of course, it’s up to you. The only advice we’d like to give is not to mix the 
two methods unless you are absolutely sure of what you’re doing. For more help in 
your decision, please check the table below:

Method Advantages Disadvantages

Inspector • Can be viewed and changed in real 
time from the Arrangement, while the 
music is playing.

• Always positioned at be-
ginning of a Part.

Recording 
or enter-
ing in List 
Edit

• Can be entered anywhere in a Part.

• Can be edited using all the available 
edit tools.

• Finding the right Program number 
might be easier by recording a button 
on the synth front panel than by typing 
in a number.

• Can’t be changed or dis-
played from the 
Arrange window.
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Program Change Numbering

Program Change numbers range from 1 to 128 in MIDI. Some instruments use 
other types of numbering; some count from 0 to 127 and others have the numbers 
divided into Banks (A 1 to 32, B 1 to 32 etc.). To find the right number to enter in 
for example the Inspector, consult the device’s operation manual or simply experi-
ment until you get it right!
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MIDI Volume
MIDI Volume is a MIDI Controller message, Controller 7 to be exact. When a de-
vice receives MIDI Volume messages it is supposed to adjust its volume for that 
MIDI Channel, just as if you had changed it directly from the front panel.

● Some very old synthesizers might not be able to “read” MIDI Volume!

Entering Volume in the Inspector

Just as with Program Change messages you can enter MIDI Volume messages in 
the Inspector for individual Parts, for example to get a basic mix at the beginning 
and to introduce volume changes at different positions in the Song.

When Cubasis AV plays back 
this Part, the instrument will 
receive a MIDI Volume 
message to set its Volume to 
a value of 115.
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Entering Volume in an Editor

You can enter single MIDI Volume messages in the List editor. But it is often more 
useful to use the Controller Display in Key Edit. This allows you to “paint” volume 
curves, to easily create fade ins and fade outs etc.

A Fade in, drawn in Key Edit.
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Which should I choose - Inspector Settings or “Real” Events?

Again – it’s your choice, but the table might give some advice:

Method Advantages Disadvantages

Inspector • Visible directly from the Ar-
range window.

• Can be changed in real time 
from the Arrangement, while the 
music is playing.

• Can only be used for “direct 
changes” not for fades.

• Always appear at the beginning 
of the Part.

Recording 
or entering 
into an edi-
tor

• Can be entered anywhere in a 
Part.

• You can draw in smooth curves 
in Key Edit.

• Can be recorded from external 
equipment such as a foot pedal 
or slider.

• Can be edited using all the 
available edit tools.

• Not visible from the Arrange 
window.

• Can’t be changed from the Ar-
range window.
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Mute and Solo 11
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What is Muting?
Using the Mute function you can silence some of the music without actually delet-
ing it. This is useful in many situations; you may for example want to try out differ-
ent variations of an Arrangement by muting some parts of the music, or listen only 
to the rhythm section of a song etc.

Muting a Track

To “unmute” a Track, simply click on the black dot.

● If any notes are sounding at the moment you Mute a Track, they are allowed 
to play until their end.

Clicking in the Mute column...

...silences the Track. The black dot indicates that the Track is Muted.
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What is Solo?
The Solo function works as an “inverted” Mute - that is, if you Solo a Track, all 
other Tracks get Muted. This is useful if you want to listen closely to the contents of 
a Track, and don’t want any other music to interfere. Solo a Track like this:

Click on the Solo button in the upper left 
corner of the Arrange Window to activate Solo.

The highlighted Solo 
button indicates that 
Solo is activated.

All Tracks except the 
currently selected, 
get Muted.

If you select another Track, 
it will get Soloed instead.
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Instead of clicking on the Solo button, you can press [S] on the computer keyboard. 
You can unmute one or more Tracks while in Solo mode if you want to hear, for ex-
ample, just how two or three Tracks sound together.

To deactivate Solo, click on the Solo button (or press [S]) again. All Tracks will re-
turn to the Mute status they had before Solo was activated.
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About Parts and Arranging
As you have already seen, a Cubasis AV Arrangement is roughly structured in two 
“levels”: Several Tracks, each containing a number of Parts . This chapter is about 
Arrangement editing - in other words, re-arranging Parts. This is done in the right 
part of the Arrange Window, the area called the Part Display.

The Arrange Window with the Part Display on the right side.
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About the Tools

When manipulating the Parts, you will make use of the various tools in the Tool-
box. 

• To display the Toolbox and select a tool, click the right mouse button.
The pointer takes on the appearance of the selected tool when moved into the 
Part Display.

The tools are all described later in this chapter, in the contexts in which they are 
used.

The Arrow tool

The Pencil tool

The Eraser tool The Scissors tool

The Magnifying 
Glass The Glue tube
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About Overlapping Parts

Parts on the same Track might overlap or be completely on top of one another. 
However, there is a big difference between the two types of Tracks:

• On Audio Tracks, only the Parts that you can see are played back.
This means that if two Parts overlap, the section that is obscured will be silent.

• On MIDI Tracks, all sections of all Parts will be played back, no matter if 
they are visible or not.
You can make good use of this feature in many ways:

• Parts which start with an upbeat can overlap the end of the previous Part.
• Small drum ornaments (such as cymbal crashes) can be created as separate 

Parts and just be put on top of the basic beat Part.
• Duplicate Parts which are used to create delay effects, double sounds and so 

on, can be put on top of the original Parts.
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Creating Parts
Parts are created automatically when you record, but there are situations when you 
may want to create empty MIDI Parts and “fill them” with Events in one of the ed-
itors. This is essential if you want to create music using Step Recording (see page 
350). Parts can be created using the following methods:

• By selecting Create Part on the Parts menu or by pressing [Com-
mand][Control]-[P] on the computer keyboard.
This will create an empty Part on the selected Track, between the Left and 
Right Locator.

• By double clicking with the Arrow tool between the Left and Right Locator.
This will create an empty Part between the Locators on the Track you clicked 
on.

• By drawing an outline in the Part display with the Pencil tool.
This will create an empty Part with the size and position of the drawn outline. 
Remember that the Snap value applies as usual.
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Selecting Parts
You have to select a Part in order to move, delete or in any way manipulate it. Se-
lecting a Part can be done in several different ways:

By clicking

Clicking on a Part with the Arrow tool...

...selects it and deselects all other selected Parts.
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By shift-clicking

Clicking on a Part while holding down [Shift]...

...selects the Part.

The previously selected Part(s) remain selected.
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By using the computer keyboard

• If you hold down the [Shift] key, the previous Parts will remain selected.

Pressing the right 
arrow key on the 
computer keyboard...

...selects the next Part 
on the same Track.
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By enclosing them in a rectangle

If you hold down [Shift] when you start to drag, you don’t have to have the pointer 
in an empty area, you can start with the pointer positioned over a Part.

...and drag the mouse with 
the button pressed. A dotted 
outline of a rectangle is 
shown.

When you release the mouse 
button, all Parts that were 
enclosed or “touched” by the 
rectangle, become selected.

Press the mouse button with 
the pointer somewhere in 
an empty part of the Part 
Display...
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Selecting all Parts

On the Edit menu you will find an item called “Select All”. This item selects all 
Parts in the Arrangement.

• You can also select all Parts by pressing [Control]-[A] on the computer key-
board.

Selecting all Parts on one Track only

If you hold down [Shift] on the computer keyboard and double click on a Part, all 
Parts on that Track get selected.
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Deselecting Parts

There are two principal ways to deselect already selected Parts:

1. If you click in some empty area in 
the Part Display...

...all selected Parts get deselected.
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2. If you instead hold down [Shift] and click on a Part...

...the Part gets deselected, but the other selected Parts remain selected.
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Manipulating Parts

About the Snap value

When you are moving, duplicating or changing the length of Parts, the result of 
your actions depends on the Snap value. 

Pulling down the Snap pop-up menu.
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This value determines the smallest distance you can move a Part. The table and fig-
ure below explains it more clearly:

Value Description

Off Any position can be used.

Bar Movement is restricted to exact bar lines.

1/2 to 1/16 Movement is restricted to the selected note value.

If Snap is set to Bar...

...the Song Position can only be dragged to exact bar lines.

If Snap is set for example to 1/4...

...the Song Position can be put on any quarter note position.
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Moving Parts

You can move one or more Parts to a new position on any Track of the same type. 
Remember that the Snap value determines where you can place the Parts.

Press the mouse button with the Arrow pointer over the selected Parts 
you want to move. The pointer takes on the shape of a hand.
- 183 - 



...and release the mouse button. The Parts are moved. 
Note that the relative distances between the moved Parts are kept intact.

Drag the Parts to their new position...
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Duplicating Parts

To duplicate Parts, hold down the [Alt] key on the computer keyboard and proceed 
exactly as when moving. You may move the duplicate to any position on any Track 
of the same type.

Another way of moving or duplicating Parts is to use Cut/Copy and Paste. These 
functions are described on page 35.

When you hold 
down [Alt] and 
drag a Part to a 
new position...

...a duplicate of the Part, complete with contents, is placed at the new position.

The original Part 
is not affected.
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Repeating Parts

You can repeat one or several Parts, on the same or different Tracks, using the Re-
peat function on the Parts menu:

1. Select the Part(s) you want to repeat.

2. Select the “Repeat...“ item on the Parts menu...
...or press [Control]-[K] on the computer keyboard.

3. Enter the desired number of copies in the dialog box that appears.
If you activate the “Ghost copies” checkbox, the copies will be Ghost Parts. 
Ghost Parts are described on page 196 in this chapter.
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4. Click “Do It”.
The selected Part(s) are repeated, and the copies are lined up “end-to-start” 
after the original(s). The Parts selected are treated as one block, so the relative 
spacing between the created Parts is determined by the beginning of the first 
selected Part and the end of the last.

Original Parts. Copies.
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Repeating Parts with the Pencil tool

If you hold down [Alt] while lengthening a Part with the Pencil tool, new Parts will 
be created, all lined up end-to-start after the Previous Part. The new Parts will be 
copies of the original, including all Events and playback parameters.

The outline shown when you drag the Pencil can be thought of as a “frame”, that becomes 
filled with as many copies of the original Part as possible.
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Merging Parts

Merging one Part with another adds the contents of the first Part to the second. Of 
course, the two Parts have to be of the same type, i.e. both MIDI Parts or both Au-
dio Parts. It is done like this:

1. Hold down the [Control] and [Alt] keys on the computer keyboard.

2. Drag the first Part and release it on top of the other Part.
As when moving a Part, the result of this depends on the Snap Setting. The 
start and end points of the two Parts don't have to match at all.

● The dragged Part is not erased or even moved. A copy of its contents is made, 
and it is this copy that is merged into the other Part. 
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Changing the Length of a Part

If you have an excessively long Audio or MIDI Part, you can easily shorten it using 
the Pencil tool.

● For Audio Parts, this will only create a new shorter Segment, without destroy-
ing any actual audio data. For MIDI Parts, however, shortening a Part will 
erase any MIDI data in the section that is removed.

1. Select the Pencil tool from the Toolbar.

2. Pull down the Snap pop-up menu and select an appropriate Snap value.
See page 181.

3. Click anywhere in the Part and keep the mouse button pressed.
A dotted frame appears, indicating the size of the Part.

4. Drag the Pencil to the left or right, and release the mouse button.
The Part is resized. You may use this method to make the Part longer as well, 
but this is not very useful, since there will be nothing in the lengthened sec-
tion!

● If you make a MIDI Part shorter with the Pencil tool, some notes may con-
tinue to sound after the end of the Part. To make these notes end when the 
Part ends, select the Part, pull down the Parts menu and select Cut Notes.
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Splitting a Part

To split a Part into two, you use the Scissors tool:

1. Select the Scissors tool from the Toolbar.

2. Pull down the Snap pop-up menu and select an appropriate Snap value.
See page 181.

3. Click in the Part where you want to split it.
You will get two Parts, with the same name as the original Part:

• If you hold down [Alt] and click on a Part with the Scissors tool, the Part 
is split into several sections.
The length of the sections is determined by where you click in the Part:
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Joining Parts

You can use the Glue Tube tool to join Parts together into one:

1. Select the Glue Tube tool.

2. Click on a Part.
The Part is “glued together” with the next Part on the Track. The resulting, 
longer Part will have the name of the first Part. It is OK if there is a gap be-
tween the two Parts.

Before and after glueing two Parts together.

• If you hold down [Alt] and use the Glue Tube tool, the Part you click on, 
and all following Parts on the Track, will be joined into one larger Part.
The resulting Part will have the name of the Part you click on.
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Scrubbing

With the Magnifying Glass tool, you can perform what is known as “Scrubbing”. 
This means that you can listen to the contents of each Part separately in Stop mode:

1. Select the Magnifying Glass.
From there on, the procedure differs for Audio Parts and MIDI Parts:

2. To monitor the contents of an Audio Part, click anywhere in the Part.
You will hear the contents of the Part played back, from the point where you 
clicked, for as long as you keep the mouse button pressed (or until the end of 
the Part).

When you press the mouse button, the pointer takes on the shape of a speaker.

3. To monitor the contents of a MIDI Part, drag the pointer forwards or 
backwards over the Part.
Notes and other MIDI Events will be played back according to how fast you 
drag the pointer.
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Renaming Parts

A Part can have a name consisting of up to 10 characters. When you create a Part by 
recording, it will get the name of the Track it resides on. There are two ways to 
change the name of a Part:

• Select the Part, open the Inspector and double click on the name field.
Type in a new name and press [Return].

• You can also hold down [Alt] on the computer keyboard and click on the 
Part.
A small name value box opens, where you can type in a new name. For MIDI 
Parts, the name is shown inside the actual box in the Part display.

Deleting Parts

There are several ways to delete a Part:

• Click on it with the Eraser tool.

• Select it and press [Backspace] on the computer keyboard.

• Select it, pull down the Edit menu and select “Delete Parts”.
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A note on deleting Audio Parts

Deleting an Audio Part with any of the above mentioned methods does not remove 
the actual audio file from the hard disk, or even from the list in the Pool. To actually 
delete the audio file from the hard disk, proceed as follows:

1. Select the Part.
If the audio file is used in several Parts in the Arrangement, you need to select 
all these Parts.

2. Hold down [Control] on the computer keyboard and press [Backspace].
A dialog appears, asking if you really want to delete the Audio file.

3. Click “Yes”.
The Audio file is removed from your hard disk.

● Keep in mind that a single audio file may be used by several Cubasis AV 
Songs! Make absolutely sure the audio file isn’t used in any other Song, before 
you delete it.
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Ghost Parts
A Ghost Part is a linked copy of an existing Part. For Audio Parts, this simply 
means that the Ghosts and the original Part all contain the same segments (see page 
86). This can be practical if you have a lot of copied Parts in your Arrangement, 
since it reduces the number of segments in the Pool (see page 207), making the au-
dio management easier. 

When it comes to MIDI Parts, there are even bigger benefits of working with Ghost 
copies: Let’s say you have recorded a four bar drum pattern, that you want to repeat 
through your Song. By using the Repeat function (described on page 186) and acti-
vating the “Ghost Copies” checkbox, you make a large number of Ghost Parts, 
lined up after the original. If you later want to change or add something in the drum 
pattern, you only have to edit the original Part - your changes will automatically be 
reflected in all Ghost copies. 
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On the other hand, you may want to change one of the Ghost Parts only - for exam-
ple to create a fill or variation. After making your changes in one of the MIDI Edi-
tors, you will get the following alert (upon closing the editor):

• If you click “Yes” the edited Ghost Part will be converted to a normal 
Part.
The other Ghost Parts will not be affected by the editing.

• If you click “No”, your changes will be inserted into all of the copies, just 
as if you were editing the original Part.
The Part will remain a Ghost Part.
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Creating a Ghost Part

You can create Ghost Parts either by using the Repeat function (see page 186) or by 
using the following method:

1. Hold down the [Control] key.

2. Drag the Part you want to copy to a new position.

3. Release the mouse button.
The Ghost Part appears, shown with the Part name in italics.
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Creating several Ghost Parts

1. Hold down the [Control] key.

2. Lengthen the Part with the Pencil tool.
A number of Ghost Parts will be created, all lined up end-to-start after the 
original Part (the number of Ghost Parts is determined by the length of the 
“frame” you draw with the Pencil, that is, the outline shown when you drag 
the Pencil becomes “filled” with as many ghost copies of the original Part as 
possible).

More about Ghost Parts

• A Ghost Part can be moved like any other Part. 
• It can also overlap existing Parts, just like any other Part.
• If you alter the contents of a Ghost Part by recording over it, merging it with 

another Part or by splitting or joining, it is automatically converted to a regu-
lar copy.

● Do not edit (in an Edit window) several MIDI Ghost Parts at the same time 
that are made up from the same Real Part. It won’t make the program crash or 
anything, it will just lead to confusing results when you close the editor.
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Working with several Arrangements
You can work with more than one Arrangement within a Song, should you so want. 
The different Arrangements could for example contain different versions of your 
music, or be used as “workbenches” for pieces that you later put together into one 
final Arrangement, etc.

Opening a New Arrangement

There are two ways to open a new Arrangement:

• Pull down the File menu and select “New”.

or

• Press [Control]-[N] on the computer keyboard.

The new, empty Arrangement opens in a window of its own.
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Selecting an Arrangement

Clicking on the Arrange button on the Transport Bar brings the most recently active 
Arrange window to front. To select another Arrangement, click on its window, or if 
it is obscured, pull down the Windows menu and select it from the Arrangement 
list.
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Copying Parts between Arrangements

If you want to move or copy Parts from one Arrangement to another, you use the 
standard Windows Cut, Copy and Paste commands on the Edit menu. This example 
describes how to copy a group of Audio and MIDI Parts to a new, empty Arrange-
ment:

1. Select the Parts to be copied.

2. Pull down the Edit menu and select Copy, or press [Control]-[C] on the 
computer keyboard.
If you want to move the Parts instead of copying, you should use the Cut com-
mand ([Control]-[X]) instead.

3. Click on the other Arrange window, so that it comes to front.

4. Move the Song Position pointer to where you want the first of the copied 
Parts to begin.
All other Parts will keep their distances in relation to the first Part.

5. Pull down the Edit menu and select Paste, or press [Control]-[V].
The Copied/Cut Parts are pasted into the new Arrangement, on their original 
Tracks, starting at the Song Position.
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Making a copy of a complete Arrangement

Sometimes you may want to make a duplicate of your whole Arrangement, for ex-
ample if you want to have several versions to experiment with. Then, the easiest 
way is simply to save the Arrangement (using the “Save As...” item on the File 
menu) and open it again in new Arrange windows, as many times as you want. Re-
fer to the page 403 for more information about these commands.

Naming the Arrangement

You can give names to each of your Arrangements by clicking with the right mouse 
button in the left part of the Arrange window’s Title bar, and typing in a new name.

Renaming an Arrangement.
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If you choose to save an Arrangement to disk as a separate file, then the name you 
give it while saving will be used as the Arrangement’s title next time you load it.

Closing an Arrangement

You can close an Arrangement, if you don’t want to keep it or if you just want it to 
get out of the way:

1. Make sure the window is active (selected).

2. Click on the window’s Close Box, select “Close” from the File menu or 
press [Control]-[W].
A dialog appears:
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3. Select one of the options in the dialog.
The four options have the following functions:

Don’t Save Closes the Arrangement without saving it.

Save Opens a file dialog where you can save the Arrangement for later 
use. After saving, the Arrangement is closed.

Cancel Cancels the operation, i.e. the Arrangement is not closed.

Set Aside The window is closed, but the Arrangement is kept ,“hidden” in the 
Song. To open a Set Aside Arrangement, pull down the Windows 
menu and select it from the Arrangement list there.
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Introduction
Just as you use the Explorer or File Manager to manage your files and folders, you 
use the Pool to manage your audio segments and files.

Opening the Pool Window
The Pool is opened by selecting “Pool” from the Audio menu or pressing 
[Control]-[F].
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Overview of the Window

The Pool lists all the audio files in the Song. Please note that this means it shows the 
files for all Arrangements that belong to the Song.

● For an explanation of audio files and segments, see page 84.

Segment names Audition buttons 

File names Segment waveform images Headings 
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Customizing the Display

Showing and Hiding Segments

For one File

• To display/hide the segments belonging to one file, click on the triangle 
preceding the file.

For all Files

• To Show all segments for all files, select Expand from the pop-up View 
menu.

• To Hide all segments for all files, select Collapse from the same menu.

• To toggle between showing and hiding all segments for all files, hold 
down [Alt] and click on one of the triangles preceding the files.

Hiding Headings

If you don’t need the Headings at the top of the window you can hide them using 
the “Hide/Show Headings” item on the pop-up View menu.
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Selecting what is shown

If you don’t need all the information fields for the files and segments, you can deac-
tivate these by clicking the “i” icon at the top of the window. Among other things 
this allows you to get a more detailed overview of the waveforms.

Zooming and setting Sizes of the Waveforms

If you change the width of the window, the waveforms are scaled accordingly. That 
is, the bigger you make the window the more detailed view of the waveform you 
will have.

By clicking the Plus/Minus buttons you can set the vertical size of the lines, to get 
a better overview of the waveforms.
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Setting File and Segment Order

File Order

On the View menu, you can determine in which order the files should be displayed:

Segment Order

By selecting “Order Segments” from the pop-up View menu, you rearrange the seg-
ments so that they are shown in the order they appear in the file.

Option Description

By Name Files are shown alphabetically.

By Date Files are shown ordered according to the time they were created, with 
the newest file on top.

By Size Files are shown in size order, with the largest one on top.
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The Headings and Columns
For each file/segment you have a number of information and setting fields. The 
names for these are displayed in two rows of headings at the top of the window.

The file headings and their corresponding fields in the Pool window.

The segment headings and their corresponding fields.
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Below follows a brief description of each entry in the headers. Many of these are 
used in various operations described later in this chapter.

File Heading Explanation

File Name The name of the file, on disk.

Disk The Disk the file resides on. If the file can’t be found, three ques-
tion marks are shown instead (see page 221). Clicking on the letter 
in this column lets you replace an audio file as described on page 
219.

S/M Indicates if the file is mono or stereo. If the audio file is stereo, two 
intersecting circles are shown.

Img This shows you the status of the waveform image for the file (see 
page 223).

Length This shows the size of the file in bytes.

Date and Time This shows the date and time the file was created.
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Segment Heading Explanation

Hear To play the segment, click in this column (on the speaker sym-
bol) and hold down the mouse button.

Segment (name) The name of the segment.

Start The segment’s Start Inset in the file, displayed in samples. You 
can change this value by double clicking and typing in another 
value.

End The segment’s End Inset in the file. Can be changed like the 
Start value.

Length The length of the segment, i.e. the number of samples between 
the Start and End Insets. 

SRate The Sample Rate of the file. Cannot be changed.

Range A graphical overview of the segment in the file.
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Finding Out how a Segment is used in the Song
One segment can be used in more than one place in a Song. There are a number of 
situations where you will want to find out where a segment is used, for example:

• So that you can tell that a segment isn’t used anywhere and possibly delete it.
• If you want to know if a segment is used in more than one place, so that you 

can decide how editing the segment affects the Song.

Number of Times the Segment is used

Next to the speaker icon for each segment, you will see a number telling how many 
times in the Song this segment is used. A segment without numbers is not used any-
where.
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File Operations

Renaming a File

To rename a file, proceed as follows:

1. Double click on the existing name.

2. Enter a new name or edit the existing one.

3. Click outside the box or press [Return].

● Renaming a file this way is much preferred to renaming it from the Explorer or 
File Manager. This way, Cubasis AV “knows” about the change and will not 
lose track of the file the next time you open the Song. See page 221 for details 
about lost files.
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Locating a File on the Hard Disk

To find out where on the hard disk a certain file is located, hold down [Control] and 
[Alt] and click on the file. A pop-up showing you the file location appears.

Deleting Files

Removing from Pool

If you want to remove one or more files from the Pool without actually deleting 
them from the hard disk, proceed as follows:

1. Select the file(s).
Selecting more than one is done just as with any other object in Cubasis AV, 
by clicking in combination with the [Shift] key.

2. Press [Backspace].
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• If you try to delete a file that is used by one or more Parts, the program 
will ask you if you also want to delete those Parts.
Cancelling this operation means that neither the file nor the Parts are deleted.

Removing from the Pool and deleting from Hard Disk

If you want to remove the file from the Pool and also delete the file permanently 
from the hard disk, proceed as follows:

1. Select the files.

2. Hold down [Control] and press [Backspace].
A dialog box asks you if you are sure you want to continue. Remember that 
this operation cannot be undone!

Creating a Segment

You can create a “default” segment for the file, that is one that plays the entire file.

1. Select the file.

2. Select Duplicate Segment from the Do pop-up menu or press [Alt Gr]-[D].
The new segment can be edited to play any part of the file (see page 227).
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Replacing a File in the Pool

There are situations when you may want to replace an audio file in the Pool with 
another, but keep all segments that are in use. As an example, consider the follow-
ing situation: 

You have used an external Wave Editor (see the chapter “Using an External Wave 
Editor”) to perform some editing on an audio file. To be on the safe side, you save 
the edited audio file under another name than the original. When you return to Cu-
basis AV, you will want to be able to replace the original file, so that all segments 
reference to the new, edited audio file instead, and preferably be able to switch back 
if you change your mind. Proceed as follows:

1. Click on the letter in the Disk column for the file.
A dialog appears, asking if you want to “Re-find” the file. Click “Yes”.

2. In the file dialog that appears, select the audio file that should replace 
the existing file in the Pool.
In our example above, this would be the edited version of the audio file.

3. Another dialog will ask you if you are sure. Click “Sure”.
The audio file in the Pool is now replaced with the one you selected in the file 
dialog. The segments keep their names and, if possible, their start and end in-
set positions. If you later want to switch back to the original file, just repeat 
the operation.
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● Please note that the replacing audio file must be of the same length as the 
original file, for the segment start and end insets to be relevant! If you perform 
any editing that involves changing the length of the file (such as time stretch, 
truncating, etc.), this method does not work, since you will have to create 
new segments.
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Handling “Missing Files”
When you open a Song, you may get a warning that one or more files are “miss-
ing”. If you click Ignore, the Song will open anyway, without the missing files. In 
the Pool you can check which files are considered missing. This is indicated by 
three question marks under the heading “Disk” (instead of the usual drive letter).

A file is considered missing under one of the following conditions:

• The file has been moved to another folder or renamed in the Explorer/File 
Manager since the last time you changed the Song 
and 
you ignored the Missing files dialog when you opened the Song.

• You have used the Explorer/File Manager to move, rename or change proper-
ties such as date for the file since you started the program this time.

File is missing

File is found
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Locating a missing file

1. Click on the question marks.

2. In the dialog that appears, decide if you want the program to try the find 
the file for you (Auto) or if you want to do it yourself (Manual).

Auto

If you choose Auto, the program scans all your hard disks for a file with the proper 
name and creation date.

If Auto doesn’t work

Please note that Cubasis AV is quite strict about identifying the files you use. Cuba-
sis AV retains information on the Name and Creation Date of every file saved in a 
Song. If these values are changed by you, or a program you may be using, you will 
not be able to rely on Cubasis AV's “auto-find” function. In this case you will have 
to use the “Manual” option and “over-ride” the subsequent warnings.

Manual

If you choose Manual, the program will display a file dialog allowing you to locate 
the file manually.

When you have found the file, click OK to replace the missing file in the Pool. If the 
name or date is not identical to the missing one, the program will warn you but let 
you proceed. The next time during this session that the program attempts to search 
for a missing file, it will first look at the position of the last found file.
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Creating Wave Images and Keeping them up to date
With each audio file goes an image, a picture of the waveform for display in the 
Pool and Arrange window. Wave images are created after you have completed re-
cording (in a process that may take a few seconds) and stored in a separate file with 
the same name as the audio file, but with the extension “WIF”.

If for example you perform some external editing to the audio file, it may get “out 
of sync” with its corresponding wave image. In the same way, if you accidently de-
lete or move a “WIF” file, the wave image will be missing for the corresponding au-
dio file. The three states of the wave image are indicated by the waveform icon for 
each file in the Pool like this:

Updating the Wave Image

To update the wave image for one file, click on its icon or select “Make Image” 
from the Do pop-up menu.

Icon: Description:

The image is OK.

The image might need updating (“out of sync”).

The file has no image.
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Segment Operations
The Pool allows you to create new segments, slightly or drastically different from 
those you already have in your Song, and drag and drop these in the Arrange win-
dow.

Auditioning a Segment

From the Beginning

To audition a segment from its beginning, press and hold the mouse button with the 
pointer over the speaker icon to the left of the segment name.

From any Position

To start playback from any position in the segment, click with the mouse pointer in 
the waveform to the right. Playback will start from the position you click on.
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Renaming a Segment

To rename a segment, proceed as follows:

1. Double click on the existing name or select the segment and press 
[Alt Gr]-[N].

2. Enter a new name or edit the existing one.

3. Click outside the box or press [Return].

Duplicating Segments

To create a copy of a segment, proceed as follows:

1. Select the segment by clicking on it.

2. Select Duplicate Segment from the Do pop-up menu or press [Alt Gr]-[D].
The new segment appears in the Pool.
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Deleting segments

● Deleting a segment never destroys any actual audio data.

Deleting one or several segments from the Pool

1. Select the segment(s).
Selecting more than one segment is done just as with any other object in 
Cubasis AV, by clicking in combination with the [Shift] key.

2. Press [Backspace].

• If you try to delete a segment that is used by one or more Parts, the pro-
gram will ask you if you also want to delete those Parts.
Cancelling this operation means that neither the segments nor the Parts are 
deleted.

You can tell how many times a segment is used in a Song by checking the number 
next to the speaker icon.

Deleting all Segments not used in the Song (Purge)

To automatically delete all segments that are currently not used in the Song, select 
Purge Segments from the Do pop-up menu. This is a quick way to “clean up” the 
Pool, making it easier to get a good overview.
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Changing Start and End Insets

You can change the Start and End points of the segment, by double clicking and 
typing in new values. This allows you to change what part of the audio file the seg-
ment plays. One use for this is to remove unwanted silence at the beginning or end 
of a recording.

● Please note that this change will affect all places in the song where this seg-
ment is used. If this is not what you want, make a duplicate of the segment 
first, and make the changes to this. Then drag the changed segment into the 
Arrange window and place it wherever you want it.
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Deleting Unused Portions of Audio Files (Erase Unused)
“Erase Unused” allows you to “trim” down your Audio files so that they only con-
tain the sections actually referenced by that file’s segment. This helps you maintain 
as much free space on the hard disk(s) as possible.

The idea behind this is that hard disk space is most often precious, and recorded si-
lence (for example) takes up as much hard disk space as recorded “noise”. When 
you adjust Start and End Points in segments to “hide” the sections of audio you 
don’t want to hear, you are still using up valuable disk space for those unheard bits. 
To “fix” this, use Erase Unused.

Which Parts of the Files are considered Unused?

Unused portions of a file are the sections not played back by any segment in the 
Pool.

This means that even if the segment isn’t used anywhere in the Song (which you 
can tell by looking at the speaker icon beside the segment – unused segments have 
no number) the section of the file that the segment plays is considered to be in use. 
To avoid keeping a lot of unnecessary audio sections, the program therefore auto-
matically performs a “Purge Segments” (see page 226 in this chapter) before the 
actual “Erase Unused” operation.
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Applying Erase Unused

● Erase Unused changes the contents of one selected audio file. If you use the 
file in another Song, or if you want to be able to go back to the original re-
cording, make sure you have a copy of the file before you begin!

1. Select either the file or one of its segments.
This command works on one sound file at a time. For this function to work, 
two criteria have to be fulfilled:

• The audio file must be used by at least one Event somewhere in the Song.
• There must be some section of the audio file that isn’t used by any Segment 

(otherwise there’s nothing to erase, right?).

These segments are 
each used in one place 
in the Song.

These segments are not 
used in the Song but 
will automatically be 
purged (deleted).
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2. Select the “Erase Unused” command from the pop-up menu.
A dialog box will display how much of the original audio file will be kept, 
and ask you if you want to go on.

3. Click Compact.
First the unused Segments are deleted. Then the unused sections of the file are 
deleted and the remaining parts “joined together” with only a short section of 
silence in between. The segments are adjusted accordingly.

Erasing all Unused Audio in a Song

To permanently erase all unused Audio in a Song, simply select all files in the Pool 
and select Erase Unused.
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Processing Files and Segments
The Pool contains two audio processing functions: Normalize and Reverse. There 
are two different ways of processing audio files and segments:

• If you simply select a file or a segment and select one of the processing 
functions, a new file will be created and added to the Pool, together with 
a segment for it.
To use the processed audio in the Song, you need to drag the segment into the 
Arrange window, as described on page 235.

• If instead you select a file (not a segment), hold down [Alt] and select a 
processing function, the original file is removed from the Pool and re-
placed with a new, processed file. 
All segments that played the original audio file, will now play sections of the 
processed file. If later you want to use the original file in your Song, you have 
to import it again (see page 233).

● Beware, you can not Undo this operation! All Segments playing a section of 
the file will be affected by the processing!
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Normalize

This lets you increase the level of a recording that was made at too low a level: The 
program scans the file to find the maximum amplitude. Then, the level of the entire 
recording is raised until the maximum amplitude matches 0 dB (the highest level 
possible without digital distortion).

● Please note that the level of any background noise is raised just as much as 
the rest of the signal. If you have the option to re-record the file with correct 
level settings, this is in many cases a better option than using Normalize.

Reverse

This turns a recording backwards, just as when you turn a tape on a reel-to-reel re-
corder backwards.
- 232 - 



Importing Audio Files into the Pool
From the Pool you can import files created by other programs, or files you have cre-
ated in another Cubasis AV Song.

File Formats

Files in the following formats can be imported:

• Wave (.WAV) or AIFF (.AIF).
• Mono or Stereo.
• The sample rate set for the Song.
• 16 bit resolution (uncompressed).

A regular file dialog is used to select audio files to import.
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Exporting Files and Segments
You can export segments from the Pool as individual files, for use in other applica-
tions:

1. Select the segment you wish to export.

2. Select “Export Audio File” from the File pop-up menu.
A file dialog appears.

3. Use the pop-up in the lower left corner of the file dialog to select a for-
mat for the file to be created.
You can choose between Wave files (extension .WAV) and AIFF files (exten-
sion .AIF).

4. Use the file dialog to find a location and name for the file.

5. Click Save.
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Dragging Segments into the Arrange Window
To move segments into the Arrangement, Cubasis AV uses drag and drop tech-
niques:

1. Arrange the windows so that as much as possible of the Part Display in 
the Arrange window is visible, when you have the Pool window active.

2. Position the mouse button over the name of the segment and press the 
mouse button.

A dotted rectangle appears around the name of the segment.
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3. Drag the segment out of the Pool window and release it on an Audio 
Track in the Arrange window.
The Snap value applies as usual.

4. A new Part is created, playing the segment you dragged.
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Saving and Loading the Pool
The Pool is automatically saved with the Song. However, by using the Load and 
Save Pool commands on the pop-up File menu, you can freely save Pools and load 
them into Songs. 

Saving

1. Select Save Pool from the File Pop-up menu.

2. In the dialog box that appears, specify if you want to save all files and 
segments, or just the selected ones. 

3. In the standard dialog box that appears, specify a name and a location 
for the file.

● The audio files themselves are not saved in the Pool file, only a reference to 
them. You should probably not move any audio file(s) until next time you 
want to use the Pool. You should definitely not delete them!
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Loading

A Pool file is opened (loaded) just like any other file. When you load a Pool file, the 
files in it are added to the current Pool.
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Importing Audio
You can import audio into the Song, from the Arrangement or from the Pool. Use 
the former when you want to position the file on a Track directly, and the latter 
when you plan to edit the file before using it in an Arrangement.

File Specifications

The files that you import must meet the following specifications:

• The file must be in AIFF (Audio Interchange File Format) or Wave (.WAV) 
format.

• It can be in Mono or Stereo.
• The sample rate must be the same as the one set for the Song (or the file will 

not play back correctly).
• The file must have 16 bit resolution and be uncompressed.

Naturally, the files created by Cubasis AV fit into these specifications.
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Importing into the Arrangement

The Import Audio File item on the File menu imports a file into the Arrangement as 
follows:

1. Select the Track where you want the audio file to appear.

2. Set the Left Locator at the point where you want the file to start.

3. Select Import Audio File from the File menu.
A file dialog appears.

4. Locate the file, select it and click OK.
The following now happens:

• The audio file is added to the Pool.
• A segment is created, that plays the entire audio file.
• A Part, playing the segment, is created and positioned on the selected Audio 

Track, starting at the Left Locator position.

Into the Pool

This is described on page 233.
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Exporting Audio

Exporting from the Arrangement

It might happen that you want to turn the whole or parts of an Arrangement into a 
single audio file. This is handy if you are running out of audio Tracks and want to 
“merge” for example a number of vocal overdubs into one recording, instead of 
keeping each overdub on a separate Track.

Performing the Audio Mixdown

1. Set up the Tracks to play as intended. 

Please note the following:

• Muted Tracks will not be included in the Mix.
• Make sure the levels are set correctly so that no clipping occurs and that the 

overall volume is not too low. Use the Audio Mixer to check the levels.
• The Volume settings in the Monitor window will be used.
• If you create a stereo file (see below), the panning in the Monitor window will 

be used.

2. Set up the Left and Right Locator as desired.
Only the section between the Left and Right Locator will be included in the 
new audio file.
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3. Create an empty Audio Track, where you want the mixdown to wind up, 
and make sure it is selected.

4. If the Mix Audio will be in stereo, set the “Rec Chn Mode” parameter in 
the Inspector for the Track to “Stereo”. 

5. Select Mixdown from the Audio menu.
A dialog box asks you for a new file name and location.

A new audio file is created and added to the Pool together with a segment 
that plays the whole file. In the Arrange window, a new Part appears between 
the Locators on the selected Audio Track, containing the new segment.

Exporting from the Pool

This is described on page 234.
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What is a Wave Editor?
In this context, the word Wave editor indicates any program that allows you to per-
form editing on your audio files. This may include cutting and pasting real audio 
data, applying DSP (Digital Signal Processing) functions, etc. In other words, it 
provides more direct control over the audio files than the Audio editor does. Two 
examples of Wave editors are Steinberg’s WaveLab and WaveLab Lite, both power-
ful audio editing and processing tools. 

Cubasis AV allows you to open a Wave Editor of your choice from inside the Pool 
or the Arrange window, process an audio file and return to Cubasis AV, without any 
hassle.

Precautions
In contrast to working inside Cubasis AV, e.g. changing a segment’s start and end 
insets in the Pool, a Wave editor makes permanent changes to your audio files, 
(sometimes called “destructive editing”). When you for example Paste in the Wave 
editor, this alters the file on disk directly, rather than just adding new segments or 
Events.

Many Wave Editors allow you to Undo your last action. However, it may be safest 
to use the Export Audio File item on the File pop-up menu in the Pool to make a 
backup of your audio file before editing it in an external Wave editor.
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Setting which Wave Editor to use
You may use any Windows program as Wave editor, provided it meets the following 
criterium:

• The program must be able to launch and open a “.WAV”-file for editing, 
by receiving a DOS command line with the path and name of the file as 
argument.
If you are uncertain whether your programs meet this criterium or not, follow 
the instructions below and try it.

To select which program to use for Wave editor, proceed like this:

1. Pull down the Audio menu and select “Set Wave Editor...”.
A dialog opens.
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2. Click on the Browse button.
A regular file dialog opens. Find and select the Wave editor file you want to 
use, and click OK.

The path and name of the selected Wave editor file is displayed in the dialog, to-
gether with its program icon.

3. If you are using Steinberg WaveLab or WaveLab Lite as Wave editor, and 
want to make use of the segment start and end insets when editing the 
audio file, activate “Segment Range Selection”.
See below.

4. Click Exit.
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Editing in the selected Wave Editor
Once you have selected a Wave editor using the procedure on the previous page, 
you can access it from the Arrange window.

● Remember that any processing you perform on this audio file will be reflected 
in all its segments throughout the Song. If you don’t want this, use the Export 
Audio File command in the Pool to create a copy of the audio file to edit in-
stead.

1. Double click on an Audio Part in the Arrange window.
This automatically opens the audio file in the set Wave editor. 

● If you are using WaveLab Lite or WaveLab, and you have activated the option 
“Segment Range Selection” in the Set Wave Editor dialog, the segment range 
in the audio file will be selected when you open it in the editor. Furthermore, 
if you are using WaveLab (the full-featured version), Markers will be inserted 
in the audio file, at the start and end inset positions.

2. Perform whatever processing you want.
This may include shortening or lengthening the file, applying DSP effects, etc. 
See the documentation for the Wave editor in question for more details. Stein-
berg WaveLab and WaveLab Lite also include extensive on-line help.
- 248 - 



3. Save the audio file and close it.
Nothing stops you from keeping the Wave editor running, just remember to 
close the audio file.

4. Return to Cubasis AV.
If you have applied any processing to the audio file, an alert box will appear, 
telling you that the file contents have been changed, and the Pool and Ar-
range windows will be updated to reflect the changes.

• If you have shortened the audio file in the Wave editor, the length of its 
segments in Cubasis AV will automatically be adjusted if needed (since a 
segment cannot be longer than its audio file).

• If you have lengthened the audio file, the length and start point of its seg-
ments will not be affected.

• If you created a copy of the audio file before editing it, and then per-
formed editing to the audio file that didn’t change its length (e.g. dy-
namic or spectral editing), you can switch between the original and the 
edited file without having to adjust or make new segments. 
See page 219.
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What can I do with the MIDI Editors?
When you record MIDI data, you fill Parts with notes and other MIDI “Events”. 
But you don’t really get to see and manipulate those Events individually from the 
Arrange window. In the MIDI editors you do!

Different types of Events and where to find them
Below we’ll list the different types of MIDI data that Cubasis AV can record, and 
how and where they are displayed for editing:

Notes (Note On and Off messages)

Notes are displayed in all MIDI editors. Let’s look at a simple melody line and how 
it is shown in the different editors:
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In Key Edit

The notes are shown as boxes, with higher notes higher up in the 
grid. The note length is indicated by the width of the rectangle.

The piano keyboard to the left is there to make it easy to 
find the right pitch when inputting or editing notes.
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In List Edit

The notes are shown both in the list to the left, 
and in the graphic display to the right.

The black bar graphs are for graphically displaying and editing MIDI “Value 2” 
in every Event. In the case of notes, “Value 2” is the velocity value.
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In Score Edit

In Score Edit, notes are displayed and edited just as notes on a printed score. 
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Continuous Events

In MIDI, various types of MIDI messages are used to transfer continuous changes. 
To be exact, these types are:

• Aftertouch (Channel Pressure).
• Pitch Bend.
• Controllers, like sustain pedal, MIDI Volume, Modulation wheel etc.

To be really exact (not to say pedantic!) some of these are not really continuous. 
Sustain Pedal for example can only be down (On) or up (Off). However, the MIDI 
specification groups all these messages as Continuous messages, and so does Cuba-
sis AV.
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Continuous messages are shown and edited in Key Edit and List Edit:

The “mountains” of continuous data in the Key Edit window above are in re-
ality a large number of single Events. This becomes clear when looking at the 
same data in the List Edit Window on the next page:

In Key Edit, the area beneath the Divider is the Controller Display.

Clicking on this icon brings up a pop-up menu, allowing you to select which type of 
continuous data should be shown. In this case, modulation wheel Events are displayed.
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● Please note that only the most common Continuous Controller Events are 
shown in Key Edit. These are Aftertouch (Channel Pressure), Pitch Bend, 
Modulation, Main Volume, Pan and Velocity. To display, create or edit other 
types of Continuous Events, use List Edit.

The modulation Events are listed in their playback order.

Value 2 for each Event is shown in the list and in the bar display. 
The grey color indicates non-note Events.
- 257 - 



Program Change messages

A Program Change message is a MIDI Event, telling a connected MIDI device to 
switch to another Program (e.g. a sound in a synthesizer, a setting in a reverb de-
vice, etc). You can record Program Change messages into Cubasis AV like any 
other Event. If you want to edit (or create new) Program Change messages, it can 
be done in List Edit. See the chapter “List Edit”.

System Exclusive messages

System Exclusive messages are a special kind of MIDI Event, intended for detailed 
control of the parameters of a MIDI device. Since all devices have different param-
eters, each major manufacturer of MIDI devices has a special ID code that is in-
cluded in the System Exclusive message.

Cubasis AV can record and play back System Exclusive messages, but they can not 
be edited or created from scratch.
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Opening An Editor

By double clicking on one Part

1. If you only want to open one Part into an editor, simply double click on it.
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Selecting the default MIDI editor

Which editor opens when you double click on a Part, depends on the “Double Click 
Opens” setting:

1. Pull down the Options menu and position the pointer on the Double 
Click Opens item.
A submenu appears.

2. Select one of the three items on the submenu.
You can choose between Key, Score and List Edit.

3. Save your Song.

If you want this setting to be valid for all new Songs, you should set up your “Au-
toload” song for this. See the chapter “Customizing Cubasis AV”.
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Editing a complete Track

You can edit all Parts on a Track at the same time:

1. Make sure no Parts are selected, by clicking somewhere 
in the background area of the Arrange Window.

2. Select the Track you want to Edit.

3. Select the preferred editor from the Edit menu 
or use the keyboard equivalents.
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Editing more than one Part

You can edit any selection of Parts, even Parts on different Tracks at the same time. 
The only restriction is this:

● List Edit can only be used to edit Parts that are all on the same Track.

1. Select the Parts you want to Edit.

2. Select the preferred editor from the Edit menu or use the keyboard 
equivalents.
The editor opens, showing the selected Parts at the same time. However, only 
one at a time is active. The active and inactive Parts are separated graphi-
cally:

● In Key Edit, notes belonging to an active Part are bright-colored (black when 
they are selected), while notes belonging to an inactive Part are dimmed and 
thinner than the notes of the active Parts.
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3. To activate a Part within an editor, click on any Event belonging to that 
Part.
You can also use the Next/Previous Part commands on the Goto pop-up 
menu, which is convenient if the Part is empty.

If you haven’t recorded any Part yet

You might want to open the editor to input notes from scratch, without recording 
anything first. In this case you have to create a Part, using any of the methods de-
scribed on page 173.

Active and Inactive Parts 
in Key Edit.
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About Recording and Playback
Basically, anything you can do in the Arrange window that relates to playback and 
recording, can also be done in the editors.

Realtime

Like everything else in Cubasis AV, editing can happen in realtime. This means that 
you can edit while the music is playing or actually even while you are recording!

Step Recording

If you prefer not to record your music in real time, you may use the Step Recording 
function to input music one note at a time. This is explained in the chapter “Step 
Recording”.
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Follow Song

If Follow Song on the Options menu is turned on, the Edit window will scroll auto-
matically during playback, so that the current Song Position is always visible.

• You may also press [F] on the computer keyboard to turn Follow Song on 
and off.

Cycle

If the Cycle button on the Transport Bar is activated, a certain section of your ar-
rangement will be repeated over and over as described in the chapter “Cycled Play-
back and Recording”. This is very handy for editing where you can fine-tune a 
recording and instantly hear the result without having to Rewind and Play to get to 
the right section.
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The Loop Function

In all of the MIDI editors you can set up a local Loop, which is a sort of “mini-cy-
cle” for the Parts being edited. The Loop facility operates in addition to the Cycle, 
meaning you can Loop the Parts you are editing while Cycling Parts that are not be-
ing edited!

There are three ways to set the Loop:

• Drag the mouse on the Position Bar to draw the Loop area. 

This does not work in Score Edit, since it has no Position Bar.

• Use the mouse and/or computer keyboard to set the values in the Loop 
boundary boxes on the Status Bar. 

• Use [Alt Gr]-[L] and [Alt Gr]-[R] to open the Loop boundary boxes and 
enter the values.

The upper value is the start of the Loop, the lower is the end.

The Loop On/Off button.
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Either way, the current Loop is shown in black on the Position Bar when it is on, 
and in grey when it is off.

Turning the Loop on or off

• Turn the Loop on/off by clicking on its button or by pressing [Alt Gr]-[O].
For this to work, you have to define the Loop first, as explained above.

When the Loop is active, the Parts within the Loop in the Edit window loop almost 
independently of the rest of the music. We say “almost”, because the Loop is still 
dependent on the Cycle. Every time the Cycle starts over again, so does the Loop.

The Loop is also used to direct editing to the Events inside the Loop. See page 273 
in this chapter.

Playback Parameters

The Playback settings you may have done in the Inspector are not visible when you 
edit the Part. This means that if a Part is transposed using the Inspector, it will be 
shown at its original recorded pitch in the editor, even though you will hear it play-
ing back transposed. 

• If this is a problem, you may “freeze” the play parameters.
This function transforms the settings in the Inspector (e.g. a transposition) to 
“real” MIDI data (in the case of transposition, changed pitches for each note), 
visible and editable in the editors.
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Moving around and the Goto pop-up menu
You can move directly to certain useful positions in an editor by selecting from the 
Goto menu on the Function Bar. These options will scroll your view to show the 
Events at the chosen position.

● The Goto commands don't affect selection in any way. They only change the 
view as if the scroll bars were used.

Song Position Takes you to the Song Position.

First Event Takes you to the first Event in the active Part.

Last Event Takes you to the last Event in the active Part.

First Selected Takes you to the first of all the selected Events.

Next Selected Takes you to the next selected Event.

Last Selected Takes you to the last of the selected Events.

Prev Selected Takes you to the selected Event before the one 
currently in view.

Next Part Takes you to the beginning of the next Part. This 
might just lead to a vertical scroll if there are sev-
eral Parts beginning at the same Position.

Prev Part Takes you to the beginning of the previous Part. 
Again, this might just lead to a vertical scroll.
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Creating Events in the Editors
This is mainly done with various tools from the Toolboxes:

• The Pencil tool is used to “draw” notes and other Events in Key and List 
Edit (see page 287 and page 315).

• The Paint Brush tool is used to “paint” series of notes in Key and List Edit 
(see page 289 and page 315).

• The Note and Rest tools are used in Score Edit, to create notes and rests 
respectively (see page 336).

Creating notes with the Fill function

All the editors have a pop-up menu named “Do”. The contents of this pop-up menu 
varies with the different editors, but all include a function called “Fill”.

This function only works when the To menu is set to “All Events”, “Looped 
Events” or “Cycled Events” (see page 273). It then fills the whole Part/the Loop/the 
Cycle with notes that have the same pitch. The notes are spaced according to the 
Snap value and are all given a length corresponding to the Quantize value.
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Monitoring Events in the Editors
As already mentioned, you can have playback running while you are editing. And, 
you can also use the cue function (see page 119) in the Edit windows. But there are 
two more ways to listen to your music in the editors:

The Magnifying Glass

The Magnifying Glass tool is common to all MIDI editors. When you click on an 
Event using this tool, the Event is played back. You can also hold the mouse button 
and drag the Magnifying Glass around over the Events.

The Speaker

When you click on the speaker symbol on the Status Bar, Events will be output au-
tomatically when you click on them, when you create them using the pencil or paint 
brush, and when you make changes on the info line.
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Selecting Events in the Editors
Selecting Events in the editors is done just like selecting Parts in the Arrange win-
dow, described on page 174. You can:

• Click on an Event to select it (and deselect all others).

• Hold [Shift] and click on an Event to select it, adding to any previous se-
lection.

• Select several Events by enclosing them in a rectangle using the Arrow 
tool.

• Press [Control]-[A] to select all Events in the editor.
This is the same as using the Select All item on the Edit menu.

• Use the [←] and [→] keys to select the previous/next Event in the Active 
Part.
If you hold down [Shift] and use the arrow keys, the next/previous Event will 
be selected, without deselecting already selected Events.
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Selecting Events from different Parts

You can select Events from both an active and an inactive Part:

1. Select the Events you want in the active Part, using any method de-
scribed above. 

2. Hold down [Shift].

3. Select one Event from an inactive Part by clicking on it. 
This Part now becomes active. 

4. While keeping [Shift] pressed, use any method to select more Events 
from the now active Part. 
As long as you keep [Shift] pressed, you can switch active Parts and select 
from as many as you like.

● Any type of editing you do (like moving, copying and so on) will affect all se-
lected Events, whether they are in active or inactive Parts.
(Note, however, that the setting on the To pop-up menu may further restrict 
which Events are affected, see below).

● When you record, use Step Input or make any other changes via MIDI, it is al-
ways the active Part that is affected.
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The To Pop-up

All the editors have a pop-up menu called “To”. This is used together with the Loop 
and Cycle functions to collectively choose a group of Events to be affected by your 
editing.

All Events, active or inactive, will be affected.

All Events inside the Loop 
will be affected, regardless 
of whether the Loop is On 
or Off, or whether the 
Events come from active or 
inactive Parts.

All Events inside the Cycle will 
be affected, regardless of 
whether the Cycle is On or Off, 
or whether the Events come 
from active or inactive Parts.

All selected Events, inactive or 
active, will be affected.

Those Events that are inside 
the Loop and selected will 
be affected.

Those Events that are inside the Cycle 
and selected will be affected.
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About Editing
This is done differently in every editor, using the various tools in the Toolboxes. 
Refer to each editor’s chapter for detailed information about how to use the differ-
ent tools.

Quantize and Snap Values in the Editors

The Quantize and Snap values work exactly as in the Arrange Window (see page 
181). However, there are a couple of things worth pointing out:

• Each editor has separate settings for Quantize and Snap values.
This means that the settings you make in the Key Edit window will not auto-
matically be transferred to for example Score Edit. This is practical, due to the 
different work methods you will employ in the different editors.

• The Quantize value also determines the length of input notes.
If for example you have the Quantize value set to 8, the notes you create will 
automatically become 1/8-notes.

• The Snap value also defines the spacing between input notes.
This applies when you use the paint brush or the Fill command from the Do 
pop-up. With a Snap value of 4 and a Quantize value of 16, you will get six-
teenth notes, positioned on the beats (quarter-note positions).
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• The Snap pop-ups in the editors contain more options than the one in the 
Arrange Window.
This is because, unlike when moving Parts, you may need small or uneven 
Snap values in the editors. The following Snap values are available:

The values 2 - 7 pp are 
values in ticks, allowing 
high precision editing 
and moving.

The values ranging from 
64 to 1 are regular note 
values. Triplets (T) and 
dotted (.) note values can 
be selected.
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Editing Notes via MIDI

You can change the properties of notes via MIDI. This can be a handy and fast way 
to get for example the right velocity value, since you will hear the result even as 
you edit:

1. Select the note you want to edit.

2. Click on the MIDI Connector symbol on the Status Bar.

The symbol should be “lit”. This enables editing via MIDI.

3. Use the Note buttons on the Status Bar to decide what properties will be 
changed by the MIDI input.
You can enable editing of Pitch, Note On- and/or Note Off-velocity.

With this setting, the edited notes will get the Pitch and Velo-off values of the notes input via 
MIDI, but the Velo-on values will be kept as they are.
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4. Play a note on your MIDI instrument.
The note selected in the editor will take on the properties of the played note, 
according to the setting made in step 3.

The next note in the active Part automatically gets selected. A series of notes 
can therefore quickly be edited.

• If you want another try, select the note again (easiest by pressing the [←] 
key on the computer keyboard) and again play a note on your MIDI In-
strument.
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The Info Line

At the top of the Key and Score editors, you have the Info Line.The Info Line 
shows the values for one selected note. The values can be edited, just as in the List 
in List Edit:

1. To show/hide the Info Line, click on the i-button on the Status Bar or 
press [Alt Gr]-[I] on the computer keyboard.

2. Select a single Event.
Its values are shown on the Info Line.

If no Event or several Events are selected, the Info Line shows “– – –” for all values.

3. Change the desired values using regular value editing.
As always, you can use the mouse or type in values from the computer key-
board.

When the “i” button is lit, the Info Line is shown.
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Info Line Parameters

The following parameters can be changed on the Info Line:

● Not all MIDI Instruments send and/or read velocity (especially true with Note 
Off velocity). Check your instrument’s operation manual if you are unsure.

Parameter Remark

Start Changing this value is the same as moving the note.

Length In ticks.

Pitch Changing this value transposes the note.

Velo On The Note On velocity; the speed with which you press a key on a 
MIDI keyboard.

Velo Off The Note Off velocity; the speed with which you release a key on a 
MIDI keyboard.

Chn The “original” MIDI Channel associated with the note (see page 91).
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Cutting, Copying and Pasting

You can use the Cut, Copy and Paste commands to move Events between editors or 
to duplicate a series of Events.

• Cut or Copied Events are Pasted in starting at the Song Position. The 
Events will keep their relative positions, pitch and other properties. See 
page 39.

Deleting Events
To delete Events:

• Click with the Eraser tool on the Events you want to delete, or...

• Select the Event(s) you want to delete and press [Backspace], or...

• Select the Event(s) and select Delete from the Edit menu.
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Closing the Editor
There are two ways of closing the editor, “Cancelling” and “Keeping”.

Cancelling

If you press [Esc] (escape) on the computer keyboard or select “Cancel” from the 
Edit window’s Control Menu (reached by clicking on the Control Menu button to 
the left on the window’s title bar), a dialog box allows you to change your mind:

Cancelling can be thought of as a super-undo. It allows you to try out a series of 
changes to a recorded piece of music and then easily revert to its original state.

“Cancel” will cancel all changes you have 
made since you opened the editor.

“Keep” will exit the editor, 
but keep your changes.
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Keeping

If you close the editor by selecting “Keep” from the Control Menu or by pressing 
[Return], the window closes and all the editing you have done is kept.

The “Keep Appended Events?” Dialog

If you close the editor and a dialog appears asking you if you want to “Keep ap-
pended Events”, this is because you have added Events outside the Part(s) being ed-
ited.

• If you click “Yes”, the Part will be extended to encompass the added Events.
• If you click “No”, the Events outside the Part will be discarded.
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Which Editor should you use?
This of course depends on your individual way of working. However, the following 
suggestions may help you find your way:

Use Key Edit when...

• You want to get a quick overview of the Events.
• You want to edit several Parts at the same time.
• You’re editing Pitch Bend, Aftertouch, Main Volume, Modulation, Pan or Ve-

locity values.

Use List Edit when...

• You need to perform detailed editing of single Events.
• You’re editing other kinds of Continuous Controllers than those available in 

Key Edit.

Use Score Edit when...

• You are used to reading and writing scores.
• You are preparing your music for printing.

● Key and Score Edit can be used to edit any combination of Parts from different 
Tracks. List Edit can only be used for Parts on one Track at a time.
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17

Key Edit 17
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Overview
Key Edit displays notes as boxes with higher notes higher up in the display, and the 
width of the boxes corresponding to the note lengths. The piano keyboard to the left 
is there to make it easy to find the right pitch when inputting or editing notes.

Key Edit also lets you display and edit Continuous Controllers (such as Pitch Bend, 
Modulation, Aftertouch, etc.) in a graphic Controller Display, as described on 
page 298. 
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Below you will find a description of some of Key Edit’s main features:

Dark notes are selected.

The position of the mouse pointer is shown both 
on the Piano keyboard and in the Mouse Box.

The Song Position Pointer.

Clicking here opens the Controller Display.

The Snap and Quantize boxes.

The Goto pop-up is used for moving the view.

The Do and To pop-ups. 
See “page 273”
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Entering Notes

Using the Pencil tool

1. Set the Snap value to the smallest position at which you want to enter a 
note.

2. Set the length of the note to be entered by changing the Quantize value.

For example, if you want to enter eighth notes at quarter note positions, set the Quantize 
value to “8” and Snap to “4”.

3. Select the Pencil tool from the Toolbox, and move the pointer onto the 
note display.
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4. Aim at the correct position.
The piano keyboard to the left and the two fields on the Status Bar will help 
you by showing the pitch and position.

5. Click once with the mouse.
The note appears.

The pitch of the note.

The position of the note.
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Using the Paint Brush tool

Use the Paint Brush to ‘paint’ in several new notes at a time:

1. Select the Paint Brush tool.

2. Position the pointer where you want the first note to be.

3. Press the mouse button and drag the pointer.

Notes are created according to the following rules:

• The notes are created at a spacing defined by the Snap value.
• The notes get the length of the Quantize value.
• Movement is restricted to a horizontal direction only when you are dragging 

(that is, all notes will have the same pitch). 
If you want to paint “freehand”, with no restrictions in pitch, hold down [Alt] 
when you are using the Paint Brush.
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The Insert Button

The Insert button

If the Insert button is activated on the Status Bar,when you use the Pen or Brush to 
insert new events, all Events in the Part (after the insert position) will be moved one 
Quantize value later. This works just like with Step Input (see the chapter “Step Re-
cording”).

● You can also create new Events using the Fill function on the pop-up Do 
menu, see page 269.
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Setting the length while drawing

You can easily set note lengths to something else other than the quantize value, 
while entering them. The Snap value still applies so you can only set the Length to 
even multiples of this value.

1. Aim with the Pencil at the correct position and pitch.

2. Press the mouse button and drag to the right with the button pressed.
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3. Release the mouse button. The Event is adjusted to the closest Snap 
value.

Determining the note’s velocity

The Notes you enter have a high velocity normally. In Key and List Edit you can 
change it by holding down modifier keys while clicking. Use the following modi-
fier keys:

Velocity Modifier key

High (127) None

Medium - high (96) [Shift]

Medium (64) [Control]

Low (32) [Shift]+[Control]
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Manipulating Notes

Selecting Notes

This is done with the Arrow tool, just like selecting Parts in the Arrange window:

• Click on a note to select it.
• Hold down [Shift] and click to select several notes.
• “Draw” a rectangle around several notes to select them.

You may also use the left and right arrow keys on the computer keyboard to select 
the previous or next Event in the editor.

• If you select a single note, its values will be shown on the Info Line.
You can use the Info Line for detailed editing of single notes, as described on 
page 278.
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Moving Notes

1. Select the Arrow tool.

2. Set the Snap value.
If you want to be able to move the note(s) to exact quarter note positions only, 
set Snap to 4. If you want to move them to exact eighth note positions, set 
Snap to 8, etc. This works just like when moving Parts in the Arrange Window 
(see page 181).

3. Select the note(s) you want to move.

4. Position the pointer over one of the selected notes and press the mouse 
button.
The pointer takes on the shape of a hand.

• If you hold down [Shift], movement is restricted to either vertical or hor-
izontal.
Use this if you only want to transpose the notes, or move them without trans-
posing.

5. Drag the note(s) to the new position and release the mouse button.
A dotted outline of the note(s) is shown while you drag.
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Duplicating Notes

1. Select the Arrow tool.

2. Set the Snap value as for moving notes (see the previous page).

3. Select the note(s) you want to duplicate.

4. Hold down [Alternate] on the computer keyboard.

5. Position the pointer over one of the selected notes and press the mouse 
button.
The pointer takes on the shape of a hand.

• If you hold down [Shift], movement is restricted to either vertical or hor-
izontal.
Use this if you want move the duplicated notes in one direction only.

6. Drag the note(s) to the new position and release the mouse button.
A duplicate set of notes is created and positioned where you drag them.
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Resizing Notes with the Pencil tool

You can change the size of notes that you have drawn or recorded, using the Pencil 
tool:

1. Set the Snap value.
What you do when you resize a note, is to move the end position of that note. 
You can only resize in multiples of the set Snap value. That means, if Snap is 
set to 8, you can move the end-position of a note to 1/8, 1/4, 3/8, etc.

2. Press the mouse button with the Pencil pointer inside the note you want 
to resize.

● It might be hard to determine whether you have the pointer inside a note or 
not. To avoid painting in new Events, hold down [Alt] on the computer key-
board. This disables creation of new Events.

3. Drag the pointer to set the note to the desired length, and release the 
mouse button.
The note gets resized, taking the set Snap value into account.
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Deleting Notes

To delete notes, you can use one of the following three methods:

• Select the Eraser tool and click on the notes you want to delete, or...

• Select the note(s) you want to delete and press [Backspace], or...

• Select the note(s) you want to delete and select Delete from the Edit 
menu.
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The Controller Display
This is the area in Key Edit that is used for graphically displaying and editing Ve-
locity and Continuous Controllers.

Opening the Controller Display

• Open the Controller Display by clicking on the Controller button below 
the piano keyboard to the left.
To close the Controller Display, click on the button again.

Determining which Controller to display

The Controller Display can show several types of continuous MIDI data, but only 
one at a time, of course. You decide which one yourself:

1. Open the Controller Display as described above.

2. Position the pointer over the Controller icon and press the mouse button.
- 298 - 



3. Select a Controller type from the pop-up menu that appears.
The numeric value below the icon shows the number of the displayed Con-
troller.
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Changing the size of the Controller Display

Drag the Divider up 
or down to enlarge or 
shrink the Controller 
Display.
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Editing Velocity

The velocity values are shown as bars, with higher bars representing higher veloc-
ity values. Since a velocity value is no Event in itself, but rather a property of a 
note, you cannot create, move or delete velocity values in the Controller display. 
However, if you move or delete a note in the Event Display, its corresponding ve-
locity bar is moved or deleted as well.

Using the Pencil

To change a series of values, drag over them.

Simply click on the velocity bar with the Pencil... ...to change its value.
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Using the Line Tool

To create a ramp of values, for example a fade-in or fade-out, proceed as follows:

1. Select the Line tool.

2. Position the pointer and press the mouse button.

3. “Draw” the outline of the ramp with the mouse button pressed.

4. Release the mouse button. The velocity values are changed.
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Creating Non-note Events

These include Aftertouch (Channel Pressure), Pitch Bend, Modulation, Volume and 
Pan. There is one very important thing to observe about non-note Events. If for ex-
ample you put in one single MIDI Modulation wheel Event with a value of 63, this 
will be displayed like this:

The figure above might look like an “infinite” series of modulation Events all with 
the value 63, but it is not, it is only one. It is a graph of instantly moving the modu-
lation wheel to position 63 and leaving it there. 

It is important to remember that if you draw, or in any other way input Controllers, 
this makes them stay at the last set value for an infinite amount of time (or until you 
change it the next time). Sustain pedal (damper) for instance, will vary between 0 
and 127 every time you press or release the pedal, but stay at the last value as long 
as you don't move your foot on or off it. Draw in one “foot down” Event, and the 
notes will sustain until a “foot up” Event appears.
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To create a non-note Event, proceed like this:

1. Select what type of data you want to add.
Use the Controller pop-up, as described on page 298.

2. Set up the Snap value to decide what “density” you want for the Events.

3. Hold down the [Alt] key.
From here on there are basically three ways to go, as shown in the picture on 
the next page:

If you for example want to input one Event 
every eighth note, set the Snap value to “8”.
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4. Release the [Alt] key.

If you want to enter just one Event, click once with the Pencil.

If you want to “paint a curve”, drag the Pencil (with the mouse button pressed).

If you want to create a perfect ramp, use the Line tool as described above.
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● All values range between 0 and 127, except Pitch Bend, which has a value 
range from -8192 to +8191. For Pitch Bend, value 0 is equivalent to no Pitch 
Bend (the Pitch Bend wheel/lever in center position).

Selecting Non-note Events

This is done somewhat differently from selecting notes: You can’t click on an Event 
to select it, rather you have to enclose it in a frame, using the Arrow tool. Note that 
it is the start of the Event that has to be enclosed:

Click with the Arrow tool to select Events in the Controller Display. To select sev-
eral Events, you may hold down the [Shift] key on the computer keyboard and 
click, or enclose the Events in a frame, just like when selecting notes.
- 306 - 



Editing Non-note Events

With the Pencil

To change one value with the Pencil, simply click on it.

To change a series of values, drag over them.
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With the Line Tool

“Draw” a line with the Line tool...

...to create a ramp of values.
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Deleting Non-note Events

You delete an Event in the Controller Display just like you delete notes:

• Click on the Event with the Eraser tool.

• Select the Event and press [Backspace].

or

• Select the Event and select Delete from the Edit menu.
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18

List Edit 18
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Overview
Below you will find a description of some of List Edit’s main features:

The Song Position is shown both in the Event list and in the Event display.

The Events are shown in the list 
and in the display to the right.

The Mouse position is 
shown in the Mouse Box.

The Do, To and 
Goto menus.

With the Insert pop-up 
menu, you decide which 
type of Events to input.
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The Columns in the List

In List Edit, you can view and edit several types of Events. Common to the various 
Event types are the Start Position, Length and Chn parameters. As you expected, 
these show where an Event starts, its length in ticks and its MIDI Channel value, re-
spectively. The table on the next page shows the List columns and the parameters 
for the normal Event types (the rows):

To make all columns appear, drag the Divider as far right as possible.
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There is also a column named  Status. For all Event types except Control Change 
(see below), this is just an explanatory value that can’t be changed, e.g. “Note” for 
Note Events etc.

Val 1 Val 2 Val 3

Notes Pitch Note On velocity Note Off velocity

Poly Pressure Note Number Pressure Amount Not used

Control Change Controller Type Change Amount Not used

Program Change Program Number Not used Not used

Aftertouch Pressure Amount Not used Not used

Pitch Bend Bend value (fine) Bend value (coarse) Not used
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Transforming Controller Events

If you change Value 1 for a Control Change Event, you actually change the Con-
troller from one type to another. To simplify this, the name of the Controller type is 
shown in the “Status” column in the List. You can change the value either in the 
“Val 1” column or the “Status” column.

Changing the value in the “Val 1” column... ...will simultaneously affect the 
“Status” column, and vice versa.
- 314 - 



Creating Events
1. Use the Insert pop-up menu to decide what type of Event to Insert.

2. Set the Snap value to the smallest position at which you want to enter a 
note.

3. If you are entering notes, set their length with the Quantize value. 
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From here there are three ways to go:

• Select the Pencil or the Paint Brush and draw the Event in the Event display.

• Activate Step Input by clicking on the foot symbol on the Status Bar.
Step programming is described in “Step Recording”.

• Create notes using the Fill function on the Do pop-up menu, see page 269.

If you are inputting notes, they will have...

• the pitch C3.
• a Note On velocity of 127.
• a Note-Off velocity of 64.
• the MIDI Channel value of the Part.

If you are using Step Input, the notes will have other properties, as described in the 
chapter “Step Recording”.

The Event appears both in the Event Display and in the List.
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Editing in the List
The positions and values of Events can be edited in the List, using the regular pro-
cedures. There are some things to note:

• If you hold down the [Alt] key on the computer keyboard when you change 
a value, all Events of the same Event type will be set to the same value.
This means for example that all Control Change Events will be affected.

• If you change an Event’s Start Position, the List will be resorted.
The Events are always shown in the order they are played back, with the ear-
liest Event at the top and the latest at the bottom.

Editing in the Event Display

Moving Events

You can use the Arrow tool to move Events in the Event Display, much like in Key 
Edit. However, there is one big difference. This is how you should look at the hori-
zontal and vertical positions:

• The horizontal position of an Event in the Event Display is directly re-
lated to the Event’s Start Position in the Song (just as in Key Edit).

• The vertical position of an Event is just related to the order of the Events, 
as in the List. It has no direct relation to time.
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An example:

...the Event suddenly appears on another vertical position, since the order of the Events has 
been changed.

Let’s say we have three Events, positioned at 2.1.0, 2.2.0 and 2.4.0. If you move the middle 
Event a bit to the right...

But if you move the Event further to the right, past the third Event...

...it will still keep the exact same vertical position, since its position is still after the first 
Event but before the third.
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Changing the Lengths of Notes

You can click inside a Note Event and drag it to the desired length, using the Pencil 
tool. The new length is shown in the Length column in the List.

Editing in the “Value 2” Display
The graphical display to the right shows Value 2 for the Events in the List (where 
applicable) as horizontal bars. You may use this to change values, create ramps etc.

For note Events, the bars are black,
for SysEx Events, they are white,

and for other Event types they are grey.
This is to make it easier to distinguish

different Events.
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As you can see in the tables on page 312 in this chapter, the Event types that use 
Value 2 are Notes, Poly Pressure, Control Change and Pitch Bend Events. Perhaps 
the most common use for the display is to edit Value 2 for Note Events, that is, the 
Note On velocity value.

• You do not have to select the Pencil tool to change the bars in the “Value 
2” display; the pointer automatically changes to the Pencil when you 
move it into the display.
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Hiding Events
You might not want to see all types of Events in the list. If you for example are only 
interested in editing Program Change, then all other Events are just in the way. Use 
the Display Filters to determine which Event types should be shown:

1. Click on the “F”-button on the Status Bar.

2. Check the checkboxes for the Event Types you want to Hide.
These types disappear from the List.

● The Display Filters do not remove, mute or in any other way change the 
Events. Editing may affect both visible Events and Events hidden with the Dis-
play Filters.

● “Special” Events, such as SysEx or Text, cannot be hidden.

This opens a line with checkboxes for the different Event Types.
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Overview
Score Edit displays your music as regular notation. Below you will find a descrip-
tion of some of Score Edit’s main features:

• If you are editing one Track, as much of it as possible is shown on several 
staves - one above the other - just as with a score on paper.

The “inverted” notes 
are selected.

The Song Position Pointer.

The mouse position is shown both in the mouse box and as a 
note name in the box below. When you move a note, the lower 
box shows the amount of transposition in semitones.

If you are editing Parts on several Tracks at the same 
time, the striped double bar line at the beginning of 
the score indicates the Active Track.
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• If you edit Parts on several Tracks, they are put on a grand staff (multiple 
staves, tied together by bar lines).

• The number of measures across the screen of course depends on how 
many notes there are in each measure.

• The last measure in the Part is indicated by a double bar line.
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Getting the Score displayed correctly

Time Signature

Score Edit always uses the Time Signatures specified in the Master Track.

Staff Settings

When you open Score Edit for a Part recorded in real-time, the score may not look 
as legible as you would first expect. The Score editor can ignore the minor time var-
iances in performance and make a neater score almost instantly. To achieve this, 
there are a number of settings in a Staff Settings dialog box that determine how the 
program displays the music.

There are two ways to open the Staff Settings dialog:

• Double click in the white area to the left of the staff.

• Activate a staff by clicking on the first bar line on any of the staves in the 
window. Then select “Staff Settings” from the Do pop-up menu.
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The Staff Settings dialog appears: 

● The settings you do in this dialog box are independent for each Staff (Track), 
but common for a piano staff you create with Split Staff Mode.
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Key and Clef

The correct Key and Clef are set using the two scroll bars in the Key & Clef section.

If you check the “Auto Clef” checkbox, the program attempts 
to guess the correct clef, judging from the pitch of the music.

Use this 
scrollbar to 
select a clef.

Use this 
scrollbar to 
select a key.

To set Key and Clef for the 
lower Staff in Split mode 
(see below), activate the 
Lower Staff checkbox.
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Splitpoint

When this is ticked, the Part is split on the screen into a bass and treble clef, as in a 
piano score. You use the  value field to set the note where you want the split to oc-
cur. Notes above the split note will appear on the upper staff, and notes below the 
split note will appear on the lower staff.

Before and after setting a split at C3.
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Display Quantize

Since the actual timing of recorded notes often varies slightly from the desired no-
tation, the program can be told to “allow” such variations, and still display notes as 
if they were played perfectly in time. This is done using the Quantize section of the 
Staff Settings dialog.

● These are only display values used for the graphics in the Score Editor. They 
do not affect the actual recording in any way.

Here is a description of the functions:

Parameter Description

Notes The smallest note value to be displayed. Set this to the smallest sig-
nificant note value used in your music. If for example you set this 
to eighth notes, no note values smaller than eighth notes will be 
displayed. If you set it to a triplet value, the program expects all 
notes on this staff to be triplets.
This setting is partly overridden by Auto Quantize (see below).

Rests The smallest rest value to be displayed, as with the “Notes” setting 
described above.
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Auto 
Quantize

Generally, if your music contains mixed triplets and straight notes, 
try activating this function by selecting “Position” from the pop-up 
menu. Otherwise leave it off.

Auto Quantize uses involved methods to make your score look as 
legible as possible while allowing you to mix straight notes with 
tuplets (triplets) in a Part. But, Auto Quantize also uses the (dis-
play) Quantize value. If it can't find an appropriate note value for 
a certain note or group of notes, it will use the set Quantize value 
to display it.
If the part is imprecisely played and/or complex, Auto Quantize 
may have a problem “figuring out” exactly what you “mean”.

Parameter Description
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Switches

These provide additional options for how the score should be displayed:

Parameter Description

Clean 
Lengths

When this is activated, notes that are considered to be chords will 
be shown with identical lengths. This is done by showing the longer 
notes as shorter than they are. When Clean Lengths is turned on, 
notes with very short overlaps are also cut off; a bit as with No 
Overlap (see below), but with a more subtle effect. 

No Overlap When this is activated one note will never be shown as overlapping 
another, lengthwise. This allows long and short notes starting at the 
same point to be displayed without ties; the long notes are cut off in 
the display. This will make the music more legible.

An example measure with No Overlap deactivated...

...and with No Overlap activated.
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Syncopation When this function is on (ticked) syncopated notes are shown in a 
more legible way.

This is a dotted quarter at the end of a bar when Syncopation is Off...

... and when it is On.

Shuffle Activate this function when you have played a shuffle beat and want 
it displayed as straight notes (not triplets). This is very common in 
jazz notation.

Flat Beams When this is ticked, the beams over the notes will be flat (as op-
posed to slanted).

No Beams When this is ticked, there will be no beams whatsoever in the Part. 
This is good for example for vocal scoring.

Track Name When this is activated, the name of the Track is shown at the begin-
ning of the Staff.

Parameter Description
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Closing the Dialog

• When you have finished with the settings, close the dialog by clicking the 
OK button.
This applies the settings to the active Staff/Track.

● Remember that the Staff settings are done independently for each Track.
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Editing several Tracks
You may edit several Tracks simultaneously in Score Edit. The Tracks are shown as 
multiple staves, tied together by bar lines and placed in the order they appear in the 
Track List.

• If you need to rearrange the staves: close the editor, go back into the Ar-
range window, drag the Tracks to the order you want them, and open 
Score Edit again.

The Song Position Pointer.

Selected notes.
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The Active Staff

Just as in the other editors, all MIDI input (as when recording from your instru-
ment) is directed to one of the Tracks, here called the Active Staff. The Active Staff 
is indicated by a black rectangle in the left part of the first visible bar.

To make another Staff active:

• Click anywhere in the Staff you want to activate.

or

• Step to the Staff you want to activate, using the [↑ ] and [↓ ] keys on the 
computer keyboard.

The Active Staff rectangle.
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Creating Notes and Rests
When you input music “by hand” in Score Edit, you can use the Note and Rest 
tools. The length of the note or rest to be input, is determined by the Quantize 
value. However, the easiest way to input notes and rests, is to use the note symbols 
in the Toolbar:

• To input a note, first click on the desired note value in the Toolbar (the 
Note tool is automatically selected), then click in the staff where you 
want the note.
If you want to insert a triplet or dotted note, click on the “T” or “·” button 
when you select the note value.

• To input a rest, first select the Rest tool, then proceed as when inputting 
notes.
There is one big difference between inputting notes and rests:

● Rests are always inserted (as if Insert was activated) into the music.
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When you change Quantize value, or click on a note button on the Toolbar, the shapes of the 
Note and Rest tools are changed.
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Manipulating Notes
There are a few special features for manipulating notes:

Moving and Transposing Notes

• Use the two mouse boxes to determine where to place notes.

When you move several notes, the upper mouse box shows the position of 
the note you clicked on when starting to drag.

• If you hold down [Control] and transpose a note, it will only be trans-
posed within the set key.
If, for example, the key is C major (set in the Staff Settings dialog), you will 
only transpose to notes belonging to the C major scale.

• Holding down [Shift] restricts movement to either up/down or left/right.
If for example you want to transpose a note, select it, hold down [Shift] and 
move it vertically. This way, the note is not accidentally moved to another po-
sition in the bar.

The upper box shows the position of the 
moved note (as bars, beats and ticks).

The lower box shows the pitch when 
inputting notes, and the transposition 
value when moving notes.
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Changing the Length of Notes

You may use the Note tool to change the lengths of notes in the score:

1. Select the Note tool.

2. Click on the desired note value button on the Toolbar.

3. Hold down [Alternate] on the computer keyboard and click on the note 
you want to change.
The note gets the selected note value.

● Please remember that the Display Quantize settings in the Staff Settings dialog 
affect how notes are displayed. If the above procedure doesn’t give the ex-
pected result, check the Display Quantize settings.
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Joining Notes

The Glue Tube tool allows you to join two or more notes of the same pitch.

• Click on a note with the Glue Tube tool.

The note is joined to the next note with the same pitch.

Enharmonic Shift

The buttons on the right part of the toolbar are used to shift the display of selected 
notes so that for example an F# (F sharp) is instead shown as a Gb (G flat) and vice 
versa:

1. Use the arrow tool to select the note(s) you want to affect.

2. Click on one of the buttons to display the selected note(s) a certain way.

The middle button resets the notes to the original display. The other four options are double 
flats, flats, sharps and double sharps.
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Flip Stems

By selecting this item from the pop-up Do menu or by pressing [Alt Gr]-[X] on the 
computer keyboard, you change the stem direction of the selected note(s).

Deleting Notes and Rests

This is done with the Eraser tool, the [Backspace] key or the Delete item on the Do 
pop-up menu, as in the other editors.

• Deleting a note is the same as replacing it with a rest. 
No other notes are affected, although some notes may be displayed differ-
ently, due to the Display Quantize settings (see page 329).

• Deleting a rest will cause all the following notes and rests to move to the 
left, to fill up the “empty space”.
Let’s say you have a quarter note rest on the first beat of a bar, followed by 
two quarter notes, on the second and third beats. If you delete the quarter 
note rest, the two notes will be moved to the left, ending up on the first and 
second beat of the bar. 
In other words: deleting rests is really only a way of moving notes.
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Adding Text
Cubasis AV lets you enter text anywhere in the Score. This can be used for lyrics, 
comments or performance instructions. Proceed like this:

1. Select the “Text” Tool.

2. Click anywhere in the score.
A text input line dialog box appears. 

3. Enter the text and press [Return] when you are ready.
The font, style and size of the text depends on the settings in the Text Settings 
dialog, reached from the Do pop-up menu.
- 342 - 



Changing the Font and Size

If you wish to change the font and size for some text you already put in, proceed as 
follows:

1. Select the text by clicking on it with the Arrow tool.
You may select several lines of text in the Staff, by holding down [Shift] and 
clicking on them.

2. Select “Text settings...” from the Do pop-up menu.

3. Use the Font pop-up, the size setting and the style options in the dialog 
box that appears.
The fonts you find on the menu depend on what fonts you have installed in 
your computer.
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4. Click “Change Selected or “Change All” to “direct” the font size and 
style selection to one or more text objects.

The font and size settings you just made will also apply to all the text you input 
from now on (until you change the settings, of course).

Editing text

To edit text, double click on it with the Arrow tool and enter new information on the 
input line, just as when you put in the text the first time.

● On your font menu you will also find the Cubase font. This is not intended for 
text, but for the non-text symbols used in the score.

Cutting and Pasting Text

Using the keyboard short-cuts (not the menus) you can Cut and Paste text. Select a 
“block” of text by clicking on it with the arrow tool, press [Control]-[X] or [Con-
trol]-[C] to Cut or Copy. Click for a new insertion point, and press [Control]-[V] to 
Paste. 
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Moving and Duplicating Text

Text “blocks” can be moved freely within the “page”, one at a time or together, just 
drag it/them to the new location. 

If you hold down [Alt] when you drag you are making copies instead of just moving.

Deleting Text

Text “objects” are deleted just like notes, rests or other objects.
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Title, Comment and Copyright
There are three standard text elements on the first page of your score, which you 
may enter in the dialog box that comes up when you select “Score Title...” from the 
Do pop-up menu. 
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1. Enter Title, Comments and Copyright notes in the respective text areas.
“Title” is the title of the Score. It is printed at the top of the first page, and is al-
ways centred.
“Comment” is positioned just below the Title.
“Copyright” is positioned at the right side of the first page, just above the first 
system.

2. Use the pop-up menus and check boxes to select font, size and attributes 
for the three text elements.

3. Click OK.

● None of these elements are visible on-screen but will be printed out.
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Printing
To print your score, proceed as follows:

1. Make settings for the Text, Title, Comment and Copyright elements, as 
described on the previous pages.

2. Pull down the File menu and select Print & Page Setup.
A dialog with printer settings opens. 

3. Select the preferred printer, paper size, orientation, etc.

4. If you need to, change the margins by setting the Left, Right, Top and 
Bottom settings.
Please note that each printer has a minimum margin. To automatically set the 
values to this, click the Default Values button. 

5. Click OK to close the dialog.
The “Print” item should now be available on the File menu. If it is greyed out, 
you have not made the correct printer settings in the Print & Page Setup dia-
log - repeat step 6 to 8 above.
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6. Select Print from the File menu or press [Command]-[P].
A dialog box appears. The options in the dialog depend on the type of printer 
you use (explained in your Windows documentation). Normally you should 
be able to specify a number of copies to be printed, print all pages or just a 
specified range, etc.

7. Click OK.
A dialog will inform you of the progress of the printout. You can cancel print-
ing at any time by clicking the Cancel button.

● Note that printing is only available from Score Edit!
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Introduction
Step Input is when you enter notes one at a time (or one chord at a time). This is 
useful when you know the part you want to record but are not able to play it exactly 
as you want it.

Preparations

1. Create an empty Part, as a container for the notes you are about to Step 
Record.
You can of course also use an exisiting Part.

2. Open the Part in a MIDI editor of your choice.
The pictures below show Key Edit, but it doesn’t matter which you select.

3. Click on the Step button.
This automatically activates the MIDI In icon and the Step Position box.

Click the Step button...

...the MIDI connector is 
automatically activated...

...and the Step 
Position box appears.
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Determining Note Lengths and Positions

• To set the length of the notes you are about to input, adjust the editor’s 
Quantize value.
If for example you set this to “16” all notes you input will be sixteenth notes.

• To set the “spacing” between the notes and chords, adjust the editor’s 
Snap value.
If you set this to “8” all notes will appear on eighth note positions.

Setting the Position for the first note

To set the position where you want the first note to appear, adjust the regular Song 
Position (for example on the Transport Bar) and the Step Position is automatically 
set to the same value.

Note length

Note “spacing”
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Selecting a Track for input

If you are editing several Tracks at the same time, you must decide which Track to 
enter notes into by making a Part/Track active. This is just as when recording from 
an editor, see page 262.

Entering notes and chords

1. Play one key or a chord.
If you just played one key it appears as soon as you release it. If you play a 
chord it appears when you release the last key. In either case, the velocity you 
played is recorded with the note.
No matter how long you hold down the key, the note will get the length set in 
the Quantize box.

2. Enter the note(s) for the next position.

When you release 
the key, the note 
appears and the 
Step Position box 
advances one step.
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Adding Rests

To move one step without entering any notes, press the [Tab] key on the computer 
keyboard.

Changing note values and positions as you go along

• If you want to enter notes of another length, simply change the Quantize 
value at any point.

• If you want to input notes with a different “spacing” simply adjust the 
Snap value.

• If you want to move to a completely new position, change the Song Posi-
tion or use Fast Forward or Rewind.
If you change the Song Position...

...the Step Position is set to the same value.
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If you make a mistake

If for example you entered a note with the wrong pitch or made a mistake when 
playing a chord, press [Backspace]. This deletes the last note/chord you entered, 
and moves the Step Position one step backwards. You can press this key repeatedly 
to “delete backwards”.

You can also use the tools and menu for editing (deleting, moving etc.).
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Using the Insert button

If the Insert button on the Status Bar is activated, the notes are inserted rather than 
added. That is, any existing notes are moved to a later position to make room for the 
new notes.

The Insert button.

With Insert on, and the Step Position here... ...the new note is inserted, and the 
following notes are “pushed forward”.
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Playing back

You can activate playback at any time and from any position, to hear what you have 
done. Please note, though, that moving the Song Position also moves the Step Posi-
tion.

When you are finished

When you have entered all the notes you want, don’t forget to deactivate step mode 
by clicking on the MIDI In button.

Click on the “MIDI connector”, and the 
Step button is automatically deactivated.
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How Functions are applied

● The procedures in this chapter are relevant for MIDI Tracks only.

By using the items on the Functions menu you can perform various operations on 
notes and other MIDI data. The most important of these functions is called Quanti-
zation, and will be explained in detail in this chapter. However, before explaining 
how the functions work, it is important to know exactly what is affected by a func-
tion:

In the Arrange window

• Functions will apply to all selected Parts. 

• If there are no selected Parts, the function will apply to all Parts on the 
active Track.

In the MIDI Editors

• Which Events are affected depends on the selection and the setting on 
the To pop-up menu (see page 273).
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Quantizing

What is Quantizing?

Quantizing is a function that automatically moves recorded notes, positioning them 
on exact note values. If you record a series of eighth notes, for example, some of 
them may end up slightly “off” the exact eighth note positions. Quantizing the 
notes with the Quantize value set to eighth notes, will move the “misplaced” notes 
to exact positions.

The Quantize value concept may need some explanation. By setting this value, on 
the pop-up menu on the Status Bar, you select the exact positions the notes should 
be moved to when you quantize. These are the options:

In this example a Quantize value of eighth note triplets is selected.

This column is for selecting a 
triplet Quantize value. 
The available values range from 
1T (whole note triplet) to 
64T (1/64 note triplet).

If you select OFF, no quantizing 
will be done.

This column is for selecting a 
dotted Quantize value. The 
available values range from 
1. (dotted whole note) to 64. 
(dotted 1/64 note).

The middle column is for selecting “normal” Quantize values. The available values range 
from 1 (whole note) to 64 (64th-note).
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Selecting Over Quantize

In Cubasis AV, the Quantize function is called “Over Quantize”. This is a very mu-
sical version of the standard “auto correct” quantize. It will move notes to the clos-
est quantize value, without changing the length of the notes.

To Quantize your music, proceed as follows:

1. Select the Part(s) (Arrange window) or notes (MIDI Editors) that you 
want to Quantize.
If you have no Parts selected in the Arrange window, all Parts on the selected 
Track will be affected.

2. Pull down the Functions menu and select Over Quantize or press [Q] on 
the computer keyboard.
The selected notes are quantized according to the selected Quantize Value.
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Undoing Quantize

● Quantizing in Cubasis AV is not done “once and forever”! You can always re-
quantize to any value, even to Off, and even after saving to disk!

This means that notes quantized to eighths can later be quantized to sixteenths. The 
original (un-quantized) positions of the notes are used for determining how notes 
should be moved.

To completely restore quantized notes to their original positions, use the Undo 
Quantize function on the Functions menu. This can be applied to any selection of 
Parts or notes, just as all Functions (see page 359).
- 362 - 



Other Functions
The Functions menu is not only used for quantizing, it contains a couple of other 
functions as well. The same rules as for Quantizing are used to decide what gets af-
fected. 

Delete Doubles

This command erases all double notes, which may occur when you record with Cy-
cle activated. Double notes could be hard to hear, but sometimes they sound like 
short delays or flanger effects (or even just as one extra loud note).

Notes are considered to be doubled when they have the same note number (pitch) 
and have identical start points.

Delete Cont. Data

This command erases all continuous data such as Modulation, Pitch Bend, etc. 
Notes and Program Change Events are left unaffected.

Freeze Play Parameters

Use this function when you need to make play parameters in the Inspector perma-
nent, or in other words, convert them to real Events, as described on page 149.
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Using the Master Track
The Master Track is a special Track that contains time signature and tempo events 
only. Use this Track when you want to incorporate time signature and tempo 
changes in your music. If your Song does not contain any time signature or tempo 
changes, it is easier to set the tempo on the Transport Bar, as described in the chap-
ter “Playback, Tempo and the Transport Bar”.

• To make Cubasis AV follow the tempo settings on the Master Track, click 
on the Master button on the Transport Bar so that it is activated.

You may also press [M] on the computer keyboard to activate/deactivate the 
Master Track.

● Cubasis AV always follows the Time Signature changes set up on the Master 
Track. By activating/deactivating the Master Track, you decide if Cubasis AV is 
to follow the Master Track tempo settings or the tempo on the Transport Bar. 

● Please note that changing the tempo in Cubasis AV will not change the tempo 
within any recorded audio! The Master Track tempo only affects when each 
Audio Part starts, not the actual contents of the Part.

Master activated
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The Master Track Editor
There are two ways to display the Master Track and its entries:

• Select Master Track from the Edit menu.

• Press [Control]-[M] on the computer keyboard.

The four columns in the list display each entry's position (in two different ways, see 
below), and its tempo or time signature value.
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The Tempo and Time Signature entries are shown in a list which can be scrolled us-
ing the scroll bar or the [↑ ] and [↓ ] keys on the computer keyboard. There are al-
ways two entries at the top of the list; the Master Track is never empty. These two 
are the initial tempo and time signature, positioned at 1. 1. 0.

About the Time Position value

The fourth column in the list shows the time position for each entry. This is dis-
played in the format hours:minutes:seconds:frames:subframes, where there are 25 
frames to each second and 80 subframes to each frame (the common European time 
code format). This is useful when for example you are working with sounds and 
music for movies (see the chapter “Movies”).

Remember that the time position for an entry will change when you change any 
previous tempo value. For example, an entry on the first beat of bar 15 (position 
15:01:000) will have the time position 00:00:28:00:00 in tempo 120. If you lower 
the initial tempo in the Mastertrack to 105, the entry will have the time position 
00:00:32:00:00, since it “takes longer” to get to bar 15 at this lower tempo.
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Editing Events in the List

You change the Tempo and Time Signature values directly in the list, using the nor-
mal value editing procedures. Please note:

• You cannot change the position of the Events in the list.
Instead of moving an Event, use Cut and Paste, as described on page 370.

Inserting Tempo or Time Signature Events

To insert new Events into the list, you use the Functions pop-up menu in the top left 
corner of the editor:

1. Use the Song Position value box in the top right corner to set the position 
where you want to insert the Event.

2. Pull down the Functions pop-up menu and select “Insert Tempo” or “In-
sert Signature”.
The new Event is added to the list. Time Signature Events are always posi-
tioned at the start of a bar.

3. Edit the Event to give it the desired value, as described above.
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Deleting Events

1. Click on the Event you want to delete, to select it.

• If you want to select a range of Events, click on the first Event, hold down 
[Shift] on the computer keyboard and click on the last Event.
All Events in between are selected.

• If you want to select several Events, but not all in between, hold down 
[Control] and click on the Events.
Only the Events you click on are selected.

2. Pull down the Functions pop-up and select Delete Selection, or press 
[Delete] on the computer keyboard.
The Event is removed from the Master Track.
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Cut, Copy and Paste

You can use the Cut, Copy and Paste commands on the Edit menu (and their key-
board equivalents) on the Master Track Entries.

1. Select one or more events and Cut or Copy them.

2. Set a new Position value using the Song Position value field.

3. Select Paste.
The entries will get pasted in, beginning at the position set in the value field.

• A Pasted entry will not replace an existing Entry at the same Position.

• A Time Signature entry can only be pasted in at the downbeat of a bar.
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Other Functions

On the Functions pop-up menu in the top left corner, there are some other functions 
for the Master Track:

Hide/Show Tempi and Time Signature

These two menu items allow you to Hide either all Tempi or all Time Signatures. 
When either is hidden, its menu item changes from “Hide” to “Show”.

Clear Tempi

This function simply deletes all tempo entries but the first from the list.

Copy Range

This function is practical if you have a certain section of tempo and/or time signa-
ture changes in your Song and want to copy this section to another position. Pro-
ceed as follows:

1. In the Arrange window, set up the Left and Right Locator to encompass 
the section you want to copy.

2. Move the Song Position pointer to where you want to copy the section.

3. Press [Control]-[M] to open the Mastertrack editor.
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4. Pull down the Functions pop-up and select Copy Range.
The entries within the range will be copied and the copies pasted into the 
Mastertrack, starting at the Song Position you set in step 2 above.

Undo

Any deletion, copying or creation of events in the Master Track can be undone by 
selecting Undo from the Edit menu or by pressing [Control]-[Z] on the computer 
keyboard. Value changes cannot be undone. 

Closing the Master Track Editor

Close the editor window by clicking its close box or pressing [Return] on the com-
puter keyboard.
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Introduction
This chapter describes the general procedures of adjusting levels, pan etc., for both 
audio and MIDI Tracks. This is done in two different windows in Cubasis AV, the 
Audio Mixer and the GM/GS/XG Editor.

About the differences between the two Mixers

It is important to understand the difference between the two Mixers:

• The Monitor window (the audio mixer) affects the actual audio playback.
For example, the volume faders in will really attenuate or boost the volume of 
the audio, and the pan controls will determine where in the stereo image (left 
- middle - right) the sound appears when you play it back. 
This also means you have to be careful when raising the channel volumes - 
it’s fully possible to cause distortion by setting to high levels. If this happens, 
simply lower the faders until the distortion disappears.

• The  GM/GS/XG Editor (the MIDI mixer) sends out MIDI messages to the 
connected MIDI sound source.
For examples, the volume faders in the MIDI Mixer send MIDI Volume mes-
sages (Controller 7) on each channel, and the pan controls send MIDI Pan 
messages (Controller 10).

● For this to work properly, your MIDI sound source must be able and set to re-
ceive the appropriate MIDI signals. Most modern MIDI instruments are, but if 
you’re in doubt, consult your instrument’s documentation.
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Opening the Mixers
• Open the Audio Monitor Mixer by pulling down the Audio menu and se-

lecting “Monitors”.
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• Open the GM/GS/XG Editor by selecting “GM/GS/XG Editor” on the Edit 
menu, or by pressing [Control]-[Y] on the computer keyboard.

Performing the Mix
To mix, simply play back the music and adjust the controls in each window to your 
liking.
- 376 - 



The Monitor Mixer Controls
Below follows descriptions of the controls in the Monitor window:

Control: Description:

Channel 
Faders

These work just like volume faders on a normal mixer. 
Just click and drag the fader handles to set the playback 
level for each channel.

• If you click directly anywhere on the fader, the fader 
handle is immediately set to where you click.

• If you hold down [Alt] and drag a fader, all faders in 
the Monitor Mixer will be moved accordingly.

Use this as a quick way to lower the total volume, if you 
get distortion due to high levels.

Pan Controls These govern where the sound of each channel is posi-
tioned in the stereo image. To change the panning for a 
channel, drag the red line left or right, or click directly in 
the pan control box (the pan line is immediately moved to 
where you click).

Meters These show the playback level of each channel. If the red 
segments at the top of the meter graph light up, you 
should lower the level of the channel, to avoid distortion.

Mute buttons Clicking these buttons temporarily silences the corre-
sponding audio channels.
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The GM/GS/XG Editor
If you have a MIDI instrument that supports any of the standards GM (General 
MIDI), GS (Roland’s extension of GM) or XG (Yamaha’s extension of GM), this 
window allows you to “mix” the sound of your MIDI instrument, by sending MIDI 
messages to the instrument. These messages include volume, pan, program change 
and effect settings (GS/XG only).

● If your instrument does not support any of the standards mentioned, you may 
still be able to use some of the functions in the editor, such as volume and 
pan. Refer to the instrument’s documentation and to the MIDI message col-
umn in the table below.
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The Mixer section

This is the main section of the window, where you perform the actual mixing. The 
following table lists the controls available for each channel:

Control: Description: MIDI message:

Volume fader Drag the fader to change the volume of the corre-
sponding MIDI channel.

Controller #7

Pan Defines the panning (position in the stereo image) 
for the corresponding MIDI channel. The Drum 
channel (channel 10) has no panning control.

Controller #10
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Reverb level Although this is not a part of the GM specifications, 
many GM instruments (and all GS/XG instruments) 
have a built-in reverb that can be controlled via the 
standard MIDI controller number for reverb (#91). 
If this is available in your instrument, use this value 
field to set the amount of reverb for the channel.

Controller #91

Chorus level Like the Channel Reverb controls, this parameter is 
not a part of the GM specification. However, some 
GM instruments (and all GS/XG units) have a built-
in chorus (sometimes flanger or delay) that can be 
controlled via the standard MIDI controller number 
for chorus depth (#93). If this is available in your in-
strument, use this value field to set the amount of 
chorus for the channel.

Controller #93

Program name This item opens a hierarchical pop-up menu with 
the 128 GM sounds divided into instrument type 
groups on sub-menus. 
To select a sound, pull down the pop-up, move the 
pointer to one of the instrument groups and select 
the sound from the sub-menu that appears.

Program 
Change

Mute switch 
(GS/XG only)

In GS/XG Mode (see below), the channel number 
fields above the faders can be used as Channel 
Mute buttons. You can mute/unmute each channel 
individually by clicking on the respective button.

Manufacturer 
SysEx

Control: Description: MIDI message:
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The Device section

Control: Description:

Mode You can use the editor in GM or Roland GS or Yamaha XG mode. To 
switch between modes, click on the Mode pop-up and select the de-
sired mode.

Output Use this pop-up menu to select the Output to which your GM/GS/XG 
instrument is connected (otherwise the editor wouldn’t know where to 
send the changes you make).

On/Off/Reset 
button

This button has different names and functionalities depending on 
which Mode is selected:
In GM mode, this button is used to switch your instrument in and out 
of General MIDI mode. Click on the button to send the command that 
is currently shown, to your instrument.
In GS/XG mode, this button is labelled “GS/XG Reset”. Clicking it re-
sets all controls in the window, as well as any connected GS/XG in-
strument, to their default values.
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The Effects section (GS/XG only)

The third section is not shown at all in GM mode. It contains the following global 
settings for the reverb and chorus effects that are included in all GS/XG instruments:

Control: Description:

Reverb pop-up Lets you select one of eight reverb types. The available reverb types 
are different in GS and XG instruments. In XG mode, selecting “No 
Effect” allows you to easily turn off the reverb completely.

Reverb time Lets you change the overall reverb time.

Chorus pop-up Lets you select one of eight chorus- and related effect types. The 
available effect types are different in GS and XG instruments. In XG 
mode, selecting “No Effect” allows you to easily turn off the effect 
completely.
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Background
You can set up synchronization between Cubasis and other equipment, so that the 
two devices play together and at the same tempo. This is done by receiving or trans-
mitting something called MIDI Clock. MIDI Clock is a very fast metronome trans-
mitted in a MIDI cable. 

• If one device is set to transmit MIDI Clock, via its MIDI Out, it will trans-
mit this “metronome” at the specified tempo when you activate playback 
on the device.

• If a device is set to receive MIDI Clock, it will ignore its own tempo set-
ting and instead play at the tempo specified by the incoming MIDI Clock. 

Cubasis can do both of these things, at the same time if you wish.
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Synchronizing Cubasis to other equipment
In this case, Cubasis AV will ignore its own tempo setting, and adjust its playback 
to the other device.

1. Connect the MIDI Out of the other device to a MIDI In on the computer.

2. Set up the other device to transmit MIDI Clock.

3. Open Cubasis’ Synchronization dialog box. 
This is reached from the Options menu.

4. Check the box titled “Receive MIDI Clock” and select the correct MIDI 
Input from the “Input” pop-up. 
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5. Close the dialog.

6. Activate playback on the other device. 
Cubasis will start automatically and play at the same tempo as the other de-
vice. 

• If you wind the other device to a certain position, and activate its play-
back function, Cubasis will automatically start from the correct position.
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Synchronizing other equipment to Cubasis
In this case, the other devices will adjust their playback and tempo to Cubasis AV.

1. Connect one of the MIDI Outputs on your computer to a MIDI In on the 
other device.

2. Set up the other device to receive MIDI Clock via this MIDI In.

3. Open Cubasis Synchronization dialog box. 

4. Check the box titled “Send MIDI Clock” and select the correct MIDI 
Output from the “Output” pop-up. 

5. Close the dialog.

6. Set the desired tempo in Cubasis and click the Play button. 
The other device should start automatically. 

• If you wind Cubasis to a certain position, and hit Play, the other device 
should automatically start from the correct position.
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What is Video for Windows?
Video for Windows (AVI) is an extension to Windows that allows you to play back 
movies in a window on your computer.

Cubasis AV supports Video for Windows, which means that you can have video 
playing on your screen, synchronized with Cubasis AV’s playback.

Do I need to install Video for Windows?
If you run Windows 3.1 and 3.11, you need to install the Video for Windows DLL, 
before you can play back video from your computer at all. Please contact your 
computer dealer for more information. If you are running Windows 95/98, video 
support is built in.
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Opening a Movie
1. Select Open Movie from the File menu.

A standard file dialog appears.

2. Locate and select the movie file (extension “.AVI”) and click OK.
The movie appears in a new window.

• If you want a certain movie to be opened automatically when you launch 
Cubasis AV, you can copy it to your Cubasis AV directory and name it 
“DEF.AVI”.
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Playing back the movie
1. Pull down the Options menu, select Movie and from the submenu that 

appears, select “Options...”. 
The AVI Monitor Options dialog appears.

2. Make sure that the On Line option is activated.

3. Click Exit to close the dialog.

4. Activate playback in Cubasis AV.
The movie plays back in sync. If for some reason you don’t want the movie to 
play when you play back MIDI and audio, open the Options dialog again and 
deactivate On Line.

● The audio in the movie is not played back when you play it from within 
Cubasis AV.
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About Positioning

The positions of Cubasis AV and the movie are completely linked. This means that 
when you Fast Forward, Rewind, Locate etc., the movie will be positioned accord-
ingly.

Setting Offset

If you don’t want the movie to start at the first bar of the Cubasis AV Song, you can 
define an Offset value:

1. Pull down the Options menu, select Movie and from the submenu that 
appears, select “Options...”. 
The Options dialog appears again.

2. Use the Offset value field to set the desired time at which you want the 
movie playback to begin.
The value is in time code format (hours:minutes:seconds:1/25ths of seconds). 
If you for example set this to “00:01:00:00”, the movie will start one minute 
in, from the beginning of the Song.
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Other Options

There are a a few additional options on the Movie sub-menu on the Edit menu:

• Hide/Show Title Bar.
This hides/shows the movie window's title bar.

• Hide/Show Movie.
This hides the movie window without closing the file. To show the movie, se-
lect this item again.

Closing the Movie
You close the Movie by pulling down the File menu and selecting Close Movie. 
This item is greyed out when no Movie is open.
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Why Customize?
When you use Cubasis AV the first time, all settings in the program have “factory 
values”. Depending on your working style, what we have chosen might suit you 
perfectly or not at all. By customizing Cubasis AV, you are able to make it “your 
program” and you will streamline your work considerably.

Customizing actually only involves two steps:

1. Setting up the program exactly as you want it to be each time you start 
up.

2. Saving those settings in a default Song file (“Def.All”; hereafter referred 
to as the “startup song”).
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Before customizing...
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... and after.
- 397 - 



Examples of things to customize
Below follows a brief list of candidates for customizing. You might not understand 
what all the functions below are for and what they do. Either look them up in the 
rest of this manual or leave them out for now.

Window Settings

You can change the size of the windows, move dividers and set the magnification, 
to tailor the windows to your needs. Saving this in the startup song will make the 
program appear as you want it.

Tracks

You can create and name Tracks, set them to different Track classes, etc. For exam-
ple if you know you always want a Drum Track that plays on MIDI Channel 10, 
simply create it!

You can also rearrange Track columns as you like.

Parts

You can even have Parts in your startup Song. These could for example contain li-
braries of often used drum patterns or riffs. Or, they could contain System Exclu-
sive dumps of settings that load your instruments with certain sounds. Put the Parts 
on muted Tracks and drag them onto other Tracks when you need them.
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Transport Bar settings

You might for example prefer to record in Cycle Mode, or you might always want 
Click activated. If you do, simply set this up on the Transport Bar.

Editor settings

If you prefer certain settings in the editors, for loops, quantizing etc, set them up 
and save them with the startup song.

Preferences

On the Options menu, there are several items, like Double Click opens and Follow 
Song, which you may prefer to have set in a certain way.

Metronome

Do you want a click at all? Do you want it via the computer speaker or via MIDI? 
How long do you want the count-in to be? All this is set in the “Metronome” dialog 
box, reached from the Options menu.

Sync

Most often you will synchronize to the same external equipment – for example the 
tape recorder in your studio. By setting up the Synchronization dialog as you want 
it and saving this with the startup Song, Cubasis AV will automatically synchronize 
as soon as you hit play on the tape recorder.
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Saving the Startup Song
Once you have set up the Song, perform the following steps (details about file sav-
ing can be found in the next chapter).

1. Pull down the File menu and select “Save As...”.

2. From the File Format pop-up, select “Songs (*.ALL)”.

3. Make sure you save in the same  directory as your Cubasis AV program.

4. In the File Name field, type in the name “Def.All”.

5. Click OK.
Now the next time you launch the program, the Song you just saved will au-
tomatically be loaded.
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Starting from other Song documents –Templates
The only thing that is special about the  Def.All Song, compared to other Songs is 
that it loads automatically on startup if found in the same directory as the pro-
gram.You can in fact use any Song document for customizing on startup. This is 
convenient if you do different types of work and want different “templates” for 
each.

1. Set up the Song as you want it.

2. Save it under any name in any  directory on your hard disk.

3. When you want to use a “template” song, simply double click on the 
document icon in the File Manager, or create an icon in the Program 
Manager/Start Menu and launch from this (see your Windows documen-
tation).
Cubasis AV launches and the Song is loaded automatically.
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Saving

Which should I choose - Song or Arrangement?

When you save your music in Cubasis AV, there are three document formats you 
can use for saving your music: Song, Arrangement or MIDI File. You should only 
choose MIDI Files if you want your music (MIDI only - no audio) to be playable in 
other sequencers. If you want to save your music for further use in Cubasis AV, you 
should use either the Song or the Arrangement format:

Song

When you save a Song, the following is saved:

• All the Arrangements.
• All settings in dialogs, on the Transport Bar, etc.
• All Audio Parts and segments, and references to their respective audio files.
• The Pool.
• The settings in the Mixer windows.
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Arrangement

When you save an Arrangement, the following is saved:

• All the things you see in one Arrange window; the Tracks, the Parts, the In-
spector settings etc.

The audio files, however, are stored in the Pool, and the Pool is not part of the Ar-
rangement. This means that if you only save an Arrangement, there will be no audio 
files for them to reference to! Therefore:

● When doing audio work with Cubasis AV we recommend that you always 
save complete Songs!
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This table shows the advantages and disadvantages of the two formats:

File Format Advantages Disadvantages

Arrangement • Takes up little disk space.

• Does not contain “unneces-
sary” settings if all you want to 
save is MIDI music.

• Opening an Arrangement 
does not affect settings in dialog 
boxes and on menus, which, in 
some situations, is an advan-
tage.

• A saved Arrangement can be 
opened and incorporated into 
any other Song.

• Does not contain any refer-
ences to audio.

• Does not contain a complete 
“snapshot” of the program’s 
“state”.

Song • Contains references to all au-
dio information and data.

• Contains more than one Ar-
rangement.

• Saves all the settings on all 
menus, in all dialog boxes etc.

• Takes up more disk space than 
the Arrangement file format, 
even if you only have one Ar-
rangement in the Song.
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Performing the Save

1. Pull down the File Menu and select “Save As...”
The file dialog appears.

2. Use the standard controls to find the location on your hard disk where 
you want to save the file.

3. Use the file type pop-up to select a format, Song or Arrangement.

File List Standard Windows File navigation menus and buttons

Cubasis AV File 
Type Selectors

File Name
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4. Type in a name for the file.

5. Click the OK button.

Using “Save”

On the File menu you will find a menu item called “Save”.

• If you have already saved your Song once (using “Save As...”) this menu com-
mand will save your Song without asking for a file name and location. The file 
you save now will simply overwrite the earlier version.

• If you have not yet saved your Song, selecting “Save” is the same as selecting 
“Save As...”.

The “Save” command can also be executed by pressing [Control]-[S] on the com-
puter keyboard.
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Opening
1. Select Open... from the File menu.

The Open dialog appears.

2. Use the pop-up to select which type of file you want to open, Song or Ar-
rangement.

3. Use the standard controls to display the correct folder on your hard disk.

Standard Windows File navigation sectionFile List

Cubasis AV File Type 
Selectors

File selected for opening
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4. Click on the file in the file list.
The list will only show documents of the selected type.

5. Click Open.

About opening Songs

If the file is a Song, you will be prompted with a reminder that the Song you open 
will appear instead of the Song you have on screen now. If this is not what you 
want, Cancel and Save the existing Song first.

About opening Arrangements

If the file is an Arrangement, it will appear as a new window on screen, in addition 
to any Arrange windows already open.

Opening Songs made by other Steinberg programs

Cubasis AV can open Song files made in other Steinberg sequencer programs such 
as Cubase and Cubasis. However, there are some restrictions:

• If the Song contains more than 64 Tracks, the excess Tracks are removed.

• In more advanced Steinberg programs, there are additional settings and 
parameters, which are ignored when opening the file in Cubasis AV.
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Exporting an Arrangement as a MIDI File
You might want to export an Arrangement as a Standard MIDI File, so that it can be 
loaded into other computer programs or hardware sequencers, for example.

● A Standard MIDI File contains MIDI data only - no audio. Any audio in your 
Arrangement will automatically be excluded from the created MIDI file.

1. Mute all the MIDI Tracks you don’t want included in the MIDI File.

2. Pull down the File menu and select “Export MIDI File”.
A file dialog appears.

3. Select a name and location for the file.

4. Click Save.

● Cubasis AV normally saves MIDI files in format 1. However, if you Export a 
MIDI File with only one Track unmuted, a MIDI File of type 0 is created.
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Importing a MIDI File
You can import Standard MIDI files into Cubasis AV, either into the currently se-
lected Arrangement or into a new Arrangement of its own:

1. If you want to include the MIDI file in an existing Arrangement, select 
this Arrangement and move the Left Locator to where you want the MIDI 
file to start.

2. Pull down the File menu and select “Import MIDI File”.
A dialog box appears, asking if you want the file to appear in a new Arrange 
window or if you want to merge the MIDI File into the current Arrangement.

3. Select one of the options.
The MIDI file is imported. The data is automatically split up into shorter seg-
ments (Parts) to make it easier to edit the music in the Arrange window.
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About Audio Files

Audio File Formats

All audio files created by Cubasis AV are Wave (.WAV) files with 16 bit resolution.

However, using the Import Audio command in the Pool, you can load audio files in 
AIFF format. When you do this, the program expects the imported file to match the 
sample rate setting in the Song. If the audio has another sample rate, it will not play 
back normally.

Backing Up

Needless to say, it is essential that you back up your audio data regularly, preferably 
on to another device.
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About Audio Cards

Which cards will work?

Cubasis AV works with any audio card that meets the following demands:

• Capable of 16-bit wave file recording and playback.
• Comes with a Windows driver.

Sample rates

Cubasis AV can record and play back at five sampling rates, 11025Hz (11kHz), 
22050Hz (22kHz), 32000Hz (32kHz), 44100Hz (44.1kHz) and 48000Hz (48kHz).

The choice of sample rate is made in the Hardware Setup dialog as described on 
page 430. Most audio cards support 11, 22 and 44.1kHz. Many cards do not support 
48kHz and some don’t support 32kHz.

Audio Quality

The audio quality you get from your recordings (the amount of distortion, the 
amount of background noise etc.) is solely dependant on your audio card and your 
other audio equipment, not on Cubasis AV.
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Number of Audio Channels

The number of audio channels does not depend on the audio card at all (except for 
the “single mode DMA warning” earlier in this chapter). More on this later in this 
chapter.

Timing

Cubasis AV uses a part of Windows called Windows Multimedia System. When 
you activate playback or recording, Cubasis AV “asks” Windows Multimedia Sys-
tem to in turn “ask” the audio card to start playback/recording.

How long this actually takes depends on a few factors, but the most important is the 
card and its driver. If one particular card is slower than another there will be a 
longer delay between Cubasis AV’s playback command and the moment the audio 
actually starts playing back.

To compensate for this, there are two Offset settings in the Hardware Setup dialog, 
one for recording and one for playback. See page 431.
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Stereo/Mono

All 16-bit audio cards can record and play back in stereo or mono.

• In Cubasis AV you can decide before each recording which it should be, 
stereo or mono. This is done in the Inspector as described on page 48 in this 
manual.

• Playback can also be switched to stereo/mono, as described on page 430.

Simultaneous Recording and Playback (“Full Duplex”)

On a regular multi track recorder you often perform something called overdubbing. 
This is when you listen to one Track and at the same time record on another.

You can of course overdub in Cubasis AV, but there are a few things you have to be 
aware of.

For a PC audio card to allow simultaneous recording and playback, the card must 
support something called Full Duplex. Many PC audio cards do not have the ability 
to record and play back at the same time. This means that as soon as you enter 
record mode, you will not hear your previously recorded audio Tracks. This is not a 
limitation of Cubasis AV, but of the cards themselves.

If your card does have the ability to record and play back at the same time, you 
should activate this function in Cubasis AV’s Hardware Setup dialog, see page 429. 
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It is of course a great benefit to have this ability, since it allows you to match your 
current performance to the previous audio recordings, for example when adding vo-
cal harmonies, one by one.

Some cards, like the Roland RAP-10, have the ability to use one channel for play-
back and the other for recording, which means that you can record and play back 
audio at the same time, but only if playback is limited to mono in the Hardware 
Setup dialog.
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Computer Performance and Audio Channels
The number of audio channels you can get from your system depends on a number 
of factors. These factors are all related to the amount of data that has to be trans-
ferred within the system. When you record, data is collected by the audio card and 
transferred via the computer’s processor to the hard disk. When you play back, this 
process is reversed. On the way there are a number of bottlenecks to pass, which we 
will try to outline on the following pages. Please also refer to the Read Me files in 
your Cubasis AV directory which may contain late information on how to optimize 
your system.

How do I know how many channels I can get?

There are two ways to do this:

• Use the included “Performance Tester” program, to test your computer’s 
performance. See page 435 in this chapter.

• Record and play back channel by channel, until Cubasis AV informs you 
that there is not enough capacity to play back all the Tracks at the same 
time.
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Computer architecture and processor speed

In all audio operations, the computer’s processor is involved, which means that the 
processor speed will limit the amount of audio that can be handled at any given 
moment.

Memory access

During playback, data is read from the hard disk and output via the audio card. Dur-
ing this process the data has to pass via the computer’s internal memory (RAM). It 
is very hard to determine exactly how fast any computer is in this respect, but a 
“256 kByte 2nd level cache” will improve performance considerably.

Hard disk caching and access

If you are using Windows 3.1, we recommend that you use SmartDrive (or similar) 
to increase the hard disk performance.

If you are using Windows for Workgroups (Windows 3.11), we strongly recom-
mend that you activate “32-bit file access” if your system supports it.

If you are using Windows 95, there are two settings you can adjust to improve the 
performance for audio recording: Read-ahead Optimization and File Caching.
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Windows 95/98 Read-ahead Optimization

When disk Read-ahead Optimization is turned on, Windows 95/98 will read data 
from disk in bigger chunks than the application (Cubasis AV) actually requests. For 
many hardware configurations, this will increase the performance. However, for 
some systems, raising the Read-ahead memory amount might instead have a nega-
tive effect on performance. Therefore, we suggest that you experiment to find the 
setting that bests suits your system. Proceed as follows:

1. Click the Start button on the Taskbar.

2. From the menu that appears, select "Settings" and then "Control Panel".

3. In the Control Panel, double click on "System".

4. Click the "Performance" tab at the top.

5. Click the "File system..." button.

6. Move the slider to another position.
You can select 0kB (None), 16kB, 32kB or 64kB (Full).

7. Click OK and OK again in the next window that appears.

8. Close the Control Panel.
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9. Start the Steinberg Performance Tester program and check its results. 
Alternatively you can launch Cubasis AV and check whether it performs 
"more smoothly" than before.

10.Repeat this operation until you find the best setting for your computer 
configuration.

Windows 95/98 File Caching

Windows 95/98 has a built-in file caching mechanism. This mechanism implements 
a very sophisticated way to improve disk performance for certain applications. 
Contrary to Smartdrive for Windows3.x, the File System Cache of Windows 95/98 
does not have a fixed size. Instead it can grow within the physical memory when the 
demand on disk data access is high. For Multimedia and hard disk access intensive 
applications this becomes a problem.

When the File System Cache increases its size, application and data memory will 
be paged out into the swap file by the virtual memory system.This leads to addi-
tional disk accesses, which will cause the audio recording and playback perform-
ance to suffer. To avoid this performance degradation, you should set a maximum 
size for the Dynamic File System Cache.

Microsoft did not provide a user interface for the file system cache.You have to 
manually edit the SYSTEM.INI file. Please perform the following steps:

1. Click the Start button on the Taskbar.
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2. From the menu that appears, select "Programs", then "Accessories" and fi-
nally "Notepad".

3. From within the Notepad, select "Open..." from the "File" menu.

4. For the file type select the option "All files".  Locate and select the SYS-
TEM.INI file in the Windows directory and click the "Open" button.

5. In the SYSTEM.INI file, search for a line which consists of [vcache] (the 
word "vcache" in square brackets).

6. Add a new line after the [vcache] line. Type "MaxFileCache=2048" on 
that line.
If you have a computer with only 8 MByte of RAM you should type "MaxFile-
Cache=512" instead.

7. Select "Save" from the "File" menu.

8. Click the Start button on the Taskbar.

9. Select "Exit" and choose "Restart Windows".

10.Click OK.
Windows 95/98 restarts and the new settings take effect.
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Disk Controller Card

The controller card for the hard disk is the next possible bottleneck:

• If you have an IDE or E-IDE drive, preferably use an “Enhanced IDE” (E-IDE) 
controller card.

• We recommend that you use a controller card connected to your computer's 
PCI bus, VESA local bus or EISA, rather than to the ISA bus. A PCI or VESA card 
can transfer data considerably faster than an ISA card.

Hard Disk Speed

The speed of the hard disk is probably the biggest limiting factor. 

One unit of measure for a hard disk’s speed is the Average Access Time. This 
should be as low as possible, and the more Tracks you plan to record on the drive, 
the lower it has be. For eight stereo Tracks, you need an Average Access Time of 
20ms or less.

Many manufacturers do not specify the Average Access Time. You will then have to 
check out a number of other parameters:

• Average Seek Time. This should be as low as possible.
For eight stereo channels at 44.1 kHz, you need an Average Seek Time of 9ms 
or less. 
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• Rotation Speed. Sometimes indicated as Rotation Latency. The Rotation 
Speed should be as high as possible, which in turn makes the Rotation La-
tency as small as possible. 
For eight stereo Tracks you need a Rotation Speed of 5400rps or above, which 
equals a Rotation Latency of 5.6 ms or less.

• Sustained Data Transfer Rate. This should be as high as possible.
For eight stereo Tracks you need at least 5Megabytes/second.

SCSI or E-IDE?

• In general, SCSI disks are better suited for hard disk recording than IDE drives, 
for various technical reasons. However, a fast E-IDE drive is better than a slow 
SCSI one.

• If you decide not to use SCSI, try to get an “Enhanced IDE” (E-IDE) drive rather 
than a regular IDE one.

• If you use a SCSI or E-IDE drive, make sure it has a built in cache of at least 
256 kByte, preferably 512 kByte.
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Other hard disk considerations

• Make sure the hard disk does not have automatic “thermal recalibration”. Or, 
at least use a hard disk that only performs thermal recalibration when the 
hard disk is not in operation. Some manufacturers sell special “A/V” (Audio/
Video) drives, claimed to be specifically suitable for hard disk recording. This 
usually means (among other things) that the drive doesn't have automatic 
thermal recalibration.

• Try to get as large a disk as you can. We recommend 1 GigaByte and up. You 
will get 1 minute of mono audio for each 5 MByte on the hard disk, per Track, 
at 44.1kHz sample rate. This means that if you for example record two stereo 
Tracks, you will use up 20 MByte per minute.

• We recommend that you save your audio files together with your Song docu-
ments on a separate drive, leaving the main drive of your computer to hold 
Windows, program files and the like.

Using the Stereo/Mono and Sample Rate settings to gain more channels

If your computer system limits the number of channels, you should try recording 
with a lower sample rate and/or mono recording.

This will considerably reduce the amount of data that needs to be transferred from 
the hard disk to the audio card. A 44100Hz stereo recording creates four times as 
much data as 22050Hz mono!
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An example

A setup consisting of... 

• a Pentium 100 with a 256kB 2nd level cache and 24 MBytes of RAM...
• a VESA or PCI local bus E-IDE or SCSI hard disk interface with a data transfer 

speed of 10 MBytes/second or more...
• an E-IDE or SCSI hard disk with an average seek time of 9ms or better, 512k 

onboard cache, 5400/7200 RPM rotation speed, 5MBytes/second minimum 
sustained data transfer rate (or better)...

...should be able to provide eight stereo channels at 44.1KHz sample rate.

A setup consisting of... 

• a 486DX 100MHz, CPU with a 256kB 2nd level cache and 16MBytes of 
RAM...

• a VESA or PCI local bus E-IDE or SCSI hard disk interface with a data transfer 
speed of 5 MBytes/second or more...

• an E-IDE or SCSI hard disk with an average seek time of 10ms or better, 512k 
onboard cache, 5400 RPM rotation speed, 3MBytes/second minimum sus-
tained data transfer rate (or better)...

...should be able to provide eight mono channels at 44.1KHz sample rate.
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The Hardware Setup Dialog

Introduction

This dialog is opened from the Audio menu and is used for a number of overall set-
tings for audio recording and playback.
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More/Less Choices

This dialog actually appears in two guises. To switch between these, use the More 
Choices/Less Choices buttons. All settings that appear in the Less Choices mode 
also appear in the More Choices mode.

The Hardware Setup dialog after clicking the More Choices... button
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Card Selection

There are two pop-ups in the upper part of the dialog. These allow you to select an 
audio card to use, should you have more than one.

We recommend that you use the same card for recording and playback. You can use 
two different cards, but you should be aware that the two cards will play back at 
fractionally different Sample Rates, and the playback speed and pitch will not 
match the actual recording speed and pitch.

Playback during Recording

When this switch is activated, Cubasis AV will play back audio Tracks while re-
cording new ones. It is of course a great benefit to have this ability, since it allows 
you to hear previously recorded audio Tracks when recording overdubs.

However, not all audio cards support this feature. Only activate this switch if:

• You know you have a card that supports this feature.
• You use two separate cards for recording and playback.
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Playback in Mono/Stereo

• When Stereo is activated, stereo recordings will play back in stereo and 
mono recordings can be positioned in the stereo image with the Pan con-
trol in the Monitor window.

• When Mono is activated, only the left channel audio output on your card 
will be used for playback. When you play back stereo recordings in this 
mode, you will only hear the left channel.

The main reason for using mono is if you have a card that supports Playback during 
Recording, but only when mono is used. See page 416.

Sample Rate

This setting determines the audio quality of your recordings. The higher the value, 
the better the quality, but when you raise the value, each recording also uses up 
more disk space and computer processing power.

Changing the Sample Rate

You should not change the Sample Rate setting if you already have files in the Pool 
(which you will have if you have made any audio recordings at all in this Song).

If you try to do this, a dialog box will appear informing you that if you proceed, the 
files you have already recorded will play back at the wrong speed. Recordings you 
make after the change will play back normally.
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Record and Playback Offsets

If you find that your audio recordings play back late in relation to your MIDI card, 
you probably have an audio card with a slow response time.

To compensate for this you can adjust the Record and Playback Offsets.

• When you raise the Playback Offset value, the audio playback will be 
ahead of (earlier than) the MIDI playback.

• When you adjust the Record Offset value, and start recording, the audio 
will be recorded ahead of the MIDI, in the same manner as with Playback 
Offset.

The delay for most audio cards is in the range of 0 to 20 milliseconds. Normally 
you would adjust the Playback value only. However, if very large adjustments are 
needed, you might try with a combination of Record and Playback Offsets.
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Sync Reference

This setting is used to switch between two methods of “synchronizing” the MIDI 
playback to the audio. Which one to choose depends on your system.

Normally, the recording and playback sections should be set to the same value.

Sample Position

This is the preferred setting if your card supports it. In this mode the number of 
samples played are reported from the card to Cubasis AV and this number is used 
for synchronizing the MIDI playback. This is equivalent to synchronizing to a sam-
ple accurate external clock.

Unfortunately, not all audio cards support this method. When you select it, Cubasis 
AV will check if your particular card and driver does. If not, a warning is issued and 
the DMA Blocksize option (see below) is selected instead.

DMA Blocks

In this mode, the reference between audio and MIDI is determined by the size of 
the data blocks being transferred by Direct Memory Access (DMA) to the audio 
card during recording and playback (yes, this is a heavy technical explanation, but 
this is a very technical issue!).

For this mode to work properly, the DMA Blocksize setting must be in accordance 
with the real blocksize used in the system. See below.
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● If the card does not support the “Sample Position” method, and the “Detect 
DMA Blocksize” function (see below) doesn’t work, you unfortunately have 
an audio card not suitable for this application. With such a card we cannot 
guarantee synchronization between the MIDI and audio material.

DMA Blocksize and Detect DMA Blocksize

The DMA Blocksize settings are only of any relevance if “DMA Blocks” is se-
lected as Sync reference. If you use “Sample Position” it doesn’t matter at all how 
these fields are set.

Normally you do not set the DMA Blocksize yourself. Instead, click the Detect 
DMA Blocksize, and let Cubase Audio detect it and set it for you.
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System Performance

This parameter is used to set a balance between the following two things:

• The time it takes for the program to react to volume and pan changes in the 
Monitor window.

• The number of playback channels.

Setting: Description:

High Changes in the Monitor window (Volume and Pan) will take effect 
quickly. On the other hand, if you do not have a very fast computer, 
you may encounter problems with playing back many audio Tracks in 
this mode (the “System too slow...” message appears).

Medium This is an intermediate balance between volume and pan updates on 
one hand and audio playback on the other.

Normal In this mode, most of the system resources are devoted to audio play-
back. This is the safest mode for playing back as many audio Tracks as 
possible.
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Using the Performance Tester Program
Included with Cubasis AV you will find a small application called “Performance 
Tester” (PFMCHKDA.EXE) that runs “benchmarks tests” on your computer sys-
tem and informs you of how many audio channels it can provide. Please check the 
ReadMe file included, for information on how to use this application.

Maintaining the Hard Disk

Defragment!

Always make sure your hard disk is defragmented. Fragmentation affects the per-
formance of any hard disk severely.
A defragmentation utility is included with later versions of DOS and Windows 95. 
See your computer manuals for details.
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Delete Unused Files!

Audio files require a lot of disk space. If you don’t delete unused files, your hard 
disk will soon fill up.

When you use Purge Segments in the Pool, it will be evident which files are no 
longer used in a Song (the files not used will have no Segments at all). This gives 
you a way of finding out which files can be deleted. But please remember that an 
audio file can be used in more than one Song.

Back Up!

It can’t be said too often. Disk crashes are a well known phenomenon. Without a 
regular backup scheme you risk to lose valuable recordings!

Multitasking
Cubasis AV of course supports Windows multitasking. However, note that audio 
playback may be temporarily interrupted if you switch between programs or keep 
the mouse button down for a long time. We recommend that you don’t switch be-
tween programs while playing back audio.
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Keyboard Commands 29
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What This Chapter Contains
The following is a list of the keyboard short-cuts for many of Cubasis AV's func-
tions.

Numeric Keypad

Key Command Function:

[*] Activate recording

[Enter] Start/Continue

[0] or [spacebar] 1st time – Stop
2nd time – Go to Left Locator/ 1. 1. 0
3rd time – Go to 1. 1. 0

[+] Increase Tempo

[–] Decrease Tempo

[1] Go to Left Locator

[2] Go to Right Locator

[9] Go to last Stop Position
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[Shift] + [1] Store Song Position as Left Locator

[Shift] + [2] Store Song Position as Right Locator

[3] to [8] Go to Cue Point 3 to 8

[Shift] + [3] to [8] Store Song Position as Cue Point 3 to 8

[/] Cycle On/Off

Key Command Function:
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Typewriter Keyboard
The various key commands are grouped after their contexts, to make it easier to 
find what you’re looking for:

File Handling and General Procedures

Key Command Function:

[Control]-[O] Open 

[Control]-[S] Save

[Control]-[Z] Undo

[Control]-[X] Cut

[Control]-[C] Copy

[Control]-[V] Paste

[Control]-[Q] Quit
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Window Handling

Key Command Function:

[Control]-[N] New Arrange window

[Control]-[W] Close active window

[Return] Close box or “click button with heavy border” in Dialog 
Boxes

[Esc] Close and Cancel in Dialog Boxes

[Control]-[E] Open Key Edit window

[Control]-[G] Open List Edit window

[Control]-[R] Open Score Edit window

[Control]-[F]

[G] Decrease horizontal magnification

[H] Increase horizontal magnification

[Shift]-[G] Decrease vertical magnification

|Shift]-[H] Increase vertical magnification
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Transport Bar functions

Key Command Function:

Page Up Forward

Page Down Rewind

[P] Set Position

[L] Set Left Locator

[R] Set Right Locator

[C] Click On/Off

[M] Master Track On/Off

[S] Solo On/Off

[F] Follow Song On/Off
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Arrange Window Selection and Editing

Key Command Function:

[Control]-[A] Select All Parts

[→] Select Next Part

[←] Select Previous Part

[↑ ] Go one Track up

[↓ ] Go one Track down

[Backspace] Delete Selection

[Control]-
[Backspace]

Permanently delete the audio file(s) in the selected Parts 
from the hard disk.

[Q] Over-Quantize

[U] Undo Quantize

[1]-[7] Set Quantize value

[T] Set Quantize value to triplets

[.] Set Quantize value to dotted
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Pool functions

[Alt Gr]-[I] Open/Close Inspector

[Control]-[M] Display Master Track

[Control]-[T] Create Track

[Alt Gr]-[N] Rename Track

[Control]-[P] Create Part

[Control]-[K] Repeat Part(s)

[Alt Gr]-[F] Freeze Play Parameters

Key Command Function:

[Alt Gr]-[D] Duplicate Segment

[Alt Gr]-[N] Rename Segment

[Control]-[Backspace] Permanently  delete the selected audio file from the 
hard disk.

Key Command Function:
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All MIDI Editor windows

Key Command Function:

[Return] Keep (Close editor, keeping changes)

[Esc] Cancel (Close editor, discarding changes)

[Insert] Insert Event

[Tab] Move one Snap in Step Edit

[[Control]-[A] Select All Notes/Events

[Alt Gr]-[O] Loop On/Off

[Alt Gr]-[L] Input Left Loop boundary

[Alt Gr]-[R] Input Right Loop boundary

[Alt Gr]-[I] Info On/Off
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Key Edit only

List Edit only

Key Command Function:

[Alternate] Restrict Pen to length changes only

[→] Next Note

[←] Previous Note

Key Command Function:

[↑ ] Previous Event

[↓ ] Next Event
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Score Edit only

• In all MIDI Editors, the arrow keys can be used in combination with the 
[Shift] key to select several notes.

Key Command Function:

[→] Next Note

[←] Previous Note

[↓ ] Next Staff

[↑ ] Previous Staff

[Alt Gr]-[X] Flip Stems

[Control]-[P] Print Score
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A
Active Part 262
Active Staff 335
Active Track 127
Aftertouch

Creating 303
In List Edit 313
Selecting Events In Editors 306

Any 96
Arrangement

About 15
Customizing 398
Naming 203
Opening 409
Saving 404

Arrow Tool
Editors 271, 294, 306
List Edit 317

Arrow tool 174
Audio

Exporting 242
Importing into Arrangement 240
Importing into Pool 233
Monitoring 51
Recording 56
Viewing 210
- 44
Audio Card
Requirements 414
Selecting 429

Audio Channel 47
About 80
vs Track 80

Audio Channels
Maximum number of 418

Audio Events
About 88

Audio Files
About 84
Deleting 217
Deleting Unused Portions of 228
Exporting 234
Format 412
Importing 233
Locating Missing 221
Locating on Hard Disk 217
Naming 61, 216
Placing on Hard Disk 49

Audio Hardware Setup 427
Audio Track

Setting Channel for 82
Auditioning

Parts 193
Segments 224

AVI Files 389
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B
Backing Up (Audio) 412
Bank Select 148, 157
Bouncing 242

C
C column 136
Cancel 281
Channel

Audio 47
Chn 47
Chn Column 138
Clean Lengths 331
Clear Tempi 371
Clefs

Setting Initial 327
Click 72
Computer keyboard 438
Controller Display

Key Edit 298
List Edit 319
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Controllers
Creating 303
Creating Ramp 308
Displaying 298
In List Edit 313
Selecting Events In Editors 306
Transforming 314

Copy 37, 280
Master Track 370
Parts 185, 202

Copy Range (Mastertrack) 371
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Events 315
Notes 287
Tracks 124

Cue Points 118
Cueing 119
Customizing

About 395
Saving 400
Settings 398
Using Templates 401

Cut 36, 202, 280
Cut Notes 190
Cycle

About 99
Playing Back 100
Recording 101
Setting Up 99
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D
Default Song 395, 400
Delete

Audio Files 217
Events 280
Notes and Rests 341
Parts 194
Segments 226
Tracks 132

Display Filters 321
Divider 30
Double Click Opens 260
Duplicate

Notes 295
Parts 185
Segments 225
Tracks 130

E
Editing

External Wave Editor 248
In List Edit 317

Editing Via MIDI 276
- 45
Editors
About 251
Closing, Cancelling Changes 281
Closing, Keeping Changes 282
Differences 283
Opening 259
Playback Parameters 267

Enharmonic Shift 340
Erase Unused 228
Eraser Tool

Editors 280
Event Display 317
Events

About 251
Audio 88
Creating 315
Deleting 280
Hiding 321
Monitoring In Editors 270
Moving in List Edit 317

Exporting
Audio Files (Bouncing) 242
MIDI Files 410
Segments 234
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F
Fast Forward 112
F-button 321
File

Button 49
File Caching 421
Fill 269
Filters

In List Edit 321
Flip Stems 341
Follow Song 265
Fragmentation 435
Free Space 51
Functions 359

G
Ghost Parts

About 196, 199
Creating 198
Creating Using Repeat 186

Glue Tube Tool
Score Edit 340

Goto Pop-up Menu 268
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Hard disk

Maintaining 435
Requirements 423

Hardware Setup 427
Hide

Events 321
Hide Tempo/Time Signature 371

I
Importing

Audio into Arrangement 240
Audio into Pool 233
MIDI Files 411

Inactive Part 262
Info Line

Editing On 278
Parameters 279
Showing and Hiding 278

Insert Button 290
Inspector

About 139
Opening and Closing 141
Parameters In 147
Program Change 154
Real-time Thru 150



K
Keep 282
Keep Appended Events 282
Key Edit

About 285
Sizing Events 291
Velocity Modifiers 292

Key Pad 109
Key Signatures

Setting Initial 327

L
Line Tool 302, 308
List Edit

About 311
Creating Events 315
Sizing Events 291
Velocity Modifiers 292

Load Pool 238
Locators

Moving Song Position to 118
Using for Cycle 99

Loop 266
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M
M column 137
Magnification

Arrange Window 28
Pool 210

Magnifying Glass Tool
Arrangement 193
Editors 270

Master Button 110, 365
Master Track 365
Merge Parts 189
MIDI

Selecting Programs 69
MIDI Channel

Any 96
In Events 91
Setting for Tracks 93

MIDI Clock
Sync to 385
Transmitting 387

MIDI File
Format 410
Importing 411
Saving an Arrangement as 410

MIDI In Button 351
MIDI Input 276
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MIDI Output
About 89
Multi-port Interfaces 90
Standard Interfaces 90

MIDI Volume 162
Mixing

Audio 377
To a file 242

Modulation
Deleting 363

Monitoring 51
Mono

Playback 430
Mono Button 48
Movies

About 389
Opening 390
Playing back along with music 391

Moving
Events in Key Edit 294
Events in List Edit 317
Parts 183

Multitasking 436
Mute 137, 166
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N
Naming

About 27
Arrangement 203
Audio files 216
Parts 194
Segments 225
Tracks 126

No Overlap 331
Normalize 232
Note Info Line

Editing On 278
Parameters 279
Showing and Hiding 278

Note Tool 336
Notes

Creating 287
Deleting 280
Duplicating 295
Editing 251
In List Edit 313
Moving 294
Resizing 296

Numeric Key Pad 109, 438
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O
Offset 431
Open

Arrangement 409
Song 409

Output
About 89
Column in Track List 138

Over Quantize 361
Overdubbing

Audio 61
MIDI 77

P
Paint Brush Tool 289
Parts

About 15, 170
Deleting 194
Deselecting 179
Duplicating 185
Merging 189
Moving 183
Overlapping 172
Overlapping (Audio) 60
Recording 75
Renaming 194
Repeating 186
Selecting 174
Paste 39, 280
Master Track 370
Parts 202

Patch pop-up menu 158
Pencil Tool

Arrangement 199
Editors 296
List Edit 319, 320

Performance Tester 418, 435
Pitch Bend

Creating 303
In List Edit 313
Selecting Events In Editors 306

Playback during Recording 416, 429
Playback Offset 431
Poly Pressure

In List Edit 313
Pool

Contents 212
Loading 238
Saving 237

Position
Relative Changes 116
Setting 112

Printing 348



Program Change 69
About 153, 258
Entering In Editors 159
Entering In Inspector 154
In List Edit 313
Numbering 161
Recording 159

Purge Segments 226

Q
Quantize

Editors 274
Performing 361
Undoing 362
Value 360

R
Read-ahead 420
Receive MIDI Clock 385
Rechannelizing 93
Record Offset 431
Recording

Audio from Stop Mode 56
In Editors 264
MIDI from Play Mode 78
MIDI from Stop Mode 73
- 45
Repeating Parts 186
Rest Tool 336
Reverse 232
Rewind 112

S
Sample Rate 414, 430

Selecting 45
Save

Arrangement 404
Pool 237
Song 403
vs "Save As..." 407

Score
Displaying 325

Score Edit
Creating Notes and Rests 336
Editing Several Tracks 334
Joining Notes 340
Moving Notes 338
Transposing Notes 338

Scrub
Events 270

Scrubbing 193
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Segments
About 87
Auditioning 224
Changing Start and End Insets 227
Creating in Pool 218
Deleting 226
Deleting unused 226
Dragging into other windows 235
Duplicating 225
Exporting 234
In the Pool 209, 215
Renaming 225

Selecting
Audio File in Pool 217
Non-note Events 306
Notes 271
Parts 174
Segment in Pool 225
Tracks 127

Send MIDI Clock 387
Snap 114, 181

Editors 274
Solo 167
Song

About 15
Opening 409
Saving 403

Song Position Pointer
Moving 113
- 45
SoundFonts 158
Speaker Button 270
Split (Piano) Staff 328
Staff

Active 335
Multiple 334

Start and End Insets
Changing in Pool 227

Startup Song 395, 400
Step Button 351
Step Input

About 351
Entering Notes 353
Entering Rests 354
Insert 356
Note Length 352
Note Spacing 352

Stereo
Playback 430

Stereo Button 48
Sync Reference 432
Synchronization 384
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About 258
System Performance 434
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Templates 401
Tempo

About 110, 365
Deleting Events 371

Text
Creating 342
Editing 344

Text Tool 342
Thru

and the Inspector 150
Time Signature

About 110, 365
Setting on the Transport Bar 72

Title
Score Edit 346
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Tools 16

About 16
Selecting 18
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About 123
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Audio 82
Changing Order Of 129
Creating 124
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Duplicating 130
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Transport Bar
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Transpose
Editing Transposed Notes 267
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Creating Ramp 302
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Modifiers 292

Video for Windows 389
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Wave Editor
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